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Introduccidn

Introduccidn

Harmony es un software de animacion completo que permite crear todo tipo de proyectos de animacion
creativos. Incluye una gran variedad de herramientas y funciones.

En esta Guia de introduccion, aprendera los conceptos basicos del uso de las principales funciones de Harmony
Advanced, que le permitiran ponerse al dia rapidamente. Consulte la documentacién completa de Toon Boom
Harmony Advanced disponible en linea en docs.toonboom.com para aprender acerca de todas las

herramientas y opciones, asi como sobre las técnicas avanzadas.


http://docs.toonboom.com/
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Capitulo 1: Creacién de una escena

Capitulo 1: Creacion de una escena

Al iniciar Harmony, aparece la pantalla de bienvenida, desde donde puede:
o Crear escenas
« Seleccionar la resolucién de la nueva escena
« Administrar los valores predeterminados de la resolucion de la escena
« Abrir rdpidamente escenas recién abiertas
o Examinar y abrir una escena creada
« Ver tutoriales en video de Harmony en la web

e Acceder ala pagina web de soporte

“Harmony

Advanced

. * Toon Boom

Abriruna
escena
reciente

Creary
nombrar una
escena

Crear o eliminar
un valor
predefinido de
resolucion de
unaescena

Seleccionar la
resolucion de la
escena

Watch Video Tutorials W GetHelp Examinary
Open... abriruna
e5Cena

Ver tutoriales en Obtener soporte
video de Harmony para Harmony

NOTA

Si esta usando Harmony Server, debe utilizar la aplicacién Control Center para crear escenas
antes de que pueda abrirlas en Harmony. Las escenas de Harmony Server no se pueden crear
directamente en Harmony.
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Creacion de una escena desde la pantalla de bienvenida

1. En el campo Name (Nombre), escriba el nombre de la escena.

NOTA

El nombre de la escena no debe superar los 23 caracteres y no puede contener
caracteres especiales, como *&A%!.

2. Paradecidir en qué directorio se va a crear la escena, haga clic en el botén Browse (Examinar) junto
al campo Location (Ubicacidn).

4. Haga clic en Create Scene (Crear escena).

Se crea una nueva escena. La ventana de la aplicacidon principal aparecera con la nueva escena
abierta.
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Capitulo 2: Introduccion a la interfaz de usuario de Harmony

El uso de Toon Boom Harmony Advanced serd mucho mas facil si primero se familiariza con su interfaz de
usuario. En el siguiente capitulo se proporciona una introduccion basica a los elementos mas importantes de la
interfaz de usuario. A medida que avance por los capitulos, conocerda mas detalles sobre cada uno de estos
elementos.

Aliniciar Toon Boom Harmony Advanced por primera vez, se presenta el espacio de trabajo predeterminado.
La zona de trabajo se divide en interfaces de usuario rectangulares denominadas vistas, cada una de ellas con
su propio fin especifico. Los laterales superior e izquierdo de la interfaz de usuario, asi como algunas vistas,
también contienen barras de herramientas, cada una con funciones especificas.

|| Vistade
propiedades de
Barra ||
de
Vistade
camara
Barrade
herramie
Vistas

Las vistas son pequefias interfaces de usuario con fines especificos. Se pueden agregar a la ventana principal
de la aplicacidn, en cuyo caso estan "ancladas" o se pueden abrir como ventanas separadas.

Cada vista tiene una pestaina con su nombre en la parte superior. Las pestanas no solo se pueden utilizar para
identificar las vistas con las que esta trabajando, sino que también le permiten apilar varias vistas en la misma
area de la interfaz de usuario. Por ejemplo, en la zona de trabajo predeterminada, la vista de cdmara ocupa la
mayor parte del area. En la parte superior de la vista de cdmara hay dos pestanas: Camera (Camara) y Drawing
(Dibujo). Esto se debe a que la vista de dibujo estd apilada con la vista de cdmara y puede cambiar rapidamente
entre ambas haciendo clic en cualquiera de las pestanas.

10
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A la derecha de las pestafias de cada division de la zona de trabajo se encuentran los botones #= Add View
(Agregar vista) y | % Close View (Cerrar vista), que le permiten apilar mas vistas o eliminar la vista seleccionada
de esta drea de la zona de trabajo.

Adicidn de una vista

Puede agregar, eliminar, mover y apilar vistas en toda la zona de trabajo para optimizar el flujo de trabajo.

Adicion de una vista al espacio de trabajo como una pestana

1. En la esquina superior derecha de una vista existente, haga clic en el botén == Add View (Agregar
vista).

bstitutions

Solid Brush 1
5

Solid Brush 2
10

Solid Brush 3
15

Solid Brush 4
25

Fixed Width 1
1

Fixed Width 2
10

2. Seleccione la vista que desee en la lista.

La vista aparece como una nueva pestafia en la seccién del espacio de trabajo donde la agregé.

11
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Tool Properties | Library | Layer Properties =+ (%

ma =

Transformation | Drawing =~ Controls | Line Thid

(o]

NOTA

Algunas vistas, como las de camara, perspectiva, libreria y modelo, se pueden abrir en varias
instancias. Por ejemplo, puede resultar (til si desea tener dos instancias de las vistas de
camara abiertas, cada una centrada en distintas areas de la escena, para cambiar répidamente

entre los trabajos de estas dos areas.

Adicion de una vista a la zona de trabajo como una ventana

1. Abrael mend Windows (Ventanas).
2. En el mend Windows (Ventanas), seleccione la vista que desee agregar.

La vista aparecera como una nueva ventana sobre la ventana de la aplicacion principal de Harmony.

Anclaje de una ventana de vista en el espacio de trabajo

1. Hagaclicy arrastre la vista flotante por la pestafa y realice una de las siguientes acciones:
o Coloque la ventana sobre otra pestana para agregarla a ese conjunto de pestanas.

o Coloque la ventana por encima, por debajo o junto a una vista existente. Al acercarse
al borde de una vista, aparece un rectangulo cian que indica dénde se anclara la vista.

12
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Aqui se proporciona una breve introducciéon a cada una de las vistas mas utilizadas en Harmony.

Vista de camara

La vista de camara es el centro de operaciones en Harmony. En esta vista puede dibujar, pintar, animar,
configurar la escena, manipular objetos, abrir simbolos y previsualizar la animacion.

La vista de cadmara también tiene una barra de herramientas superior e inferior que puede utilizar para navegar
en la vista, cambiar el modo de visualizacion o subir la jerarquia de simbolos.

13



Capitulo 2: Introduccidn a la interfaz de usuario de Harmony

(_piade ]

\ “l
_

Modo de | Modo de A
vistade | vista de Capa Numero de
F
D d nl’

Mesa de |Menl’1de l Espacio de I Nombre I |

color de

I Dibujo actual encima I Mostrar
[ Mascara del Tomar
I Zona ] [ Restablece ]
| Mostrar guias de | | Trazar dibujos |

| Estilo seleccién I

Vista de dibujo

En Harmony, puede dibujar tanto en la vista de dibujo y como en la de cdmara. Aunque las dos vistas son
similares, hay algunas diferencias cuando se trata de dibujar.

En la vista de dibujo solo se muestra el dibujo seleccionado de forma predeterminada. Puede utilizar funciones
como la mesa de luz para mostrar el dibujo actual de todas las capas habilitadas de la escena con colores
descoloridos, o el papel cebolla para mostrar los dibujos anteriores y siguientes de la capa de dibujo
seleccionada actualmente.

14
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Barrade l

Mendi de , Camera Drawing
Valores oz

MNiamero de”Posici()n del ”Selectorde

Vista de propiedades de la herramienta

La vista de propiedades de la herramienta contiene las opciones y operaciones mas comunes relacionadas con
la herramienta seleccionada actualmente. Al seleccionar una herramienta en la barra de herramientas de
herramientas, se actualiza la vista de propiedades de la herramienta.

Por ejemplo, si elige la herramienta Select (Seleccionar), la vista de propiedades de la herramienta mostrara las
opciones y operaciones relacionadas con dicha herramienta, como Snap to Contour (Ajustar a contorno), Apply
to All Drawings (Aplicar a todos los dibujos), Flip Horizontal (Voltear en horizontal) y Flatten (Acoplar).

Posibles
opcionesy
modos para la

Posibles
operaciones [
parala

15
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Vista de color

La vista de color es donde se crean colores y paletas, y se importan paletas existentes en el proyecto. La vista
de color también es necesaria para dibujar, pintar y crear estilos de color.

I Bajar/subir paletal Ilndicadorde modo de edicion de I

I Vincularl IMostrarpaIetasde I
I Quitarpaletal IMostrarpaIetasdetextura I
Menl de vista de I I Agregarl Maostrar todas las

Colour = %

I Contraer/expandir lista de

I Indicador de modo de edicidn de

I Indicador de modo de

| am Il v |

L

Definir color de Vincular/desv
pincel/lapiz/pintur incular tres

Agregar muestra Modo de edicién

I Quitar muestra de Indicador de modo de

Agregar

Lista de muestras

+ -
—1
|
 —
—_—
—1
|
—
—1
 I—
—
|
=
 —
 —

I *El bot6n del modo de edicién de paleta solo esta disponible en Harmony Server. El modo de edicién de paleta siempre esta

Vista de linea de tiempo

Para establecer el tiempo de la animacidn, trabajara principalmente con las vistas de linea de tiempo y de carta
de rodaje. Es muy util familiarizarse con la vista de linea de tiempo, su funcionamiento y su interfaz.

La vista de linea de tiempo es la vista principal utilizada al ajustar el tiempo de los dibujos, agregar fotogramas
clave y ordenar capas. La vista de linea de tiempo muestra capas, efectos, sonidos, valores de fotogramas clave,
duracién de escena, nombres de capas, dibujos, fotogramas clave, tiempo y fotogramas.

16
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| Habilitar/deshabilita |
[ Habilitar/deshabilitar |

[ Agregar/guitar papel ]

Parametros

[Cursordelinea ] [ Exposicidn de ]

[ Expandir/contraer ]

]

[ Expandir/contraer jerarquia de

Coordenadas
en el fotograma

Zoom de linea Fotograma clave de

[ Mostrar/ocultar vinculos ] Mostrar/oc

Numero de dibujo
en el fotograma

ultar
[ Mostrar/focultar ]

|Ver modos I

La vista de linea de tiempo permite leer el tiempo de izquierda a derecha. Representa los elementos de la

escena en su forma mas simple. También puede ver las capas y sus nombres, asi como la exposicién del dibujo.
El nombre del dibujo se muestra al colocar el puntero sobre la exposicién del dibujo.

Vista de sustituciones de dibujo

La vista de sustituciones de dibujo le permite ver todos los dibujos de la capa seleccionada en una lista de

imagenes en miniatura, asi como seleccionar rapidamente qué dibujo se debe exponer en el fotograma actual.

17
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Mendi de , Tool Properties  Library =~ Drawing Substitutions + (%

Iméagenes

I Mombre de capa

BOOM_Animation Control

Vista de carta de rodaje

La vista de carta de rodaje permite leer el tiempo verticalmente mostrandolo en una cuadricula, con cada capa
de dibujo representada por una columna, cada fotograma de la escena representado por una fila y cada dibujo
expuesto mostrado por su nombre en las celdas. Se pretende que funcione como una carta de exposicion de
animacidn tradicional.

Con el panel de funciones, también puede ver las funciones y los fotogramas clave de las rutas de movimiento
de la columna seleccionada, con el valor de esas funciones para cada fotograma que se muestra en las celdas.

A diferencia de la vista de linea de tiempo, la vista de carta de rodaje no muestra pegs, efectos o jerarquia de
capas. Por lo tanto, se optimiza para una animacion tradicional y sin papel, mientras que la vista de linea de
tiempo se optimiza para una animacion digital o cut-out.

18
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Encabezado de

Dibujo actual

Panel de

Current: 1: A

Dibujo/elemento || Columna || Aumentar/reducir Modo de
actual de exposicion sobrescribir/

Vista de libreria

La vista de libreria se utiliza para almacenar elementos como animaciones, dibujos, fondos y modelos de
personajes para volver a utilizarlos en distintas escenas y proyectos. También puede utilizar la vista de libreria
para crear y almacenar simbolos, asi como para almacenar e importar imagenes y archivos de sonido.

Para reutilizar elementos de una escena en otras escenas, debe crear una plantilla para poder importarla en
distintas escenas. Las plantillas pueden contener cualquier elemento, desde un solo dibujo hasta una
estructura de escena completa. Puede crear una plantilla en una escena y copiar los elementos que desee de la
plantilla en una libreria. La plantilla resultante se estructura como una miniescena que solo contiene los
elementos que copid en ella. Una plantilla no tiene ninguna dependencia en la escena en la que se cred
originalmente. Por lo tanto, se puede importar de forma segura en cualquier otra escena.

Ademas, el panel Drawing Substitutions (Sustituciones de dibujo) de la vista de libreria permite cambiar
rapidamente la exposicidn del fotograma actual a uno de los dibujos existentes en una capa. Esto es
especialmente Util para la animacién de las bocas, manos, parpados y otras partes del cuerpo de un personaje
cut-out, que suelen contener varios dibujos donde elegir.

19
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-l

I Vista previa de

s | ¢

MNombre del

Listade
I MNombre del

Control
deslizante de

Barrade

Lista de carpetas

I *El campo del nombre del dibujo solo aparece si se selecciona un elemento de

Barras de herramientas

La interfaz de Harmony contiene barras de herramientas que proporcionan acceso rapido a muchas
herramientas Utiles. Puede agregar, mover y eliminar barras de herramientas de la zona de trabajo.

Las barras de herramientas se dividen en dos categorias principales:

« Lasbarras de herramientas de la zona de trabajo son barras de herramientas con un propdsito general.
Por ejemplo, las barras de herramientas de archivo, edicidn, zona de trabajo, animacién avanzaday
deformacién de la parte superior, asi como la barra de herramientas de herramientas de la izquierda son
barras de herramientas de la zona de trabajo. Esas barras de herramientas se pueden colocar en el
borde superior, inferior, izquierdo o derecho de la ventana de la aplicacién. Si se prefiere, también se
pueden colocar en el borde de vistas especificas.

« Lasbarras de herramientas de vista son barras de herramientas Utiles para una vista especifica. Por
ejemplo, la vista de cdmara tiene una barra de herramientas de cdmara en la parte superior. Las barras
de herramientas de vista solo se pueden mostrar dentro de su vista respectiva. Se pueden colocar en el
borde superior, inferior, izquierdo o derecho de su vista.

Adicidn de barras de herramientas

Adicidn o eliminacidén de la barra de herramientas de una zona de trabajo a la zona de
trabajo general

1. Realice una de las siguientes acciones:

o En el mend superior, seleccione Windows > Toolbars (Ventanas > Barras de herramientas)
y, en el submend, seleccione la barra de herramientas que desee agregar.

20
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« Haga clic con el botén derecho en cualquier barra de herramientas situada en la parte
superior o lateral de la zona de trabajo o en la zona vacia junto a estas barras de
herramientas, y seleccione la barra de herramientas que desee agregar en el menu

contextual.

Haga clic con el
botén derecho
enestadreapara

Adicion de una barra de herramientas de vista a una vista

1. Realice una de las siguientes acciones:

« Haga clicen la pestana de la vista para la que desea agregar una barra de herramientas para
centrarse en ella. A continuacién, en el menu superior, seleccione Windows > Toolbars
(Ventanas > Barras de herramientas) y seleccione la barra de herramientas que desee

agregar.

21
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@ NOTA

En la lista de barras de herramientas del menu superior y el menud contextual de
la zona de trabajo, las barras de herramientas enumeradas por encima del
separador son barras de herramientas de la zona de trabajo y las que estan
debajo del separador son barras de herramientas de vista.

Barras de
herramient

Barras
de

En el drea superior de la vista a la que desee agregar una barra de herramientas, a la
izquierda de la pestafia, haga clic con el botdn derecho y seleccione la barra de herramientas

que desee agregar en el menu contextual.

Haga clic con el botdn
derechoen el drea
izquierda de |a pestafia
de lavista de cadmara

Dado que lavistade
cédmara yadispone de
barras de herramientas,
también puede hacer
clic con el boton
derechoen ellas para

agregar barras de

am.ea s

-,
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NOTAS

e En lalista de barras de herramientas del menu contextual de una vista, las
barras de herramientas enumeradas por encima del separador son barras de
herramientas de la zona de trabajo y las que estan debajo del separador son
barras de herramientas de vista.

Barras de

Barras de
herramient

Customize...

« Siselecciona una barra de herramientas de la zona de trabajo en el menu
contextual de una vista, esta barra de herramientas de la zona de trabajo se
agregara a la vista. Si ya estaba presente en la zona de trabajo, se eliminara
de su ubicacién anterior.

o Cuando se agrega una barra de herramientas de la zona de trabajo a una
vista que tenga apiladas otras vistas, dicha barra de herramientas sera visible
en todas las vistas apiladas en la misma zona. Por ejemplo, si agrega la barra
de herramientas de animacidn avanzada a la vista de camara, también serd
visible en la vista de dibujo.

Desplazamiento de una barra de herramientas

1. Haga clicy mantenga pulsado el controlador situado a la izquierda de la barra de herramientas que
desee mover.

23
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2. Realice una de las siguientes acciones:

o Sila barrade herramientas es horizontal, muévala hacia arriba o hacia abajo para sacarla de
su fila.

« Silabarra de herramientas es vertical, muévala hacia la izquierda o hacia la derecha para
sacarla de su columna.

3. Realice una de las siguientes acciones:

o Parareorganizar las barras de herramientas, arrastre la barra de herramientas hasta donde
desee y coldquela.

La barra de herramientas se movera a su nueva posicion. Las barras de herramientas situadas
a la derecha (o en la parte inferior, si la barra de herramientas es vertical) se desplazaran
para dejar espacio.

o Para mover la barra de herramientas a una nueva fila o columna, simplemente mueva la barra
de herramientas donde se deba crear la nueva fila o columna. Por ejemplo, para crear una
nueva fila de barras de herramientas en la parte superior de la interfaz de usuario, muévala
justo debajo de las barras de herramientas existentes en la parte superior de la interfaz de
usuario. Aparecera una nueva fila o columna resaltada en cian.

Al colocar la barra de herramientas, se creard la nueva fila y la barra de herramientas se
colocard en el extremo izquierdo de esta.
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Del mismo modo, para crear una nueva columna a la izquierda de la interfaz de usuario,
muévala justo a la derecha de las barras de herramientas existentes a la izquierda de la
interfaz de usuario.

o Para mover la barra de herramientas a otro extremo de la interfaz de usuario, arrastrela hasta
dicho extremo.

Desplazamiento de una barra de herramientas sobre otra barra de herramientas

1. Asegurese de que ambas barras de herramientas se encuentren en la misma fila o columna. Sino lo
estan, mueva ambas barras de herramientas a la misma fila o columna siguiendo el método descrito
anteriormente.

« Silas barras de herramientas son horizontales, haga clic y mantenga pulsado el controlador
de la izquierda de la barra de herramientas situada mds a la derecha. A continuacidn, sin salir
de la fila de la barra de herramientas, deslice la barra de herramientas hacia la izquierda.

« Silas barras de herramientas son verticales, haga clicy mantenga pulsado el controlador de
la parte superior de la barra de herramientas inferior. A continuacion, sin salir de la columna
de la barra de herramientas, deslice la barra de herramientas hacia arriba.

A medida que desliza la barra de herramientas sobre la otra barra de herramientas, los botones de
la otra barra de herramientas se ocultan y aparece un botdn de menu emergente.
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[ e

Menl emergente
para los botones

2. Para separar de nuevo las barras de herramientas, simplemente deslice la misma barra de
herramientas en la direccién opuesta.

3. Para expandir una barra de herramientas que tenga superpuesta otra barra de herramientas, haga
clic en el botdn de expansion situado a la derecha de la barra de herramientas superpuesta.

Barra de herramientas de herramientas

La barra de herramientas de herramientas contiene las herramientas principales que necesita para trabajar en
Harmony. En la zona de trabajo predeterminada, esta barra de herramientas se encuentra en el borde
izquierdo de la ventana de la aplicacién.

Algunos de los botones de la barra de herramientas de herramientas disponen de un tridngulo en la esquina
inferior derecha. Es para indicar que hay varias herramientas apiladas en este botdn. Para acceder a estas
herramientas, haga clic y mantenga pulsado el botdn de herramienta, o seleccione la herramienta y haga clic
de nuevo.
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Selecc

Una flecha en la esquina indica
que hay mas herramientas
disponibles en un mend

I

Editor de L3
Pincel
Lapiz
Sello

Borra

Rectangul

II@“III

Pinta

w Paint
4 Ink
w Paint Unpainted

w Repaint

Cuentagotas de

Pivote de $ Hand

| m

Maorphing

Modo Animate

Transform

=
=

Papel

Animate Current Frame

4

_‘Q- CONSEJO

’ N

herramientas que aparece.

I

Muchos botones de la barra de herramientas disponen de un atajo de teclado asociado. Puede
comprobar qué atajo de teclado estd asociado a un botén dejando el cursor del ratdn sobre el botén
durante un segundo. Si el botdn tiene un atajo de teclado, se indicara en la informacion sobre

Barra de herramientas de archivo

La barra de herramientas de archivo contiene botones para operaciones de archivo comunes, como New
(Nuevo), Save (Guardar) y Open (Abrir). Estos comandos también se encuentran en el mend superior File

(Archivo).
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NOTA

Los botones [[] New (Nuevo) y '3 Save As (Guardar como) solo estan disponibles en Harmony
Stand Alone. Con Harmony Server, se debe utilizar Control Center para crear escenas.

Barra de herramientas de edicion

La barra de herramientas de edicién contiene operaciones comunes como Undo (Deshacer), Redo (Rehacer),
Cut (Cortar), Copy (Copiar) y Paste (Pegar). Estos comandos también se encuentran en el mend superior Edit
(Editar).

Barra de herramientas de reproduccion

La barra de herramientas de reproduccion le permite reproducir la animacidn, asi como configurar algunas
opciones de reproduccién, como bucle, reproduccién de audio, rango de reproduccién y velocidad de

reproduccion.

% Render and Play

Record and Play

s Test SWF Movie

Frame 1

Desplazar

I Habilitar depuracién de I

I Renderizaryl

[ Buct|[Habilitar |

Navegacion por la interfaz

Con la ayuda de comandos de menU y atajos de teclado, algunas vistas permiten navegar por su contenido al
acercarlo, alejarlo, panearlo y rotarlo. También puede restablecer el nivel de zoom, el paneo y el angulo de

rotacidon de estas vistas segun sea necesario.

Los comandos de navegacién de la tabla que se muestra a continuacién se pueden utilizar en las siguientes

vistas, con algunas excepciones:
o Cdmara

. DIbUJO
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o Perspectiva

e Lineadetiempo
o Cartaderodaje
« Funcidn

o Lateraly superior

« Modelo

/. CONSEJO

’ N

> Atajos de teclado).

Advanced > Atajos de teclado).

Los atajos de teclado se pueden personalizar. Puede ver, buscar y cambiar atajos de teclado para
Harmony en el cuadro de didlogo Keyboard Shortcuts (Atajos de teclado). Para acceder al cuadro
de dialogo Keyboard Shortcuts (Atajos de teclado):

« Windows o GNU/Linux :en el menu superior, seleccione Edit > Keyboard Shortcuts (Editar

« macOS : en el menu superior, seleccione Harmony Advanced > Keyboard Shortcuts (Harmony

Comando Accién

Métodos de acceso

View > Zoom In (Ver > Acercar)

. Pulse 2.

Zoom In (Acercar) Acerca la vista.
Gire la rueda del ratén hacia arriba (excepto en las vistas de linea
de tiempo y de carta de rodaje)
View > Zoom Out (Ver > Alejar)

Zoom Out . . Pulse 1.

. Alegja la vista.
(Alejar)

Gire la rueda del ratén hacia abajo (excepto en las vistas de linea
de tiempo y de carta de rodaje)

Zoom In 0 Zoom .
Acerca o alejala
Out (Acercar o

Gire la rueda central del ratén hacia arriba o hacia abajo.

Mantenga pulsada la barra espaciadora y la rueda central del ratén

verticalmente.

. vista.
Alejar) mientras arrastra el ratén hacia arriba o hacia abajo.
Mueve la vista . . .,
. Mantenga pulsada la barra espaciadora y arrastre en la direccién
Pan (Panear) horizontal o

que desee panear la vista.
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Comando

Accién

Métodos de acceso

Restablece el paneo

Reset Pan de vista a su View > Reset Pan (Ver > Restablecer paneo)
(Restablecer L,
paneo) posicion . Pulse Mayus + N.
predeterminada.
View > Reset View (Ver > Restablecer vista)

Reset Vi Restablece la vist

eset View esta 'e.cle avistaa Pulse Mayus + M.
(Restablecer Su posicion
vista) predeterminada. El botdn @ Reset View (Restablecer vista) en la parte inferior de

la vista de cdmara.

Reset Rotation

Restablece la
rotacion de vista a

View > Reset Rotation (Ver > Restablecer rotacién)

(Restablecer L,
rotacién) Su posicion Pulse Mayus + X.
predeterminada.
Restablece el zoom
Reset Zoom .
devistaasu .
(Restablecer ., View > Reset Zoom (Ver > Restablecer zoom)
posicion
zoom) .
predeterminada.
. Rota lavista ala Mientras mantiene pulsadas las teclas Ctrl + Alt (Windows/Linux)
Rotate View

(Rotar vista)

izquierdao ala
derecha.

o Ctrl + 3§ (macOS), haga clic y arrastre el disco de rotacidn para
rotarlo a la derecha o a laizquierda.

3D Rotate View
(Rotar vista 3D)

Rota la vista en
cualquier direccion.
Esto solo estd
disponible en la
vista de perspectiva.

Mientras mantiene pulsada la tecla Ctrl + Mayus (Windows/Linux)
o & + mayusculas (macQS), haga clic y arrastre la escena para
rotarla en cualquier direccién.

Rotate 30 CW

Rota la vista de
cdmara 30 grados a
la derecha, como

View > Rotate View CW (Ver > Rotar vista der.)

(Rotar 30 der.)
una mesa de
animacion.
Rota la vista de
Rotate 30 CCW camara 30 grados a . . L
. o View > Rotate View CCW (Ver > Rotar vista izq.)
(Rotar 30izq.) la izquierda, como

una mesa de
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Comando

Accién

Métodos de acceso

animacion.

Mirror View (Vista
de espejo)

Cambia
temporalmente la
vista de cdmara o de
dibujo en
horizontal, lo que
permite ver y editar
lailustracién como
si se estuviera
reflejando.

View > Mirror View (Ver > Espejo)

En la barra de herramientas de camara o de dibujo, haga clic en el
botén Mirror View (Espejo) O .

Toggle Quick
Close-up
(Alternar primer
plano rapido)

Multiplica
inmediatamente el
factor de zoom de la
vista por 4. Por
ejemplo, si el factor
de zoom de la vista
de camara se
encuentra al 100 %,
esto hard que
alterne entre 400 %
y 100 %.

Mayus + Z

Toggle Full
Screen (Alternar
pantalla
completa)

Pasa por los
siguientes modos
de visualizacion:

o Normal
Full-Screen
(Pantalla
completa
normal): la
ventana
principal de
la aplicacién
se convierte
en pantalla
completa.

o View Full-
Screen (Ver
pantalla
completa): la

View > Toggle Full Screen (Ver > Alternar pantalla completa)

Pulse Ctrl + F (Windows/Linux) o 38 + F (macQS).
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Comando Accién Métodos de acceso

vista
seleccionada
se convierte
en pantalla
completay
todas las
demads vistas
se contraen.

« Normal:la
ventana
principal de
la aplicacion
serestaura a
su tamano
original y las
vistas
contraidas
se expanden.

Interfaz tactil

Si esta trabajando con una pantalla tactil, un trackpad o una tableta que admita funcidn tactil, también puede
utilizar los gestos de dos dedos estdndar para el zoom, la rotacion y el paneo en las vistas de camara y dibuijo.
Para poder hacer esto, primero debe habilitar la preferencia Support Gestures (Soporte de gestos).

Habilitacién del soporte de gestos

1. En el mend superior, vaya a Edit > Preferences (Editar > Preferencias) (Windows/Linux) o Harmony
> Preferences (Harmony > Preferencias) (Mac OS X).

2. Abra la pestafia General.

3. En la seccidn Touch Interface (Interfaz tactil), marque la casilla de verificacion Support Gestures
(Soporte de gestos).

4. Hagaclicen OK (Aceptar).
5. Reinicie Harmony.

Ahora puede manipular las vistas de cdmara y de dibujo arrastrando dos dedos sobre la interfaz
tactil.
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Uso de gestos

1. En lavista de cdmara o de dibujo, presione con dos dedos situados a una distancia corta entre si.

2. Realice una de las siguientes acciones:

o Para panear la vista, arrastre los dos dedos en cualquier direccidon, manteniéndolos a la
misma distancia uno del otro.

« Para acercar el zoom, arrastre los dos dedos separando uno del otro.

o Paraalejar el zoom, arrastre los dos dedos acercando uno al otro.
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o Pararotar, arrastre los dos dedos haciendo una curva para que giren en la misma direccion.
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Capitulo 3: Adicion de capas

Aligual que con la animacidn tradicional, Harmony utiliza capas para mantener los elementos, como
personajes, fondos y props, separados unos de otros, lo que permite animarlos de forma independiente.

Al crear una nueva escena, la escena tendrd una capa predeterminada denominada Drawing (Dibujo) en la que
se puede comenzar a dibujar de inmediato.

Capa de dibujo

Las capas se pueden seleccionar y gestionar en la vista de linea de tiempo. Una escena puede tener tantas
capas como sea necesario. Cuando la escena tiene varias capas, las capas superiores de la lista aparecen sobre
las capasinferiores.

Tipos de capas de dibujo
Harmony admite dos tipos de capas de dibujo, cada una con sus propias ventajas y limitaciones:

« Vector Layers (Capas de vectores): los dibujos de vectores estan formados por puntos y curvas que
componen los contornos de las formas de la ilustracidn, junto con el color o las texturas de relleno. Por lo
tanto, la ilustracidn en capas de vectores se puede escalar y ampliar sin que pierda calidad, a menos que
contenga una textura.
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Al dibujar en una capa de vector, cada trazo de dibujo y cada linea de Lapiz es un objeto independiente
que se puede manipular por separado. Puede seleccionar trazosy, a continuacién, moverlos y
transformarlos, incluso si se aplicaron trazos de dibujo sobre ellos. Ademas, debido a que los trazos de
dibujo estan formados por puntosy curvas, es posible editar su forma, lo que facilita las correcciones y los
cambios en la ilustracion.

« Bitmap Layers (Capas de mapa de bits): los dibujos de mapa de bits se componen de una cuadricula de
pixeles, que son puntos pequefios que tienen un solo color sélido. Las herramientas de dibujo de mapa
de bits permiten colocar trazos de pincel en un Unico lienzo plano y ajustar la ilustracion pixel a pixel si

es necesario.

Al dibujar en una capa de mapa de bits, cada trazo se compone en el lienzo, por lo que continda siendo
un dibujo Unico que solo se puede pintar o borrar, pero que no permite ajustar partes individuales.

Las ilustraciones de mapa de bits solo se pueden escalar o ampliar tanto como lo permita su densidad de
pixeles sin perder calidad de imagen. De forma predeterminada, la ilustracion de mapa de bits tiene una
densidad de pixeles del 100 %, que solo es suficiente para mostrar la ilustracidn sin ampliarla o
escalarla; de lo contrario, Harmony debe generar nuevos pixeles en la ilustracién, lo que puede hacer
que se vea borrosa o pixelada.

Por lo tanto, es posible que desee establecer la densidad de pixeles requerida para la ilustracién de
mapa de bits, en funcién de si tendra que ampliarla o escalarla, antes de comenzar a dibujar en una capa
de mapa de bits.

NOTA

Como las capas de vectores se pueden editar y escalar, se recomienda comenzar utilizando capas
de vectores mientras se familiariza con Harmony. La capa de dibujo predeterminada de una nueva
escena es una capa de vectores.

Capas de dibujo

De forma predeterminada, cada capa de un dibujo tiene dos capas de dibujo: la capa de lineas y la capa de
color. Puede utilizar estas capas para mantener separadas la capa de lineas y los colores de los dibujos.
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A la derecha de la vista de cdmara y de dibujo, puede controlar en qué capa de dibujo esta trabajando v si solo

se muestran la capa de dibujo actual o ambas capas de dibujo.

Camera Drawing =%

Vista previa de todas I

Establecer la capa de lineas I

Establecer la capa de color I

De forma predeterminada, estd seleccionada la capa de linea. Por lo tanto, si comienza a dibujar de inmediato,
dibujard en la capa de linea de la capa de dibujo, a menos que seleccione primero la capa de color.

El uso de distintas capas de dibujo para la capa de lineas y la capa de color es completamente opcional. Si lo
desea, puede utilizar la capa de lineas tanto para la capa de lineas como para la capa de color.
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NOTA

También puede habilitar capas de dibujo adicionales: las capas superior y de fondo. La capa de
dibujo superior se suele utilizar para anotaciones y la capa de fondo se suele utilizar para esbozos
basicos. Para habilitarlas, compruebe la opcidn Support Overlay and Underlay Arts (Admitir capas
superior y de fondo) de la pestafia Advanced (Avanzado) del cuadro de dialogo Preferences
(Preferencias), al que se puede acceder seleccionando Editar (Windows/Linux) o Harmony
Advanced (macOS) > Preferences (Editar (Windows/Linux) o Harmony Advanced (macOS)

> Preferencias) en el menu superior.

Cambio de nombre de capas

En una nueva escena, solo hay una capa creada de forma predeterminada, y se denomina Drawing (Dibujo). En
la animacidn tradicional, es comin nombrar a las capas de animacidn con letras individuales (A, B, C, etc.) y las
capas de disefio con acrénimos (BG para fondo, OL para superposicidn, etc.). Asi, puede comenzar la escena
dando a la primera capa un nombre adecuado.

Cambio de nombre de una capa en la vista de linea de tiempo

1. En lavista de linea de tiempo, haga doble clic en el nombre de la capa que desee cambiar.

Aparece un campo de entrada de texto sobre el nombre.

ro=al

o

2. Escriba el nuevo nombre de la capa y pulse Intro/retorno.

La capa tiene un nuevo nombre.

roSanm

o

Adicion de capas

Adicion de un elemento de dibujo desde la vista de linea de tiempo

1. Realice una de las siguientes acciones:
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o En lavista de linea de tiempo, haga clic en el botén ¥ Add Drawing Layer (Agregar capa de
dibujo).

« En el mend superior, seleccione Insert > Drawing (Insertar > Dibujo).

o Pulse Ctrl + R (Windows/Linux) o &8 + R (macOS).

Aparece el cuadro de didlogo Add Drawing Layer (Agregar capa de dibujo).

Add and Close

2. En el campo Name (Nombre), escriba el nombre de la nueva capa.
2. Seleccione si desea que la capa Line Art (Lineas) sea Vector o Bitmap (Mapa de bits).
3. Seleccione si desea que la capa Colour Art (Capa de color) sea Vector o Bitmap (Mapa de bits).

4. Realice una de las siguientes acciones:

o Haga clicen Add (Agregar) para crear esta capa, pero deje abierto el cuadro de didlogo para
poder crear mas capas.

« Hagaclicen Add and Close (Agregar y cerrar) para crear esta capa y cerrar el cuadro de
dialogo.

Se agrega a la vista de linea de tiempo una nueva capa de dibujo.

Eliminacion de capas

Eliminacion de capas en la vista de linea de tiempo

1. En lavista de linea de tiempo, seleccione las capas que desea eliminar.
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NOTA

Puede seleccionar varias capas contiguas manteniendo pulsada la tecla Mayus,
haciendo clic en la primera capa que desee seleccionar y, a continuacion, en la ultima.
También puede seleccionar varias capas manteniendo pulsada la tecla Ctrl
(Windows/Linux) o & (macOS) y haciendo clic en cada capa que desee seleccionar.

2. Realice una de las siguientes acciones:

o En labarra de herramientas de capa de la vista de linea de tiempo, haga clicen el botén =
Delete Layers (Eliminar capas).

« Haga clic con el botdn derecho en la seleccidn y seleccione Delete (Eliminar).

Las capas seleccionadas se eliminan de la vista de linea de tiempo.

Cambio de orden de capas

Reorganizacion de capas en la vista de linea de tiempo

1. En lavista de linea de tiempo, seleccione las capas que desea mover.
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2. Hagaclicy arrastre la seleccidn, y realice una de las siguientes acciones:

o Cologue la seleccidon entre dos capas para moverla entre ellas. Aparecerd una linea cian
entre las capas donde se moverad la seleccion.

o Cologue la seleccidon en una capa para aplicar un rig de las capas seleccionadas como hijas
sobre esa capa.

Agrupacion de capas
La agrupacién de capas permite mantener la estructura de la escena organizada.

Ademas, puede colocar varias capas dentro de un grupo 'y, a continuacién, agregar un efecto en este grupo para
aplicarlo en todas las capas del mismo.

Agrupacion de capas en la vista de linea de tiempo

1. En lavista de linea de tiempo, seleccione los elementos que desee agrupar.

NOTA

Las capas que se encuentren entre las seleccionadas se agruparan con las capas
seleccionadas.
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2. Realice una de las siguientes acciones:

o Haga clic con el botén derecho en las capas resaltadas y seleccione Group Selection
(Agrupar seleccidn).

o Pulse Ctrl + Mayus + G (Windows/Linux) o 3§ + mayusculas + G (macOS).

Se agrega una nueva capa de grupo a la vista de linea de tiempo.

Si hace clic en el botdn Expand Group (Expandir grupo), encontrara las capas agrupadas en rig
como hijos de la capa de grupo.

Ocultar y visualizar capas

Puede ocultar capas temporalmente para que no desordenen la vista de cdmara mientras trabaja en otras
capas.

Cdmo ocultar una capa en la vista de linea de tiempo

1. En lavista de linea de tiempo, a la izquierda de la capa que desea ocultar, haga clic en el botén (a4
Disable Layer (Deshabilitar capa).

La capa se volvera invisible en la vista de camara.

2. Sidesea mostrar la capa, haga clic en el botén . Enable Layer (Activar capa) para volver a
mostrarla.

43



Capitulo 3: Adicién de capas

Bloqueo y desbloqueo de capas

Puede bloquear capas temporalmente. Las capas blogueadas se pueden editar en la vista de linea de tiempo o
de carta de rodaje, pero no puede seleccionarlas, dibujarlas o manipularlas en la vista de camara. Esto puede
ser Util para evitar seleccionar o dibujar accidentalmente sobre los fondos, superposiciones, props o personajes

con los que no esté trabajando actualmente.

Bloqueo de una capa en la vista de linea de tiempo

1. En lavista de linea de tiempo, a la izquierda de la capa que desea bloquear, haga clic en el botén fg
Lock (Bloquear).

Sera imposible seleccionar la capa o dibujar en ella en la vista de camara. El nombre de la capa

aparecera en rojo en la vista de linea de tiempo.

2. Sidesea desbloquear la capa, haga clic en el botdn Unlock Layer (Desbloquear capa) para

volver a mostrarla.
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Capitulo 4: Como dibujar

Cuando crea una escena, la escena incluye una capa de dibujo predeterminada en la que puede comenzar a
dibujar de inmediato.

NOTA

Segun su estilo de dibujo y con lo que se sienta cdmodo, es posible que prefiera trabajar con la
herramienta Brush (Pincel) o la herramienta Pencil (Lapiz). Para obtener mds informacion sobre la
diferencia entre estas dos herramientas, consulte Cuando crea una escena, la escena incluye una

capa de dibujo predeterminada en la que puede comenzar a dibujar de inmediato. en la pagina 46.

Dibujo con la herramienta Brush (Pincel)

1. En lavista de linea de tiempo o de carta de rodaje, haga clic en la primera celda de la capa de
dibujo.

2. Sidesea dibujar con la herramienta Brush (Pincel), realice una de las siguientes acciones:
o Enlabarrade herramientas de herramientas, seleccione la herramienta &~ Brush (Pincel).
« En el menu superior, seleccione Tools > Brush (Herramientas > Pincel).
o Pulse Alt + B.

Si desea dibujar con la herramienta Pencil (Lapiz), realice una de las siguientes acciones:

« En labarra de herramientas de herramientas, seleccione la herramienta & Pencil (Lapiz).
« En el mend superior, seleccione Tools > Pencil (Herramientas > Lapiz).
o Pulse Alt +/.

3. En lalista Presets (Valores predefinidos) de la vista de propiedades de la herramienta, seleccione
un pincel o ldpiz predefinido que desee utilizar.
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4. Utilice el control deslizante Maximum Size (Tamafo maximo) para seleccionar el tamafo deseado
para el pincel o lapiz.

5. Para seleccionar un color, haga clic en el color que desee utilizar en la vista de color. Para obtener
mas informacion sobre la creacién y edicidén de colores, consulte Creacidn o edicidn de muestras de

colores en la pagina 66.

W Palettes

Scene Palettes

7. Sidesea realizar cambios en su pincel o ldpiz, en la vista propiedades de la herramienta, haga clic en
el botdn de flecha para abrir el cuadro de didlogo Brush Properties (Propiedades del pincel) o Pencil
Properties (Propiedades del ldpiz). En el cuadro de didlogo Brush Properties (Propiedades del
pincel), puede personalizar el tamafo, la forma, la textura, el caladoy el suavizado de linea del
pincel. En el cuadro de didlogo Pencil Properties (Propiedades del lapiz), puede personalizar el
tamano, el suavizado, la textura y los finales de linea del lapiz.

. /\/ n
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CONSEJOS

« Puede ajustar rapidamente el tamafo de la herramienta de dibujo seleccionada
manteniendo pulsada la tecla y, a continuacion, haciendo clicen lateclaOvy, a
continuacion, arrastrando en el espacio de dibujo. Si utiliza un lapiz de tableta, al hacerlo
con la punta del borrador del Llapiz ajustara el tamario de la herramienta Eraser (Borrador),
independientemente de la herramienta de dibujo seleccionada.

« Simantiene pulsada la tecla MayUs antes de dibujar o mientras lo hace, dibujara una linea
recta.

« Simantiene pulsada la tecla barra espaciadora mientras dibuja una linea recta, se fijara el
angulo de la linea. Si utiliza una tableta sensible a la presion, puede dibujar sobre la linea
para ajustar su grosor.

« Simantiene pulsadas las teclas MayUs y Alt antes de dibujar o mientras lo hace, dibujara
una linea recta horizontal o vertical.

« Simantiene pulsada la tecla Ctrl (Windows/Linux) o 36 (macOS) mientras dibuja, su trazo
de dibujo se convertira en una forma cerrada.

o Simantiene pulsada la tecla Alt antes de dibujar un trazo y comienza a dibujar cerca de un
dibujo existente, el comienzo del trazo se conectara con el otro dibujo.

« Simantiene pulsada la tecla Alt mientras dibuja, y finaliza el trazo de dibujo cerca de otro
dibujo existente, el final del trazo se conectara con dicho dibujo.

Ajuste de ilustracion

Harmony ofrece distintas maneras de ajustar los dibujos. Puede deshacer el Ultimo trazo, borrar partes de un
dibujo, mover, transformar o eliminar trazos, y modificar los puntos y las curvas de los trazos.

NOTA

No puede manipular o modificar los trazos del dibujo al dibujar en una capa de mapa de bits;
consulte Adicidn de capas en la pagina 36.

Deshacer el ultimo trazo

1. Realice una de las siguientes acciones:
« En el mend superior, seleccione Edit > Undo (Editar > Deshacer).

o Pulse Ctrl + Z (Windows/Linux) o 38 + Z (macQS).
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Como borrar

1. En la barra de herramientas de herramientas, seleccione la herramienta & Eraser (Borrador) o
pulse Alt + E.

2. En lavista de dibujo o de cdmara, dibuje un trazo de borrador sobre las partes del dibujo que desee
borrar.

Manipulacion de los trazos del dibujo

1. En la barra de herramientas de herramientas, seleccione la herramienta & Select (Seleccionar) o
pulse Alt + S.

2. En lavista de camara o de dibujo, seleccione los trazos que desee editar realizando una de las
siguientes acciones:

o Haga clic en un trazo para seleccionarlo.

« Mantenga pulsada la tecla Mayus mientras hace clic en un trazo para agregarloa la
seleccion.

« Dibuje un lazo alrededor de los trazos de dibujo para seleccionarlas simultaneamente.

3. Realice una de las siguientes acciones para editar la seleccidn:

o Para cambiar la ilustracidn seleccionada de posicidn, haga clicen ellay arrastrela a la
posicion deseada.
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NOTA
También puede realizar un desplazamiento pequefio de la seleccién con las
teclas de flechay, para realizar un desplazamiento rapido, mantenga pulsado

Mayus y pulse las teclas de flecha.

o Para rotar lailustracion seleccionada, haga clic fuera de la imagen y coja uno de los

controladores en las esquinas del cuadro de control y rétela.

o Para escalar lailustracidn seleccionada, haga clicy arrastre uno de los puntos de control en

las esquinas o en el centro de los bordes del cuadro de control.

CONSEJO

Mientras escala la ilustracion, puede conservar las proporciones manteniendo

pulsada la tecla MaydUs.

o Parasesgar, arrastre hacia los lados o hacia arriba y abajo de los lados o los segmentos

superior e inferior, entre los puntos de control.
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o Para eliminar, pulse Supr (Windows/Linux) o retroceso (macOS).

Edicién de las lineas

1. Realice una de las siguientes acciones:

« Sidibujé con la herramienta Brush (Pincel), en la barra de herramientas de herramientas,
haga doble clicen % Contour Editor (Editor de contorno) y seleccione 2’ Centerline Editor
(Editor de linea central) en el menl emergente, o pulse Alt + W.

« Sihadibujado con la herramienta Pencil (Lapiz), en la barra de herramientas de
herramientas, seleccione la herramienta % Contour Editor (Editor de contorno) o pulse Alt +

Q.

2. En la vista de dibujo o de cdmara, haga clic en la forma, el contorno o la linea de lapiz que desee
editar cerca del drea que desee modificar.

Aparecen los puntos de control de la forma o de la linea.

/

3. Hagaclicen uno de los puntos para seleccionarlo.

Aparecen los controladores de curva Bézier del punto, asi como los controladores de curva Bézier
para los puntos circundantes.
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CONSEJO

Puede seleccionar varios puntos dibujando un lazo alrededor de los mismos, o
manteniendo pulsado MayUs mientras hace clic en los puntos para agregarlos a la
seleccién. Puede utilizar Contour Editor (Editor de contorno) para escalar y rotar una
seleccién de varios puntos habilitando la opcidn Ly Show Contour Editor Control
(Mostrar control de editor de contorno) en la vista de propiedades de la herramienta.

4. Realice una de las siguientes acciones:

o Para mover un punto o una seleccidn de varios puntos, haga clic y arrastrelo.

o Para cambiar la curva en ambos lados de un punto, arrastre uno de sus controladores de
curva Bézier.

o Para cambiar la curva en un solo lado de un punto, mantenga pulsada la tecla Alty, a
continuacion, arrastre uno de sus controladores de curva Bézier.
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« Para deformar la curva entre dos puntos, mantenga pulsada la tecla Mayus y arrastre el
contorno entre dos puntos.

o Para eliminar los controladores de curva Bézier de un punto y hacer que las lineas a las que
estd conectado sean rectas, mantenga pulsada la tecla Alt y haga clic en el punto.

VA
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« Laslineasrectas no tienen controladores de curva Bézier en sus puntos de forma
predeterminada. Para crear controladores de curva Bézier para estos puntos y hacer que sus
lineas sean curvas, mantenga pulsada la tecla Alt y, a continuacion, haga clicy mantenga
pulsado el puntoy arrastre el cursor del ratdn lejos de él. Un nuevo controlador de curva
Bézier seguird el cursor del ratén hasta que suelte el botdn del raton.

« Para agregar un punto de control, pulse Ctrl (Windows/Linux) o & (macOS) y haga clic en el
contorno donde desea que se cree el nuevo punto.

o Paraeliminar un punto de control, seleccione el punto de control y pulse Supr
(Windows/Linux) o retroceso (macQS).

Cdmo cortar dibujos

1. En la barra de herramientas de herramientas, seleccione la herramienta Cutter (Cuchilla) = o pulse
Alt+T.
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2. En la vista de cdmara o de dibujo, dibuje un lazo alrededor del trabajo que desea cortar.

El trabajo dentro del lazo que ha dibujado se cortara del resto del trabajo y se seleccionara.

.:Q:. CONSEJOS
« Puede agregar otra parte del trabajo a la seleccidn manteniendo pulsado Mayusy
dibujando otro lazo.
« De forma predeterminada, la herramienta Cutter (Cuchilla) solo funcionard en la

capa actual. Puede cortar trabajos de todas las capas visibles manteniendo pulsada
la tecla Ctrl (Windows/Linux) o 3£ (macOS).

3. Unavez que haya cortado la imagen, puede manipularla como con la herramienta Select
(Seleccionar). Por ejemplo:

o Para mover el trabajo seleccionado, haga clic y arrastrelo.
o Para eliminar el drea seleccionada, pulse Supr.

o Para escalar, rotar o sesgar la seleccidn, utilice los controles alrededor del cuadro delimitador
de la seleccidn.
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Cdmo recortar una sola linea

1. En la barra de herramientas de herramientas, seleccione la herramienta Cutter (Cuchilla) = o pulse
Alt+T.

2. Enlavista de propiedades de la herramienta, en Cutter Tool Options (Opciones de herramienta de
cuchilla), seleccione el lazo

Se activan los modos Line Cutter Gesture (Gesto de cuchilla de linea).
3. Seleccione el modo Single Line Cutting Gesture (Gesto de corte de una sola linea) * .

4. En lavista de escena o de cdmara, deslice la herramienta Cutter (Cuchilla) por el extremo de una
linea que desee recortar.

El extremo de la linea desaparece.

Antes
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Después

NOTA

Incluso si el gesto del ratdn toca otras lineas, solo desaparece la primera linea con la que la
herramienta Cutter (Cuchilla) entra en contacto.
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Como recortar varias lineas

1. En la barra de herramientas de herramientas, seleccione la herramienta Cutter (Cuchilla) = o pulse
Alt+T.

2. Enlavista de propiedades de la herramienta, en Cutter Tool Options (Opciones de herramienta de
cuchilla), seleccione el lazo

Se activan los modos Line Cutter Gesture (Gesto de cuchilla de linea).

3. Enlavista de propiedades de la herramienta, seleccione Multiple Lines Cutting Gesture Mode
(Modo de gesto de corte de varias lineas) .

4. En lavista de escena o de camara, deslice la herramienta Cutter (Cuchilla) por el extremo de una
linea que desee recortar.

Los extremos de la linea desaparecen.

Antes

Después
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AR

A=

Acerca de estilos artisticos, herramientas de dibujo y tipos de capas

Las dos herramientas de dibujo principales en Harmony son la herramienta &~ Brush (Pincel) y la herramienta
£ Pencil (Lépiz). Segun el estilo de dibujo que desee lograr, es posible que prefiera trabajar con capas de
vectores o de mapas de bits.

En las capas de vectores, es posible dibujar con lineas de lapiz, lineas de lapiz con textura, pinceles de vectores
y pinceles de vectores con textura. Mientras que las lineas de lapiz son lineas centrales de vectores a las que
puede agregar grosor, los trazos de pincel son formas de vector sélidas rellenas con un color y los trazos de
pincel con textura son trazos de pincel rellenos de una textura de mapa de bits que filtra su color.
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I Trazo de pincel de I

|

I Linea de Llépiz con I

I Trazo de pincel con I

En las capas de mapa de bits, solo puede dibujar utilizando pinceles de mapa de bits sdélidos o con textura. Por
lo tanto, aunque las capas de vectores son mas flexibles porque permiten manipular y ajustar facilmente partes
de lailustracion, también pueden albergar mas estilos artisticos.

Sin embargo, si utiliza un pincel con textura en una capa de vectores, los trazos de pincel tendran una textura
de mapa de bits. Esto significa que, al igual que con ilustraciones en capas de mapa de bits, intentar ajustar o
cambiar el tamafio de un trazo de pincel con textura requerird que Harmony vuelva a probar la textura, lo que
puede hacer que pierda calidad de imagen, a menos que su resolucion de textura se hubiera aumentado lo
suficiente antes de comenzar a dibujar.

Una de las dificultades del uso de pinceles con textura en los dibujos de vectores es que, mientras que los
dibujos de mapa de bits siempre estan hechos de un solo lienzo plano, los trazos de pincel de vectores se
guardan como objetos independientes. Esto significa que colocar muchos trazos de pincel con textura en un
dibujo de vectores requerira que Harmony almacene la textura para cada uno de estos trazos y los componga
en tiempo real para mostrar el dibujo. Esto puede hacer que los dibujos de vectores cargados de textura, a
diferencia de los dibujos de mapa de bits, hagan que el rendimiento de la aplicacion sea mas lento y el tamario
del archivo sea mayor. Sin embargo, este es el Unico caso en el que es probable que un dibujo de vectores sea
mas pesado que un dibujo de mapa de bits.

Aunque no se recomienda para el esbozo, las lineas de lapiz con textura son una buena solucidn. Las lineas de
Llapiz con textura son mas ligeras y faciles de editar. Esto significa que la textura se actualizard con la
transformacion si escala o ajusta la linea de lapiz. Esto también significa que se puede cambiar la textura
aplicada a una linea de lapiz existente o aplicar una textura a una linea de lapiz que aun no la tenga. Las
texturas de pincel se recomiendan sobre las lineas de ldpiz con textura cuando se trata de conseguir pinceladas
de aspecto natural.
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NOTA

Incluso si aplana la ilustracion, los trazos de pincel con textura de distintos colores no se pueden
aplanar juntos en capas de vectores.

En la siguiente tabla se comparan los distintos enfoques de dibujo disponibles en Harmony:

Herramienta

de dibujo

Lapiz sélido

Vector

Especificaciones

Ventajas: muy ligero y facil de ajustar. Se puede manipular, volver a colorear y
ajustar mediante la linea central. Se puede acercar o aumentar de tamarfio sin perder
calidad.

Desventajas: no estd optimizado para transparencia.

Uso recomendado: dibujos limpios con un estilo de contorno sélido y uniforme.

Lapiz con
textura

Vector

Ventajas: ligero y facil de ajustar. Se puede manipular, volver a colorear y ajustar
mediante la linea central. Se puede acercar o aumentar de tamafio sin perder calidad.

Desventajas: no esta optimizado para transparencia. No se recomienda para realizar
bocetos. No tiene un aspecto tan natural como los pinceles con textura.

Uso recomendado: para ilustraciones de textura ligera o de estilo mixto que
requieren mucha manipulacién de lineas.

Pincel de
vectores
sélido

Vector

Ventajas: tamafio de archivo ligero. Reproduce el estilo de animacidn tradicional. Se
puede manipular, volver a colorear y editar mediante el contorno o la linea central. Se
puede acercar o aumentar de tamafio sin perder calidad.

Desventajas: no puede reproducir el aspecto de los medios naturales.

Uso recomendado: bocetos, dibujos limpios de animacidn tradicional.

Pincel de
vectores con
textura

Vector

Ventajas: se puede reproducir el aspecto de los medios naturales. Cuenta con las
mismas capacidades que los pinceles de mapa de bits con textura, pero se puede
manipular, editar y volver a colorear como un pincel de vectores sélido.

Desventajas: los trazos superpuestos de pincel pueden provocar que el dibujo haga
que el rendimiento de la aplicacidn sea lento y el tamafio de los archivos sea pesado.
Los trazos de pincel de distintos colores no se pueden aplanar a la vez. Si se ajusta,
aumenta de tamafio o acerca la ilustracidn, puede disminuir la calidad de la textura.

Uso recomendado: para ilustraciones con textura de estilo de mapa de bits ligera o
ilustraciones de estilo mixto.
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Herramienta
de dibujo

Pincel de
mapa de bits
con textura

Mapa
de
bits

Especificaciones

Ventajas: se puede reproducir el aspecto de los medios naturales. Mejor rendimiento
y tamafio de archivo mas ligero que las ilustraciones de vectores cargados de textura.
Se puede editar pixel a pixel.

Desventajas: los trazos de pincel siempre se aplanan a la vez y no se pueden
modificar por separado. Solo se pueden dibujar o borrar. Si se aumenta de tamano o
se acerca lailustracion, puede disminuir la calidad de la imagen.

Uso recomendado: ilustracién de mapa de bits cargado de textura.
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Capitulo 5: Como pintar

Toon Boom Harmony Advanced incluye algunas funciones de pintura muy Utiles para agregar color a los
dibujos. Mientras que otro software solo permite que los usuarios trabajen con muestras de color de una en una,
la pintura en Harmony se realiza con paletas que contienen varias muestras de color que se pueden almacenar
y reutilizar seguin sea necesario.

00 L JATEAC | JOER |

En la vista de color, seleccione una muestra de color distinta para cada color que desee pintar en el dibujo.
Puede agregar todas las muestras de color que desee. También puede cambiar el nombre a las existentes y
modificarlas.

L

Cuando modifique el color de una muestra existente, se actualizaran automaticamente todas las zonas pintadas
con esta muestra en toda la escena. La muestra de color tiene un nimero de ID exclusivo que la asocia con las
zonas pintadas. De este modo, puede cambiar el aspecto del personaje en cualquier momento sin necesidad de
volver a pintarlo.

64



Guia de introduccién de Harmony 21 Advanced

Otra ventaja de este sistema es que puede crear paletas completas para distintas situaciones de luz. Por
ejemplo, ademas de la paleta habitual para un personaje, también puede tener una para ese personaje en la
Lluvia con colores mas apagados y menos vivos que los colores de dias secos, o incluso otra para una escena de
noche. De este modo, el uso de paletas vinculadas a un personaje permite cambiar el color al instante para
ajustarse al clima y al ambiente de la escena sin necesidad de volver a pintar cada elemento.

Paletas de colores

En animacidn se utilizan colores especificos para pintar cada parte de cada personaje. Con el fin de mantener
una coherencia absoluta, se debe crear una paleta de colores base para cada personaje, prop y efecto de la
produccidn. A esto se le denomina paleta maestra.

Las paletas maestras contienen una muestra de color para cada area que se deba colorear. Cada muestra
almacena un color de niveles precisos de rojo, verde, azul y opacidad (a este ultimo se le denomina alfa).

El uso de una paleta de colores maestra tiene muchas ventajas, entre otras:
« Cada personaje conserva permanentemente sus colores especificos.
« No puede usar por error un color que no esté en la paleta maestra.
« Estandarizacién y uniformidad del color durante la produccidn.
« Varios artistas pueden usar la misma paleta de colores y generar los mismos resultados.

Harmony utiliza paletas para mantener todos los colores necesarios para pintar los elementos, lo que permite
un control y uniformidad totales del proceso de pintado.

Una paleta se crea asignando un conjunto de colores a cada personaje, prop o efecto. Creard una nueva paleta
y agregara un nuevo color, conocido como muestra de color, para cada zona del personaje, como la piel, el pelo,
la lengua, la camiseta, los pantalones, etc.

Creacion de una nueva paleta

1. En el mend de vista de color, seleccione Palettes > New (Paletas > Nueva) o haga clic en el botén
New Palette (Nueva paleta).

Se abre el cuadro de didlogo Create Palette (Crear paleta).

2. Introduzca el nombre de la paleta segun el modelo.

MNew Palette Name: Me:

Palette Ty

3. Hagaclicen OK (Aceptar).

La paleta aparece en la lista de paletas.
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Eallhdl

Creacidn o edicion de muestras de colores

1. Sidesea crear una nueva muestra de color, haga clicen el botén 4 Add Colour (Agregar color) en
la vista de color. Si desea editar una muestra de color existente, seleccione el color en la vista de
color.

2. Realice una de las siguientes acciones para editar la muestra de color:
« En el mendde vista de color, seleccione Colours > Edit (Colores > Editar).
« Haga doble clic en la muestra de color.

Se abre la ventana Coulour Picker (Selector de color).

3. Paradefinir el color, realice una de las siguientes acciones:

o Seleccione Red (Rojo), Green (Verde), Blue (Azul), Hue (Matiz), Saturation (Saturacion)
o Value (Valor) para cambiar el espectro del circulo cromatico y, a continuacion, haga
clic en el color que desee en el circulo cromatico.

« Introduzca los valores de matiz, saturacion, valor, rojo, verde y azul de forma manual
en los campos correspondientes. Todos los valores oscilan entre Oy 255.
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NOTA

Si cambia una muestra de color después de haber dibujado o pintado con él areas de un dibujo,
todas las dreas pintadas con este color en los dibujos vectoriales se actualizaran al nuevo color.

Pintado

Puede pintar las zonas cerradas de los dibujos con la herramienta Paint (Pintar).

Cémo pintar dibujos

1. En lavista de linea de tiempo o de carta de rodaje, seleccione el dibujo que desea pintar.

2. En la barrade herramientas de herramientas, seleccione la herramienta ® Paint (Pintar) o pulse
Alt +1.

3. En lavista de color, seleccione una paleta del personaje.

4. Seleccione un color de la paleta.

Scene Palettes

[Adlw ]
‘Wm0 s B *

5. En la vista de dibujo o de camara, comience a pintar el dibujo con los colores.
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NOTA

Al abrir una escena, las paletas de esta no se cargaran inmediatamente en la vista de color.
Primero debe seleccionar un dibujo.

Cierre de huecos

Al pintar, puede encontrar que algunas areas del dibujo no estaban completamente cerradas debido a
pequefios huecos en los contornos, lo que impide que la herramienta Paint (Pintar) rellene el area, ya que solo
rellena formas cerradas. Para cerrar la zona, puede dibujar una linea sobre el hueco con la herramienta Brush
(Pincel) o Pencil (Lapiz). Sin embargo, solo es posible cerrar el hueco agregando encima una linea invisible, que
la herramienta Paint (Pintar) considerara como una linea normal. En Harmony, las lineas invisibles utilizadas
para definir las dreas que se deben colorear se denominan lineas vectoriales transparentes.

La herramienta Close Gap (Cerrar hueco) permite cerrar pequefios huecos en el contorno de un dibujo
dibujando al instante una linea vectorial transparente para rellenar el hueco. A diferencia de la herramienta
Stroke (Linea vectorial transparente), con la herramienta Close Gap (Cerrar hueco) no tiene que dibujar con
precisidn. Solo tiene que dibujar un trazo basico junto al hueco para que se cree automdaticamente una linea
vectorial transparente recta que conecte directamente un extremo del hueco al otro.
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Uso de la herramienta Close Gap (Cerrar hueco)

1. Antesde trabajar con lineas vectoriales transparentes, se recomienda habilitar la opcién Show
Strokes (Mostrar lineas vectoriales transparentes), de modo que pueda verlas en la vista de dibujo o
de camara. Puede habilitar la opcién Show Strokes (Mostrar lineas vectoriales transparentes)
realizando una de las siguientes acciones:

« En el menu superior, seleccione View > Show > Show Strokes (Ver > Mostrar >
Mostrar lineas vectoriales transparentes).

o Pulse K.
2. Realice una de las siguientes acciones:

e Enlabarra de herramientas de herramientas, seleccione la herramienta ( Close
Gap (Cerrar hueco).

« En el menu superior, seleccione Drawing > Drawing Tools > Close Gap (Dibujo >
Herramientas de dibujo > Cerrar hueco).

o Pulse Alt +C.
3. En lavista de camara o de dibujo, trace una linea invisible cerca del hueco que se va a cerrar.

El hueco se cierra automdaticamente.

NOTA

La herramienta Paint (Pintar) también incluye una opciéon Close Gap (Cerrar hueco), que se
puede habilitar en la vista de propiedades de la herramienta. Cuando esté habilitada,
Harmony intentara encontrar y cerrar automaticamente pequefios huecos cuando intente
rellenar una forma que no esté cerrada.
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Capitulo 6: Creacion de una animacion tradicional sin papel

Creacidon de un boceto de animacidn

El primer paso para crear una animacion sin papel es la creacién de un boceto, que es el esqueleto de la
animacion. Por lo general, empezaria animando la parte mas importante de la accidn de un personaje. Por
ejemplo, para animar un ciclo de andar, comenzara por el movimiento del torso y de las piernas. Después se
puede agregar una animacion secundaria como la cabeza, los brazos y la ropa.

Para que la animacidn sea satisfactoria, comience animando la accidn principal con esbozos basicos y rapidos y,
a continuacion, agregue los detalles cuando esté satisfecho con el movimiento. Si comienza a animar todos los
detalles inmediatamente, perdera mucho tiempo en caso de tener que realizar correcciones, y es probable que

la animacidn tenga una apariencia rigida.

Creacién de un boceto de animacidén

1. En lafila superior de la vista de linea de tiempo, haga clic en m Show All Thumbnails (Mostrar
todas las imdgenes en miniatura) para habilitar el modo Thumbnail (Imagen en miniatura).

‘A
wOS AN

3

2. Pulse Ctrl + U (Windows/Linux) o 36 + U (macQS) para abrir el cuadro de didlogo Preferences
(Preferencias).

3. Seleccione la pestafia Exposure Sheet (Carta de exposicién).

4. Seleccione la opcion Use Current Frame as Drawing Name (Usar fotograma actual como nombre de
dibujo). Cuando esta preferencia esté habilitada, los dibujos nuevos se nombraran con el ndmero de
fotograma en el que se crearon.
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5. En la barra de herramientas de herramientas, seleccione la herramienta & Brush (Pincel) o pulse
Alt + B.

6. En la vista de color, seleccione un color para el pincel. Es una buena idea elegir un color claro para el
boceto de animacion. Esto facilitara el proceso de clean up, ya que las lineas oscuras y limpias haran
contraste con las lineas esbozadas claras.

7. En lavista de linea de tiempo o de carta de rodaje, seleccione la celda en la que desea que aparezca

el primer dibujo.

8. En la vista de camara o de dibujo, dibuje el primer dibujo clave.

9. Aumente el nivel de zoom de la vista de linea de tiempo hasta que vea las imagenes en miniatura
dentro de las celdas realizando una de las siguientes acciones:

o Arrastre el control deslizante _Timeline Zoom (Zoom de linea de tiempo) hacia
la derecha.

« Haga clicen la pestafia de la vista de linea de tiempo y pulse 2 de forma reiterada.
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o Mueva el cursor del ratén en la vista de linea de tiempo, mantenga pulsado Ctrl
(Windows/Linux) o & (macOS) y gire la rueda del ratdn hacia arriba.

-ErL T
[

10. Con la primera celda aun seleccionada, realice una de las siguientes acciones para marcar el dibujo
como dibujo clave. Esto le ayudara a mantener el orden.

« Habilite la barra de herramientas Mark Drawing (Marcar dibujo) seleccionando
Windows > Toolbar > Mark Drawing (Ventanas > Barra de herramientas > Marcar
dibujo) en el menu superior y, a continuacidn, haga clic en el botén @ Mark Selected
Drawings as Key (Marcar como dibujo clave).

« Habilite la barra de herramientas de carta de rodaje centrandose en la carta de rodaje
y seleccione Windows > Toolbar > Xsheet (Ventanas > Barra de herramientas >
Carta de rodaje) en el mend superior. A continuacién, haga clic en el botén & Mark as
Key Drawing (Marcar como dibujo clave).

o Enelmendde la vista de linea de tiempo, seleccione Drawings > Mark Drawing As >

Key Drawing (Dibujos > Marcar dibujo como > Dibujo clave).

11. En lavista de linea de tiempo o de carta de rodaje, seleccione la celda en la que desea que aparezca
el préximo dibujo clave.

12. En labarra de herramientas de herramientas, haga clic en el botén é Onion Skin (Papel cebolla).
Esto mostrard los dibujos anteriores y siguientes en un color claro en la vista de cdmara o de dibujo,
detrds del dibujo actual, para que pueda utilizarlos como referencias para realizar nuevos dibujos
con precision. Esta opcidn puede ser Util para dibujar poses de descomposicion entre dos poses
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clave, o para agregar un dibujo intercalado entre otros dos dibujos.

[ Intervalo de dibujos mostrados en papel l

13. Asegurese de que el papel cebolla muestre el primer dibujo clave para que pueda basar el segundo
dibujo clave en él. Para llevarlo a cabo, realice una de las siguientes acciones:

o En lavista de linea de tiempo, haga clic y arrastre el marcador de papel cebolla roja
para que incluya los dibujos anteriores que desea mostrar en el papel cebollay, a
continuacion, haga clicy arrastre el marcador de papel cebolla verde para que incluya
los siguientes dibujos que desea mostrar en el papel cebolla.

« Utilice los botones de la barra de herramientas sobre el espacio de dibujo para ajustar
la cantidad de dibujos anteriores y siguientes que se van a incluir en el papel cebolla:

o Para aumentar la cantidad de dibujos anteriores que se van a mostrar, haga clic
en el botdn é Add Previous Drawing (Agregar dibujo anterior) en la barra de
herramientas de la vista de camara/dibujo.

o Parareducir la cantidad de dibujos anteriores que se van a mostrar, haga clicen
el botén = Remove Previous Drawing (Eliminar dibujo anterior) en la barra de
herramientas de la vista de camara/dibujo.

o Para aumentar la cantidad de dibujos siguientes que se van a mostrar, haga clic
en el botdn % Add Next Drawing (Agregar dibujo siguiente) en la barra de
herramientas de la vista de camara/dibujo.

o Parareducir la cantidad de dibujos siguientes que se van a mostrar, haga clic en
el boton == Remove Next Drawing (Eliminar dibujo siguiente) en la barra de
herramientas de la vista de cadmara/dibujo.
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Intervalo de dibujos mostrados en papel

NOTA

En la vista de dibujo, puede utilizar la barra de herramientas de papel cebolla
para que el papel cebolla solo muestre tipos especificos de dibujos, como dibujos
clave o descomposiciones. Tenga en cuenta que esto no funciona en la vista de

camara.

14. Cree un nuevo dibujo vacio mediante una de las siguientes acciones:

« En labarra de herramientas de linea de tiempo o de carta de rodaje, haga clic en el
botén #<| Create Empty Drawing (Crear dibujo vacio).

o Pulse Alt + Mayus + R.

15. En la vista de camara o de dibujo, dibuje el segundo dibujo clave.
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17. En lavista de linea de tiempo o de carta de rodaje, seleccione una celda entre los dos dibujos clave.

18. Al usar los marcadores de papel cebolla, asegurese de que el papel cebolla cubra tanto el primer

como el dltimo dibujo.

[ Intervalo de dibujos mostrados en papel l

19. Cree un nuevo dibujo vacio mediante una de las siguientes acciones:

o En la barra de herramientas de linea de tiempo o de carta de rodaje, haga clic en el
botdén ¥<| Create Empty Drawing (Crear dibujo vacio).

o Pulse Alt + Mayus + R.

20. En lavista de cdmara o de dibujo, dibuje la nueva pose.

21. En lavista de linea de tiempo o de carta de rodaje, seleccione una nueva celda y repita los pasos

anteriores para cada nuevo dibujo.

NOTA
<

Al trabajar con capas de superposicion en la vista de camara, puede habilitar la opcion £
Current Drawing on Top (Dibujo actual encima) de la barra de estado debajo de la vista de
camara para hacer que la capa en la que esta trabajando aparezca sobre las otras capas.
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Revision de la animacion

Al realizar un flipping por los dibujos se puede ver si los dibujos en los que se estd trabajando conectan bien
entre siy crean la ilusién de movimiento adecuada. Puede desplazarse rapidamente por los dibujos con los
atajos de teclado para ir al dibujo anterior e ir al dibujo siguiente, o con la barra de herramientas de flipping
sencillo.

Desplazamiento por los dibujos

1. En lavista de linea de tiempo o de carta de rodaje, seleccione el dibujo desde donde desee
desplazarse.

2. Realice una de las siguientes acciones:
e Pulse F parair al dibujo anterior.
o Pulse G parair al dibujo siguiente.

3. Pulse ambos atajos de forma reiterada con rapidez para desplazarse por los dibujos hacia atras o
hacia delante.

Uso de la barra de herramientas de flipping sencillo

1. Cambie a la vista de dibujo.

2. En el menu superior, seleccione Windows > Toolbars > Easy Flipping (Ventanas > Barras de
herramientas > Flipping sencillo) para habilitar la barra de herramientas de flipping sencillo.

3. Enlabarra de herramientas de flipping sencillo, haga clic en el botén €1 Previous (Anterior) o 1»
Next (Siguiente) para ver el dibujo anterior o siguiente de la animacidn.

4. Para mostrar los dibujos del primer fotograma después de llegar al ultimo fotograma de la
animacion, seleccione la opcién Loop (Bucle).

- loop

5. Mueva el control deslizante hacia la derecha para desplazarse hacia delante y hacia la izquierda
para desplazarse hacia atras por los dibujos.

Cuanto mas mueva el control deslizante hacia la izquierda o la derecha, mas deprisa se desplazaran
los dibujos.
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6. En el campo Preroll (Preprocesamiento), introduzca la cantidad de dibujos por los que desplazarse
automaticamente antes y después del dibujo actual.

7. En el campo FPS, introduzca la velocidad a la que desee desplazarse automaticamente por los
dibujos en fotogramas por segundo.

8. Hagaclicen el botén » Easy Flip (Flip sencillo) para desplazarse automaticamente por los dibujos
en funcion de la configuracion de Preroll (Preprocesamiento) y FPS.

Cuando el boceto de animacidn esté terminado, reproduzcalo para asegurarse de que es lo que se esperaba
antes de continuar con el siguiente paso.

Reproduccion de la animacién

1. En la vista de linea de tiempo, haga clic en el botén del modo @ Solo a la izquierda de cada capa
gue desee ver durante la reproduccion en la vista de linea de tiempo para habilitar el modo @ Solo
en estas capas.

roSalM

Cuando una o mas capas tengan habilitado el modo Solo, Unicamente se mostraran las capas que
tengan este modo habilitado, y las otras capas quedaran ocultas.

2. En lavista de linea de tiempo, mueva el cabezal rojo al primer fotograma de la animacién y haga clic
en el botdn Start (Iniciar) en la barra de herramientas de linea de tiempo. A continuacion, mueva el
cabezal al Ultimo fotograma de la animacién y haga clic en el botén Stop (Detener).

3. En la barra de herramientas de reproduccion, haga clic en el botdn O Loop (Bucle) para habilitar la
opcion de bucle durante la reproduccion.

4. En labarra de herramientas de reproduccion, haga clic en el botén » Play (Reproducir) para

comenzar la reproduccién.

Limpieza

Una vez que se haya completado el boceto de animacidn, es el momento de limpiarlo y tintarlo. A este paso
también se le denomina trazado. Consiste en trazar lineas sélidas y limpias sobre el boceto de animacién para
cerrar las zonas abiertas. Es el paso final de la animacion sin papel antes del paso de ink and paint.

77



Capitulo 6: Creacidn de una animacion tradicional sin papel

En una animacidn tradicional, los dibujos de clean up se suelen trazar en una nueva hoja de papel con el boceto
debajo, que se puede ver con la mesa de luz del disco de animacion. Del mismo modo, en Harmony, tendra que
agregar una nueva capa de dibujo en el dibujo donde desee dibujar dibujos de clean up. Cuando haya
terminado la limpieza, simplemente puede desactivar la capa que contiene el boceto de animacion para que no
aparezca en la animacion final. Este enfoque también permite mantener los bocetos y los dibujos de clean up
intactos y administrarlos de manera independiente.

En la vista de cdmara, vera el boceto de animacién mientras trabaja en la capa de clean up. Si prefiere trabajar
en la vista de dibujo, puede habilitar lLa mesa de luz para mostrar el boceto de animacién mientras realiza

trazados en la capa de clean up.

Trazado de la animacion en una nueva capa

1. En lavista de linea de tiempo, cambie el nombre de la capa en la que cred el boceto de animacion
haciendo doble clic en sunombre e introduciendo el nuevo nombre, por ejemplo: "Boceto".

2. En lavista de linea de tiempo, agregue una capa realizando una de las siguientes acciones:

« Enlabarrade herramientas de capas de la vista de linea de tiempo, haga clic en el
botén % Add Drawing Layer (Agregar capa de dibujo).

o Pulse Ctrl + R (Windows/Linux) o &8 + R (macOS).

Aparece el cuadro de didlogo Add Drawing Layer (Agregar capa de dibujo).

Add and Close

2. En el campo Name (Nombre), escriba el nombre de la nueva capa, por ejemplo: "Clean-up".
2. Seleccione si desea que la capa Line Art (Lineas) sea Vector o Bitmap (Mapa de bits).
3. Seleccione si desea que la capa Colour Art (Capa de color) sea Vector o Bitmap (Mapa de bits).

4. Haga clicen Add and Close (Agregar y cerrar) para agregar una nueva capa y cerrar la ventana.
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Se agrega a la vista de linea de tiempo una nueva capa de dibujo.

5. En la vista de linea de tiempo, haga clic en el icono Lock (Bloguear) de la capa que contiene el
boceto de animacién para impedir que dicha capa se pueda seleccionar en la vista de cdmara.

6. En lavista de linea de tiempo o de carta de rodaje, seleccione la celda de la nueva capa que

corresponda al primer dibujo clave del boceto de animacidn.

7. Enlabarra de herramientas de herramientas, seleccione una herramienta de dibujo, como la
herramienta # Pencil (L3piz).

8. En la vista de color, seleccione un color para trazar la animacion. Seleccione un color oscuro intenso,
como el negro, para asegurarse de conseguir un contraste adecuado con el color claro del boceto de

animacion.

9. En lavista de camara o de dibujo, comience a trazar el primer dibujo clave.
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10.

11.

12.

NOTA

Si las capas de superposicion estan en medio, puede deshabilitarlas
temporalmente haciendo clic en su botdn (€4 Enable/Disable
(Habilitar/deshabilitar) en la vista de linea de tiempo para que solo se muestren

el boceto de animacidn y las capas de clean up.

En la vista de linea de tiempo o de carta de rodaje, seleccione la siguiente celda que corresponde a

un boceto de dibujo.

En la barra de herramientas de herramientas, haga clic en el botén é Enable Onion Skin (Habilitar

papel cebolla) para habilitar el papel cebolla.

Asegurese de que el papel cebolla muestre el dibujo de clean up anterior realizando una de las

siguientes acciones:

o En lavista de linea de tiempo, haga clicy arrastre el marcador de papel cebolla roja
para que incluya los dibujos anteriores que desea mostrar en el papel cebollay, a
continuacion, haga clicy arrastre el marcador de papel cebolla verde para que incluya
los siguientes dibujos que desea mostrar en el papel cebolla.
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« Utilice los botones de la barra de herramientas sobre el espacio de dibujo para ajustar
la cantidad de dibujos anteriores y siguientes que se van a incluir en el papel cebolla:

o Para aumentar la cantidad de dibujos anteriores que se van a mostrar, haga clic
en el botdn é Add Previous Drawing (Agregar dibujo anterior) en la barra de
herramientas de la vista de camara/dibujo.

o Parareducir la cantidad de dibujos anteriores que se van a mostrar, haga clicen
el botdn == Remove Previous Drawing (Eliminar dibujo anterior) en la barra de
herramientas de la vista de camara/dibujo.

o Para aumentar la cantidad de dibujos siguientes que se van a mostrar, haga clic
en el botdn % Add Next Drawing (Agregar dibujo siguiente) en la barra de
herramientas de la vista de cdmara/dibujo.

o Parareducir la cantidad de dibujos siguientes que se van a mostrar, haga clicen
el boton = Remove Next Drawing (Eliminar dibujo siguiente) en la barra de
herramientas de la vista de camara/dibujo.

13. En la vista de camara, trace el siguiente dibujo.

14. Repita los pasos anteriores para cada dibujo.
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Capitulo 7: Aplicacion de morphing a dibujos

La animacion dibujada a mano requiere que pase mucho tiempo trazando dibujos intercalados. La funcién de
morphing de Harmony puede ayudar a acelerar el proceso. Esta Util funcién crea automaticamente dibujos
generados por ordenador entre los dibujos de vectores para ahorrar tiempo y aumentar la productividad.
Puede modificar facilmente el tiempo y la velocidad (aceleracién y desaceleracién gradual) de una animacion de
morphing.

Uno de los principales usos de la funcién de morphing es la animacién de efectos. Por ejemplo, la animacién de
humo o agua puede llevar mucho tiempo, ya que estos tipos de efectos suelen ser de movimiento lento, lo que
requiere un gran numero de intercalados estrechamente conectados.

La funcién de morphing se utiliza para animar formas similares y simples, como pelo o humo. De este modo,
podra ahorrar tiempo durante tareas de intercalado y trazado pesadas. A su vez, le proporciona mas tiempo
para emplearlo en tareas complejas de animacién, como ciclos de andar o secuencias acrobdticas.

Para aprender a aplicar morphing a dibujos, es mejor comenzar con formas basicas, como circulos y rectangulos.
Una vez que esté mas familiarizado con la herramienta, puede aumentar sus conocimientos y experiencia. En
muy poco tiempo, producird algunos efectos notables.

Es dtil conocer los pros y los contras del morphing antes de comenzar. Si sabe lo que puede hacer y qué lineas
de dibujo pueden ser mas Utiles o probleméticas, podra disefiar dibujos clave para aplicar el morphing de forma
eficiente.

NOTA

Cuanto mas compleja es la forma, mas tarda en aplicarse el morphing. Si necesita mas tiempo para
transformar un dibujo que para dibujarlo a mano, es mejor animarlo en lugar de aplicar la técnica de
morphing. Sin embargo, si encuentra una ocasion en la que pueda aplicar morphing a los dibujos,
hagalo. Permite fijar el tiempo y la velocidad rapidamente sin la necesidad de crear dibujos
adicionales.
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Creacion de un elemento de morphing basico

1. En la barra de herramientas de linea de tiempo, haga clic en el botén ©. Add Drawing Layer
(Agregar capa de dibujo) para agregar una nueva capa al proyecto.

2. Cambie el nombre de la nueva capa (por ejemplo, Morphing).

3. En lavista de linea de tiempo o de carta de rodaje, seleccione la primera celda de la capa.

4. Realice una de las siguientes acciones:

« En labarra de herramientas de herramientas, seleccione la herramienta Rectangle
(Rectangulo) .

e Pulse Alt+7.

5. En la vista de camara o de dibujo, dibuje un rectangulo.

@ NOTA

Al dibujar un rectangulo o una elipsis, puede mantener pulsada la tecla Mayus
para dibujar su forma con las mismas dimensiones, asi como para hacer un

cuadrado o un circulo en su lugar. También puede mantener pulsada la tecla Alt
para dibujar la forma desde su centro y no desde su esquina.

6. Pinte el rectangulo con la herramienta Paint (Pintar).

7. En lavista de carta de rodaje o de linea de tiempo, seleccione la celda en la que desea que termine
la secuencia de morphing.
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rMo=anl
“.

8. Realice una de las siguientes acciones:

« En labarrade herramientas de herramientas, seleccione la herramienta Ellipse
(Elipse) O.

o Pulse Alt + =.

9. Dibujey pinte la elipse con el mismo contornoy colores de relleno que en el rectangulo.

10. En la vista de carta de rodaje o de linea de tiempo, seleccione el rango de fotogramas que va desde
el primer dibujo hasta el segundo dibujo, incluidos los fotogramas que contienen los mismos.

wO=al
{t.

11. Realice una de las siguientes acciones:

o En el menu superior, seleccione Animation > Morphing > Create Morphing
(Animacion > Morphing > Crear morphing).

« En lavista de carta de rodaje o de linea de tiempo, haga clic con el botén derechoy
seleccione Morphing > Create Morphing (Morphing > Crear Morphing).

o Pulse Alt+ M.

Aparecen las flechas que van desde el primer dibujo clave hasta el segundo dibujo clave, que
indican que se han creado los intercalados generados por ordenador.
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Ajuste de la velocidad de morphing
Si observa la animacidn, notara que el movimiento de morphing es constante. Para producir un movimiento

menos mecanico, es probable que desee crear alguna aceleracién o desaceleracién gradual.

Adicion de aceleracion y desaceleracion gradual a un elemento de morphing

1. En la barra de herramientas de herramientas, seleccione la herramienta Morphing ?}) o pulse F3.

2. En lavista de linea de tiempo, haga clic en un fotograma de la secuencia de morphing que desee

ajustar.

3. En lavista de propiedades de la herramienta, aumente o reduzca el valor de Ease In (Aceleracidn
gradual) y Ease Out (Desaceleracion gradual) para ajustar la velocidad de la secuencia.

4 Mmain

ya

Adicion de sugerencias de morphing

La herramienta Morphing de Harmony permite controlar su secuencia de morphing de muchas maneras. Una
de esas maneras es colocar sugerencias para asegurarse de que Harmony transforme los dibujos de la manera

que tenia prevista.

]
=

Las sugerencias son puntos que se colocan en los dibujos de origen y de destino para asociar zonas y lineas
entre los dos dibujos. Se utilizan para corregir errores de las transformaciones de dibujos que realiza Harmony,
como una linea que no sigue la zona de relleno de color o cuando una parte del dibujo de origen no se
transforma en su parte correspondiente del dibujo de destino. De forma predeterminada, Harmony asociara
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una esquina o un punto en el dibujo de origen con la esquina o punto mas cercanos del dibujo de destino. Por lo
tanto, las sugerencias son necesarias si la forma que se va a transformar o su movimiento son complejos.

Adicion de sugerencias

1. En lavista de linea de tiempo o de carta de rodaje, seleccione el dibujo de origen de la secuencia de
morphing.

2. Enlabarra de herramientas de herramientas, seleccione la herramienta ?}) Morphing o pulse F3.

Utilice como referencia el otro dibujo clave de morphing, mostrado en la esquina inferior derecha de
la vista de dibujo.

3. En lavista de propiedades de la herramienta, seleccione el tipo de sugerencia que desea utilizar.

o Seleccione Contour Hint (Sugerencia de contorno) para corregir el contorno de una
linea de pincel o de una zona de color (vector de contorno).
Los puntos de Contour Hint (Sugerencia de contorno) se comportaran de manera
similar a los puntos de Pencil Hint (Sugerencia de lapiz) cuando se utilicen en una linea
de lapiz. Tenga en cuenta que obtiene mejores resultados utilizando el punto de Pencil
Hint (Sugerencia de lapiz) en la linea de lapiz en lugar de los puntos de Contour Hint
(Sugerencia de contorno).

« Seleccione Pencil Hint (Sugerencia de lapiz) para corregir una linea de ldpiz (vector
central).
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o Seleccione Zone Hint (Sugerencia de zona) para corregir una coincidencia de
morphing de zona de color.

« Seleccione Vanishing Point Hint (Sugerencia de punto de desaparicién) para corregir
la trayectoria de una forma de desaparicion.

« Seleccione Appearing Point Hint (Sugerencia de punto de aparicién) para corregir la
trayectoria de una forma de aparicion.

4. En lavista de cdmara o de dibujo, haga clic en el dibujo situado junto al drea problemética.

5. Seleccione el punto de la sugerencia y muévalo a su posicidn correcta.

6. En lavista de linea de tiempo o de carta de rodaje, seleccione el dibujo de destino.

7. Busque y mueva el punto de la sugerencia correspondiente a la parte coincidente del dibujo de
destino.
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8. En la barra de herramientas de reproduccion, pulse el botén » Play (Reproducir) para ver el
resultado.
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Capitulo 8: Importacion de imagenes

De forma predeterminada, Harmony trabaja con imagenes de vectores creadas dentro de su propia interfaz.
Las imagenes de vectores se componen principalmente de informacion sobre las distintas formas que
componen las imdgenes, asi como de sus colores de linea y de relleno. Esto hace que sean faciles de editar y
pintar, y permite redimensionarlas sin que afecte a la calidad de la imagen. Por el contrario, las imagenes de
mapa de bits se componen de informacion de color sobre cada pixel individual que compone la imagen. Por lo
tanto, son mas adecuados para imagenes muy detalladas o realistas, pero no se pueden escalar sin perder
calidad de imagen, ni se pueden editar tan facilmente como las imagenes de vectores.

Normalmente, es necesario trabajar con imagenes de mapa de bits si debe crear algunos de los recursos de
escena, como fondos o props, en un software diferente. A continuacion, puede importar los archivos de
imagenes de mapa de bits en su escena de Harmony.

Alimportar una imagen de mapa de bits, debe decidir como debe procesarla Harmony. Puede elegir entre las

siguientes opciones:

o Keep as Original Bitmap (Mantener como mapa de bits original): importa la imagen exactamente tal
como esta y garantiza que no se pueda modificar cuando se trabaje en la escena. Esta opcidn es util para
utilizar fondos creados en el proyecto con un software diferente.

o Import as Toon Boom Bitmap Drawing (Importar como dibujo de mapa de bits de Toon Boom): importa
la imagen tal como estd, pero permite editarla con las herramientas de dibujo de mapa de bits de
Harmony.

« Importas Toon Boom Vector Drawing (Importar como dibujo vectorial de Toon Boom): convierte un
mapa de bits en un dibujo vectorial de Toon Boom que se puede pintar y editar facilmente con las
herramientas de dibujo vectorial de Harmony. Esta opcidon puede ser Util para la importacion de capa de
lineas escaneadas o creadas con un software diferente.

Importacion de una imagen de mapa de bits en su formato original

1. Realice una de las siguientes acciones:

« En el mend superior, seleccione File > Import > Images (Archivo > Importar >
Imagenes).

« En la barra de herramientas de archivo, haga clic en el botén ‘ Import Images
(Importar imagenes).

« En lavista de carta de rodaje, haga clic con el botdn derecho en cualquier parte del
area de fotogramas y seleccione Import > Images (Importar > Imagenes).

Se abre el cuadro de dialogo Import Images (Importar imdgenes).
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2. En la seccidn Files (Archivos) del cuadro de didlogo Import Images (Importar imagenes), haga clic en
Browse (Examinar) para buscar y seleccionar una o mas imagenes en el ordenador.

3. Agregue laimagen de mapa de bits a una nueva capa seleccionando la opcidon Create Layer(s)
(Crear capas) y una de las siguientes opciones:

o Create Single Layer Named (Crear una sola capa con nombre): Crea una nueva capa
con el nombre especificado e importa las imagenes en ella.

o Create Layer(s) Based on Filenames (Crear capas basadas en nombres de archivo):
Crea una capa basada en cada prefijo de nombre de archivo unico. Por ejemplo, si
importa tres archivos llamados a-1.tga, a-2.tgay b-1.tga, se crearan dos capas, una
denominada "a" y otra denominada "b". La capa "a" contendra las dos primeras
imdgenes, mientras que la "b" contendra la tercera.

« Add to a Existing Layer (Agregar a una capa existente): Importa lasimagenes en la
capa especificada. Tenga en cuenta que solo puede importar en las capas que son
compatibles con las opciones de importacion. Por ejemplo, si va a importar imagenes
como dibujos vectoriales, solo puede importarlas en capas de dibujos vectoriales.

4. En la seccidn Vectorization (Vectorizacidn), asegurese de que la opcidn Vectorize Image (Vectorizar
imagen) no esté marcada.

5. En la secciéon Import Options (Opciones de importacién), seleccione la opcién Keep As Original
Bitmap (Mantener como mapa de bits original).

6. En la seccion Alignment (Alineacion), decida el tamafio y la posicidn de la imagen dentro del
encuadre de cdmara. Puede elegir entre las siguientes opciones:
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Parametro

Descripcién

Fit (Ajustar)

Ajusta el tamano de la imagen para que se adapte completamente al campo de
la escena, tanto vertical como horizontalmente, asegurandose de que toda la

imagen sea visible.

Si la orientacién de la imagen es vertical, ajustard la altura de la imagen para
que se adapte a la altura del campo sin que afecte a la proporcidn de la

imagen:

Fotogra
madela

Imagen vertical | Fotogramade I

conreglade

Si la orientacidn de la imagen es horizontal, ajustara el ancho de la imagen
para que se adapte al ancho del campo sin que afecte a la proporcién de la

imagen:

Fotogra
ma de

Imagen horizontal | Fotograma de |

conreglade

Pan
(Panear)

Esto tiene el efecto opuesto al parametro de ajuste. La dimensién mas pequefia
de laimagen se ajustard a la dimensién coincidente del fotograma de la
escena, y la dimensidn mas grande de la imagen se ajustara
proporcionalmente, haciendo que la imagen llene todo el campo de la escena
y abarque mas alla de sus limites si su proporcién no coincide con la
proporcién del campo. Esta opcién se puede utilizar para importar una imagen
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de fondo de paneo, también denominada paneo.

Si la orientacién de la imagen es vertical, ajustara el ancho de laimagen para
que se adapte al ancho del campo sin que afecte a su proporcién:

Imagen vertical con
regla de alineacion

Fotogramade

Si la orientacidn de la imagen es horizontal, ajustard la altura de la imagen para
que se adapte a la altura del campo sin que afecte a su proporcion:

Fotograma || Resolucié || Imagen horizontal con

deescena || nde regla de alineacion de
Project Escala laimagen para que se ajuste a la resolucidon de la escena, haciendo que
Resolution cada pixel de laimagen tome un pixel del campo de la escena. Por ejemplo, si
(Resolucidén las dimensiones de laimagen en pixeles son la mitad de la resolucidn de la
de escena en pixeles, las dimensiones de la imagen pareceran ser la mitad de las
proyecto) dimensiones del campo de la escena.

7. Silaimagen tiene transparencia, en la seccidén Transparency (Transparencia), seleccione cémo se
premultiplicaron los valores de color en los pixeles semitransparentes de la imagen con sus valores
de alfa. Esto permite que Harmony demultiplique los valores para poder combinar correctamente la
imagen con los otros elementos de la escena.

Puede elegir entre las siguientes opciones:
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Parametro Descripcién

Los valores de color de los pixeles semitransparentes de la
imagen se han codificado de modo que cuanto mas
transparentes sean, mas cercanos al blanco estaran. Cuando

o ) . se carga unaimagen premultiplicada con blanco en un
Premultiplied with White

Lo software que no admite transparencia, aparece combinada
(Premultiplicado con blanco)

con un fondo blanco. Seleccione esta opcidn para hacer que
Harmony revierta esta premultiplicacién de modo que la
imagen se combine correctamente con otros elementos
visuales de la escena.

Los valores de color de los pixeles semitransparentes de la
imagen se han codificado de modo que cuanto mas
transparentes sean, mas cercanos al negro estaran. Cuando

o . se carga unaimagen premultiplicada con negro en un
Premultiplied with Black

e software que no admite transparencia, aparece combinada
(Premultiplicado con negro)

con un fondo negro. Seleccione esta opcidn para hacer que
Harmony revierta esta premultiplicacién de modo que la
imagen se combine correctamente con otros elementos
visuales de la escena.

El color de los pixeles semitransparentes en la imagen se
codifica independientemente de su transparencia. Cuando se
. carga una imagen que no esta premultiplicada en un software
Straight (Recto) . . , .
que no admite transparencia, los pixeles semitransparentes
simplemente aparecen completamente opacos, lo cual hace

que sus bordes parezcan pixelados.

Es lo mismo que Premultiplied with Black (Premultiplicado
con negro), salvo que también evita que los valores de color
de un pixel dado sean mas altos que el valor de alfa de dicho
Clamp Colour to Alpha (Fijar pixel. Esta opcidon solo es Util si estd trabajando con

color a alfa) imagenes que se supone que se deben premultiplicar con
negro, pero donde los valores de color de los pixeles se han
incrementado sin que sus valores de alfa se hayan ajustado
en consecuencia.
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CONSEJO

El tipo de transparencia para una imagen puede depender del software que se
utilice para crearla. Por ejemplo, las imagenes exportadas por Harmony en
cualquier formato que no sea PNG suelen ser Premultiplied with Black
(Premultiplicado con negro), mientras que las imagenes PNG exportadas por
Harmony utilizan el tipo de transparencia Straight (Directo).

Los siguientes son modos de transparencia que suele utilizar otro software para
tipos de archivos especificos:

« Griéficos de red portatiles (.png): Straight (Directo)
o Documento de Photoshop (.psd, .psb):

« Importado como una solaimagen: Premultiplied with White
(Premultiplicado con blanco)

« Importado como capas separadas: Straight (Directo)

o Formato de archivo de imagen etiquetada (.tif): Premultiplied with Black
(Premultiplicado con negro)

o Truevision TARGA (.tga): Straight (Directo)
« Imagen de Silicon Graphics (.sgi): Straight (Directo)

8. Hagaclicen OK (Aceptar).

NOTA

De forma predeterminada, las imagenes de mapa de bits se mostraran en baja resolucién en la
vista de camara para evitar que afecten al rendimiento de la reproduccion. También puede
ajustar la calidad de visualizacién de una imagen de mapa de bits seleccionandola con la
herramienta Transform (Transformar) y, a continuacion, abriendo el cuadro de dialogo Bitmap
Image Quality (Calidad de laimagen de mapa de bits) a través de View > Bitmap File Quality
(Vista > Calidad del archivo de mapa de bits). También puede previsualizar la imagen de mapa
de bits en la resolucién de la escena activando el modo Render Preview (Vista de render)
en la vista de camara.

Vectorizacion de imagenes

Harmony permite importar imagenes como dibujos de vectores. Los dibujos de vectores se pueden pintar y
editar facilmente con las herramientas de dibujo de vectores de Harmony. Esto puede ser Util para la
importacion de capa de lineas escaneadas o creadas con un software diferente, ya que luego puede pintarla en
Harmony.
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Importacién de una imagen de mapa de bits como un dibujo de mapa de bits de Toon
Boom

1. Realice una de las siguientes acciones:

o En el mend superior, seleccione File > Import > Images (Archivo > Importar >
Imagenes).

« En la barra de herramientas de archivo, haga clic en el botén ‘[ Import Images
(Importar imagenes).

« En la vista de carta de rodaje, haga clic con el botdn derecho en cualquier parte del
area de fotogramas y seleccione Import > Images (Importar > Imagenes).

Se abre el cuadro de dialogo Import Images (Importar imdgenes).

1. En la seccién Files (Archivos) del cuadro de didlogo Import Images (Importar imagenes), haga clic en
Browse (Examinar) para seleccionar una o mas imagenes del ordenador.

2. Seleccione el destino de las imagenes:

o Create Single Layer Named (Crear una sola capa con nombre): Crea una nueva capa
con el nombre especificado e importa las imagenes en ella.

o Create Layer(s) Based on Filenames (Crear capas basadas en nombres de archivo):
Crea una capa basada en cada prefijo de nombre de archivo Unico. Por ejemplo, si
importa tres archivos llamados a-1.tga, a-2.tga y b-1.tga, se crearan dos capas, una
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denominada "a"y otra denominada "b". La capa "a" contendra las dos primeras
imagenes, mientras que la "b" contendra la tercera.

« Add to a Existing Layer (Agregar a una capa existente): Importa lasimagenes en la
capa especificada. Tenga en cuenta que solo puede importar en las capas que son
compatibles con las opciones de importacion. Por ejemplo, si va a importar imagenes
como dibujos vectoriales, solo puede importarlas en capas de dibujos vectoriales.

2. En la seccion Alignment (Alineacion), decida el tamafio y la posicidn de la imagen dentro del
encuadre de la cdmara. Puede elegir entre las siguientes opciones:

Parametro Descripcién

Ajusta el tamafio de laimagen para que su altura coincida con la altura de la
escena, sin que afecte a su proporcion.

Vertical Fit
(Ajuste || Fotogra
. madela
vertical)
Imagen con regla Fotograma de |
de alineacion de
Horizontal . . . L
L Ajusta el tamano de la imagen para que su ancho coincida con el de la escena
Fit (Ajuste

. sin que afecte a su proporcién.
horizontal)
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|| Fotogra
madela

| Fotograma de I

Imagen con regla de
alineacion de ajuste

Importa laimagen a tamafio real sin ajustar su tamafio en proporcion a la

Actual Size ., . . . . .
T . resolucién de la escena. Por ejemplo, si las dimensiones de la imagen en
amafo . . . .
) pixeles son la mitad de la resolucidon de la escena en pixeles, las dimensiones
rea

de la imagen pareceran ser la mitad de las dimensiones del campo de la escena.

3. Silaimagen tiene transparencia, en la seccién Transparency (Transparencia), seleccione como se
premultiplicaron los valores de color en los pixeles semitransparentes de la imagen con sus valores
de alfa. Esto permite que Harmony demultiplique los valores para poder combinar correctamente la
imagen con los otros elementos de la escena.

Puede elegir entre las siguientes opciones:

Parametro Descripcién

Los valores de color de los pixeles semitransparentes de la
imagen se han codificado de modo que cuanto mas
transparentes sean, mas cercanos al blanco estaran. Cuando

L . . se carga unaimagen premultiplicada con blanco en un
Premultiplied with White

Lo software que no admite transparencia, aparece combinada
(Premultiplicado con blanco)

con un fondo blanco. Seleccione esta opcidn para hacer que
Harmony revierta esta premultiplicacién de modo que la
imagen se combine correctamente con otros elementos
visuales de la escena.

Los valores de color de los pixeles semitransparentes de la
Premultiplied with Black imagen se han codificado de modo que cuanto mas
(Premultiplicado con negro) transparentes sean, mds cercanos al negro estaran. Cuando
se carga unaimagen premultiplicada con negro en un
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software que no admite transparencia, aparece combinada
con un fondo negro. Seleccione esta opcidn para hacer que
Harmony revierta esta premultiplicacién de modo que la
imagen se combine correctamente con otros elementos
visuales de la escena.

Straight (Recto)

El color de los pixeles semitransparentes en la imagen se
codifica independientemente de su transparencia. Cuando se
carga una imagen que no esta premultiplicada en un software
que no admite transparencia, los pixeles semitransparentes
simplemente aparecen completamente opacos, lo cual hace
que sus bordes parezcan pixelados.

4. Hagaclicen OK (Aceptar).

Importacién y vectorizacion de una imagen de mapa de bits

1. Realice una de las siguientes acciones:

« En el mend superior, seleccione File > Import > Images (Archivo > Importar >

Imagenes).

o En la barra de herramientas de archivo, haga clic en el botén ‘i Import Images

(Importar imagenes).

« En la vista de carta de rodaje, haga clic con el botdn derecho en cualquier parte del

area de fotogramas y seleccione Import > Images (Importar > Imagenes).

Se abre el cuadro de didlogo Import Images (Importar imagenes).
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1. En la seccidn Files (Archivos) del cuadro de didlogo Import Images (Importar imagenes), haga clicen
Browse (Examinar) para seleccionar una o mas imagenes del ordenador.

2. Seleccione el destino de las imagenes:

o Create Single Layer Named (Crear una sola capa con nombre): Crea una nueva capa
con el nombre especificado e importa las imagenes en ella.

o Create Layer(s) Based on Filenames (Crear capas basadas en nombres de archivo):
Crea una capa basada en cada prefijo de nombre de archivo Unico. Por ejemplo, si
importa tres archivos llamados a-1.tga, a-2.tgay b-1.tga, se crearan dos capas, una
denominada "a" y otra denominada "b". La capa "a" contendrd las dos primeras
imagenes, mientras que la "b" contendra la tercera.

« Add to a Existing Layer (Agregar a una capa existente): Importa lasimagenes en la
capa especificada. Tenga en cuenta que solo puede importar en las capas que son
compatibles con las opciones de importacion. Por ejemplo, si va a importar imagenes
como dibujos vectoriales, solo puede importarlas en capas de dibujos vectoriales.

3. En la seccidn Import Options (Opciones de importacién), seleccione la opcion Convert to Toon
Boom Vector Drawing (Convertir a dibujo de vector de Toon Boom).

4. En la seccidn Vectorization (Vectorizacion), decida si desea importar la imagen en blanco y negro, o
en grises. También puede hacer clic en el botdn New Preset (Nuevo valor predef.) para crear un
parametro de vectorizacion personalizado.
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o Black and White (Blanco y negro): vectoriza los dibujos como una linea negra sélida; crea un
dibujo 100 % basado en vectores. Los contornos de los dibujos se pintaran con la muestra de
color de la linea vectorizada de la paleta de colores de la escena.

o Grey (Gris): vectoriza la imagen como una mezcla de contorno de vectores y relleno de mapa
de bits en escala de grises. Las lineas conservan la textura de la digitalizacion, y el blanco del
papel pasa a ser transparente.

| Valor predefinido de I

NOTA

Puede hacer doble clic en los valores predefinidos en cualquier momento para abrir el cuadro
de didlogo Vectorization Parameters (Parametros de vectorizacion) para personalizar su opcion.

5. Haga clic en OK (Aceptar).

Las imdgenes vectorizadas aparecerdn en los destinos seleccionados.

NOTA

Si tiene imagenes de mapa de bits en la libreria, puede arrastrarlas y colocarlas directamente en la
escena como una manera rapida de importar una imagen de mapa de bits. Sin embargo, no tendra
acceso a todas las opciones de importacién.
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Capitulo 9: Colocacidon y animacion de capas

La configuracion de una escena se puede comparar con la construccidon de la escenografia para un programa de
televisidn. Este es el punto en el que coloca el elemento de escena, como el encuadre de camara, los elementos
de fondo y los personajes.

Colocacion de capas

El primer paso para configurar la escena es colocar cada capa en su posicidn, angulo y tamafio iniciales. Puede
realizar cualquier tipo de transformacién geométrica en una capa con la herramienta !.! Transform
(Transformar).

Paneo, rotacion, escala o sesgo de una capa con la herramienta Transform
(Transformar)

1. En labarra de herramientas de herramientas, seleccione la herramienta i.} Transform
(Transformar) o pulse Mayus + T.

2. Enlabarra de herramientas de herramientas, si esta habilitado el modo Animate Current Frame
(Animar fotograma actual) o gﬁ Animate Onion Skin Range (Animar intervalo de papel cebolla),
haga clic en él para abrir el mend emergente Animate (Animar) y seleccione % Animate Off
(Animar desactivado).

3. En lavista de propiedades de la herramienta, asegurese de que la opcién A Peg Selection Mode
(Modo de seleccion de peg) esta deshabilitada.

4. En lavista de cdmara o de linea de tiempo, haga clic en la capa que desea manipular para
seleccionarla.

CONSEJOS

« Sidesea seleccionar varias capas en la vista de camara, mantenga pulsado Mayus y
haga clic en cada capa que desee seleccionar.

« Sidesea seleccionar varias capas en la vista de linea de tiempo, mantenga pulsado
Ctrl (Windows/Linux) o & (macOS) y haga clic en cada capa que desee seleccionar.

« Sidesea seleccionar una serie contigua de capas en la vista de linea de tiempo,
mantenga pulsado Mayus, haga clic en la primera capa que desea seleccionar y
luego en la ultima.
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Aparece un cuadro de control del manipulador alrededor de la capa seleccionada.

[ Sesgar ]

D—[ Escalar horizontal y

Sesgar

[ Escalar

Rotar

Escalar horizontal y

Escalar

..
D—[ Escalar horizontal y

)

[ Escalar [ Sesgar

1. Realice una de las siguientes acciones:

« Mover: mueva el cursor por la ilustracién. Cuando el cursor se convierta en +}, haga clicy

arrdstrelo sobre la ilustracién para moverla.

« Rotar: coloque el puntero fuera de una esquina del cuadro de limite. Cuando el cursor se

conviertaen ), haga clicy arrastrelo para rotar.

B

ﬁ o

« Escalar: mueva el cursor sobre cualquiera de los puntos de control amarillos del cuadro del
manipulador. Cuando el cursor se convierta en ", haga clicy arrastre para escalar la capa.
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@ NOTA

Al realizar el escalado de la seleccién, puede mantener pulsado MayUs para
mantener las proporciones entre el ancho y la altura.

« Mueva el cursor sobre uno de los bordes verticales del cuadro del manipulador. Cuando el
cursor se convierta en 1[ , haga clicy arrastre hacia arriba o hacia abajo para sesgar la capa
en vertical.

« Mueva el cursor sobre uno de los bordes horizontales del cuadro del manipulador. Cuando el
cursor se convierta en ¥, haga clicy arrastre hacia la izquierda o hacia la derecha para
sesgar la capa en horizontal.

Cambio de posicion del pivote

Las transformaciones realizadas sobre una capa de dibujo, tales como rotacion, escala, sesgo y volteo, se
realizan de forma relativa a la posicion del punto de pivote del dibujo. Por ejemplo, al rotar una capa, esta
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rotard alrededor de su punto de pivote, y al escalar la capa, se escalard como si su centro fuera realmente su
punto de pivote.

Mientras realiza transformaciones con la herramienta Transform (Transformar), puede arrastrar y colocar el
pivote de la seleccidn. Sin embargo, esto no tiene un efecto permanente. Solo cambiara temporalmente la
posicion del pivote para que le ayude a realizar transformaciones en el fotograma seleccionado, pero el punto
de pivote real de la capa de dibujo permanecera igual.

Puede cambiar de forma permanente la posicién del punto de pivote de una capa utilizando una de las
herramientas de la barra de herramientas de animacién avanzada.

NOTA

Al mover de forma permanente el punto de pivote de una capa que ya esta animada, todas las
transformaciones realizadas en la capa en otros fotogramas clave se volveran a calcular de acuerdo
con la posicién del nuevo punto de pivote. Por lo tanto, la animacién existente tendra una
apariencia completamente diferente, excepto en el fotograma actual. Es recomendable que
siempre se asegure de que el punto de pivote se encuentre en la posicion idénea antes de

comenzar la animacion.

Cambio de posicion permanente del punto de pivote de una capa

1. En la barra de herramientas de animacién avanzada, seleccione la herramienta <}> Translate
(Traslacién), (¥ Rotate (Rotar), & Scale (Escalar) o /7 Skew (Sesgar).

2. Realice una de las siguientes acciones:

o En lavista de linea de tiempo, seleccione la capa a la que desee mover el pivote.

o En lavista de cdmara, utilice Ctrl + clic (Windows/Linux) o ¢& + clic (macQOS) en la capa para
la que desea mover el pivote.

El punto de pivote @ aparece en la vista de camara.

3. Mueva el cursor sobre el punto de pivote. Cuando el cursor del ratén se convierta en 4—}; haga clicy
arrastrelo al punto de pivote para cambiar de posicion.
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El punto de pivote de la capa ha cambiado de posicién. Si la capa se ha animado, su posicién se
desplazard por las escenas de forma relativa a la cantidad que acaba de desplazar el punto de
pivote.

Animacion de una capa

Puede animar una capa colocandola en diferentes posiciones, angulos y tamafos en distintos puntos a lo largo
de la linea de tiempo de la escena. Para ello, puede crear fotogramas clave de animacion en la capa. Un
fotograma clave registra las transformaciones geométricas en una capa en un punto especifico en el tiempo.
Cuando dos fotogramas clave de animacién se encuentren en una capa en diferentes puntos de la linea de
tiempo de la escena, Harmony interpolard automaticamente la posicidn, el angulo y el tamafio de la capa en
cada fotograma entre esos dos fotogramas clave, creando una animacion.

Colocar enel
segundo

Colocar enel
primer

| Colocar para cada fotograma I

Animacioén de una capa

1. En labarra de herramientas de herramientas, seleccione la herramienta i.} Transform
(Transformar) o pulse Mayus + T.

2. Enlabarra de herramientas de herramientas, si estd seleccionado el modo $ Animate Off (Animar
desactivado) o g\% Animate Onion Skin Range (Animar intervalo de papel cebolla), haga clicen él
para abrir el menu emergente Animate (Animar) y seleccione Animate Current Frame (Animar
fotograma actual).
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3. Sila capatiene un peg padre:

o Sidesea animar en el peg en lugar de en la capa, asegurese de que el modo & Peg Selection
(Seleccidn de peg) esté habilitado en la vista de propiedades de la herramienta.

o Sidesea animar directamente en la capa, asegurese de que el modo /& Peg Selection
(Seleccidn de peg) esté deshabilitado en la vista de propiedades de la herramienta.

4. En lavista de linea de tiempo, vaya al primer fotograma.

5. En el menu superior, seleccione Animation (Animacion) y asegurese de que la opcidon Stop-Motion
Keyframe (Fotograma clave de Stop-motion) no estd marcada. De este modo, Harmony crearad la
animacion automaticamente entre los fotogramas clave de la animacion que cree.

6. Seleccione la celda donde desee crear el primer fotograma clave.

7. Para crear el primer fotograma clave, realice una de las siguientes acciones:

« En la barra de herramientas de linea de tiempo, haga clic en el botén ¢r Add Keyframe
(Agregar fotograma clave).

« Haga clic con el botdn derecho y seleccione Add Keyframe (Agregar fotograma clave).

e Pulse F6.

Se crea un fotograma clave en el primer fotograma de la vista de linea de tiempo.

8. En lavista de camara, seleccione el elemento que desea animar y muévalo, rételo, escalelo o
sésguelo de modo que esté en su posicidn de inicio correcta.
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10.

11.

12.

13.

En la vista de linea de tiempo, vaya al fotograma en el que desea establecer la segunda posicion.

rno=am

o

Seleccione la celda donde desee crear el segundo fotograma clave. clic con el botén derecho en la
seleccién y seleccione Insert Keyframe (Insertar fotograma clave).

El segundo fotograma clave aparece en la lista de linea de tiempo, junto con una linea desde el
primer fotograma clave al segundo fotograma clave. Esto indica que cada fotograma intercalado se
animara mediante Harmony.

IIIIIIIIIF__|—

En la vista de cdmara, mueva, rote, escale o sesgue el elemento de modo que esté en su segunda
posicidn correcta.

En la vista de linea de tiempo, seleccione el primer fotograma para retroceder al comienzo de la
animacion.

En la barra de herramientas de reproduccién, haga clic en el botén » Play (Reproducir) para
obtener una vista previa de la animacién.
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NOTA

Si anima capas en el eje Z, puede que desee obtener una vista previa de las animaciones desde
las vistas superior, lateral o de perspectiva durante la reproduccién. Sin embargo, la
reproduccion esta deshabilitada de forma predeterminada en esas vistas. Para habilitarlas, en
el menu superior seleccione Play > Enable Playback > Top View (Reproducir > Activar
reproduccion > Vista superior), Side View (Vista lateral) o Perspective View (Vista de
perspectiva).
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Capitulo 10: Colocacion y animacion de la camara

En Harmony, puede animar objetos dibujdndolos en su capa individual y colocandolos a continuaciéon en
distintas ubicaciones en diferentes fotogramas clave a través de la linea de tiempo para crear una ruta de
movimiento. Se puede aplicar el mismo principio a la cdmara de la escena, ya que se trata de una capa.
Adicidn de una camara

De forma predeterminada, una escena no tiene capa de cdmara. Para poder ajustar el angulo de la cdmaravy la

posicién de la escena, debe agregar una a su escena.

Adicidon de una camara

1. Realice una de las siguientes acciones:

« Enlavista de linea de tiempo, haga clicen el botén +, Add Layer (Agregar capa) del
menu emergente y seleccione Camera (Camara).

o En el mend superior, seleccione Insert > Camera (Insertar > Camara).

Se agrega a la escena una nueva capa de camara y aparece en la vista de linea de tiempo.

ro=al
o

o

Aunque es posible tener varias cdmaras en la misma escena, solo puede ver su escena utilizando las cdmaras de
una en una. Esto puede resultar (til si ain esta trabajando en la composicidn de escena y tiene distintas
configuraciones de camara para probar.

Cambio entre cdmaras

1. En el mend superior, seleccione Scene > Camera (Escena > Camara).

2. Entre las camaras de la lista, seleccione la cdmara con la que desea trabajar.

Adicion de un peg padre

Aunque es posible colocar una cadmara sin necesidad de usar un rigging debajo de un peg, se recomienda
hacerlo siempre por dos motivos:

« Permite colocar, rotar y alejar o acercar la camara con la herramienta Transform (Transformary).

¢ Permite animar los movimientos de la camara. Sin un peg padre, la posicidn, el angulo y el zoom de la
camara son estaticos.
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Adicion de un peg padre a una camara

1. En lavista de linea de tiempo, seleccione la capa de camara.

2. En labarra de herramientas de capas, haga clic en el botén (% Add Peg (Agregar peg).

Aparece una capa de peg directamente sobre la capa de camara y se conecta a ella
automaticamente.

Colocacidén de la camara

La accion de la escena tiene lugar dentro del encuadre de camara, de modo que es muy importante configurarlo
correctamente. Puede ajustar la resolucion de la cdmara y otros parametros relacionados en la ventana Scene
Settings (Configuracion de escena), a la que se puede acceder desde el menu principal de Scene (Escena).

A

'
.
SR

Para cambiar la posicién de la cdmara directamente, puede moverla con la herramienta i.} Transform
(Transformar) o H} Translate (Traslacidn), puede rotarla con la herramienta (< Rotate (Rotar) y puede alejarla
o acercarla con la herramienta [ Scale (Escalar) de la barra de herramientas de animacién avanzada. También
puede escribir sus coordenadas directamente en la vista de propiedades de capa. Si ha usado un rig de cdmara
debajo de un peg, puede aplicarle todo tipo de manipulaciones solo con la herramienta Transform
(Transformar). Los siguientes pasos indican cémo manipular la camara al usar un rig debajo de un peg.

111



Capitulo 10: Colocacién y animacién de la camara

Colocacion de una camara en la que se ha usado un rig debajo de un peg en la vista
de camara

1. Realice una de las siguientes acciones para seleccionar el peg padre de la camara.

o En lavista de linea de tiempo, haga clic en la capa del peg padre de la cdmara.

o En lavista de cdmara, haga clic en el encuadre de la cdmara. El encuadre de la cdmara es un
rectangulo fino alrededor de la etapa de la escena.

Aparece un cuadro de control alrededor del encuadre de la cdmara.

Rotar Rot:
| Acercaro } = i = Acercaro |

Move

= Moverl

Mover

| Acercaro } = = = Acercaro |
o O

2. Realice una de las siguientes acciones:

« Mover el encuadre de la cdmara: coloque el cursor sobre cualquiera de sus bordes o sobre el
centro. Cuando el cursor cambie a +}+, haga clicy arrastrelo en el encuadre de la cdmara para
cambiarlo de posicién.

« Acercar o alejar: coloque el cursor en una de las esquinas del encuadre de la cdmara. Cuando
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el cursor cambie a =, haga clicy arrastrelo a la esquina para cambiar el tamafio del
encuadre de la cdmara. Al contraer el encuadre de la cdmara se acercard la escena, y al
expandirlo, se alejara.

« Rotar la cdmara: coloque el cursor fuera de una de sus esquinas. Cuando el cursor cambie a
o, haga clicy arrastrelo para rotar el encuadre de la camara.

Animacion de la camara

La cdmara de una escena se puede manipular y animar como cualquier otra capa. Se muestra en la vista de linea
de tiempo y puede utilizar las mismas herramientas y modos de seleccion para compensarla o animarla. Sin
embargo, la capa de la cdmara en si es estatica, lo que significa que mantiene la misma posicién y angulo en
toda la escena. Para poder animar la cdmara, es necesario conectarla a una capa de peg, que se puede animar, y
que afectara directamente a la posicion y al angulo de la camara.

Puede animar los movimientos de la cdmara directamente en la vista de cdmara.
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Animacion de la camara

1. En la barra de herramientas de herramientas, si esta seleccionado el modo $ Animate Off (Animar
desactivado) o gﬁ Animate Onion Skin Range (Animar intervalo de papel cebolla), haga clicen él
para abrir el menl emergente Animate (Animar) y seleccione Animate Current Frame (Animar
fotograma actual).

2. En la barra de herramientas de herramientas, seleccione la herramienta i.! Transform
(Transformar) o pulse Mayus + T.

3. Enelladoderecho de la vista de linea de tiempo, en la capa de peg de cdmara, seleccione el
fotograma en el que desee que comience el movimiento de camara.

4. Realice una de las siguientes acciones para agregar un fotograma clave:

« En la barra de herramientas de linea de tiempo, haga clic en el botén ¢ Add Keyframe
(Agregar fotograma clave).

« Haga clic con el botdén derecho y seleccione Add Keyframe (Agregar fotograma clave).

e Pulse FG.

Aparece un fotograma clave en dicha celda. Los fotogramas que preceden a este fotograma clave
mantendran la misma posicion de cdmara que este fotograma clave.

5. En la vista de cdmara, manipule la cdmara para que esté en la posicién correcta cuando la cdmara
comience a moverse.
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6. En lavista de linea de tiempo, haga clic en la celda en la que terminara el movimiento de camara.

7. Realice una de las siguientes acciones:

« En la barra de herramientas de linea de tiempo, haga clic en el botdn ¢r Add Keyframe
(Agregar fotograma clave).

« Haga clic con el botdén derecho y seleccione Add Keyframe (Agregar fotograma clave).

e Pulse F6.

Aparece un fotograma clave en dicha celda.

8. En la vista de camara, manipule la camara para que esté en la posicidn correcta cuando la cdmara
termine de moverse.

9. En lavista de linea de tiempo, seleccione el primer fotograma para retroceder al comienzo de la
animacion.
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10. En la barra de herramientas de reproduccion, haga clicen el botén » Play (Reproducir) para
obtener una vista previa de la animacidn.

116



Guia de introduccién de Harmony 21 Advanced

117



Capitulo 11: Creacién de un rig de un personaje cut-out

Capitulo 11: Creacion de un rig de un personaje cut-out

En Harmony, un rig de personaje es basicamente una plantilla basada en el modelo del personaje, peroen la
cual todas las partes mdviles estan divididas en distintas capas y ordenadas en una jerarquia que facilita la
animacion digital, también conocida como animacidn cut-out.

Para realizar un rig de personaje, en primer lugar debemos asegurarnos de tener un modelo de personaje del
que partir. Si tiene un dibujo de un personaje disponible, impdrtelo en una nueva escena y, a continuacion,
ajuste la escala y coldquelo a su gusto. De lo contrario, puede dibujar el modelo del personaje directamente en
Harmony. Una vez que tenga listo un modelo, podemos comenzar a descomponerlo en partes para crear el rig
con él.

Se pueden emplear muchas técnicas para descomponer una marioneta. En esta seccién, aprendera uno de los
métodos mas comunes y sencillos. Para la primera descomposicidon de personaje, siga estas instrucciones para
hacerse una idea de cémo funciona Harmony. Una vez que conozca las funciones y comandos basicos de
Harmony, podra crear sus propias técnicas para cumplir las necesidades de su produccién.

- ““’%AQ 00.\\
ﬁUm\ (

Dibujo de las piezas

La técnica de descomposicion principal que se muestra es el trazado del modelo.

Descomposicion de un personaje mediante trazado

1. En lavista de linea de tiempo, agregue una nueva capa de dibujo para cada parte del cuerpo que
desee separar. Puede pulsar Ctrl + R (Windows/Linux) o 38 + R (macOS) para agregar nuevas capas
de dibujo.
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2. En lavista de linea de tiempo, seleccione la primera celda de la capa en la que desea dibujar la
parte.

3. En la barra de herramientas de herramientas, seleccione la herramienta de dibujo que desee.
Existen dos métodos que se suelen utilizar para dibujar las partes de un modelo de personaje cut-
out:

o Utilizar la herramienta # Pencil (Lépiz) y suavizar las lineas con la herramienta R
Smooth Editor (Editor suave).

o Utilizar la herramienta G Polyline (Polilinea). Este método permite dibujar con gran
precision, pero puede llevar mas tiempo.

Estos métodos garantizan que cada parte se realice con el menor numero de puntos posible, para
gue sean faciles de manipular, modificar o volver a dibujar.

4. En lavista de color, seleccione una muestra de color. Si todavia no ha creado ninguna paleta para el
personaje, consulte Como pintar en la pagina 64.

5. Siprefiere trabajar en la vista de dibujo, realice una de las siguientes acciones para mostrar las
demads capas con colores descoloridos:

« En la barrade herramientas de la vista de dibujo, haga clicen el botén U Light Table
(Mesa de luz).

o Pulse Mayus + L.

6. En lavista de camara o de dibujo, dibuje la nueva parte.
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7.

10.

Si desea cerrar una forma abierta sin dibujar un contorno visible, puede dibujar una linea visible con
la herramienta (-~ Stroke (Linea vectorial transparente).

NOTA

De forma predeterminada, las lineas vectoriales transparentes creadas con la
herramienta Stroke (Linea vectorial transparente) no son visibles. Para ver las lineas
vectoriales transparentes en el dibujo, seleccione View > Show > Show Strokes (Ver >
Mostrar > Mostrar lineas vectoriales transparentes) en el menu superior o pulse K.

En la barra de herramientas de herramientas, seleccione la herramienta ® Paint (Pintar) o pulse
® Paint Unpainted (Pintar drea no pintada) para colorear el dibujo.

En la vista de color, cree el color de relleno deseado si no se encuentra todavia en la paletay, a
continuacion, seleccionelo.

En la vista de cdmara o de dibujo, pinte el dibujo.
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11. En labarra de herramientas de herramientas, seleccione la herramienta ® Select (Seleccionar).
Seleccione el dibujo y acople las lineas haciendo clic en el botédn 5= Flatten (Acoplar) de la vista de

propiedades de la herramienta.

12. Silas lineas estdn compuestas por varios trazos de lapiz, puede que desee combinarlas en una unica
linea de lapiz fluida. Mediante la herramienta Select (Seleccionar), seleccione las lineas de lapiz que
se deben combinar vy, en la vista de propiedades de la herramienta, haga clic en el botén % Merge

Pencil Lines (Combinar lineas de lapiz).

0>

13. Repitatodo el proceso para cada parte del cuerpo que desee que se pueda animar.
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Adicion de pegs

Los pegs son un tipo especial de capa que no contiene ningun dibujo. Solo se utilizan para compensar y
transformar dibujos que estén debajo de su jerarquia, sin transformar directamente los dibujos.

Al crear un rigging o configurar una escena, se recomienda emparentar pegs a cada una de las capas de dibujo.
De este modo, se permite mantener los fotogramas clave y los dibujos de animacion en capas separadas, lo que
facilita el trabajo sobre la posicién y exposicion de las capas de dibujo por separado en la vista de linea de
tiempo. También facilita la creacién de una jerarquia de las partes del cuerpo que se pueden animar juntasy por
separado.

Contiene las animaciones de
posicion, rotacion y escala del

Contiene los dibujos reales, los fotogramas en los que se
exponen y durante cuantos fotogramas se exponen.
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Si desea animar solo sobre pegs, puede activar el modo Peg Selection (Seleccién de peg) de la herramienta
Transform (Transformar) en la vista de propiedades de la herramienta. También puede deshabilitar las capas
de dibujo de animacién para que solo se puedan animar los pegs.

NOTA

También es posible hacer que una capa de dibujo sea padre de otra capa de dibujo. Al igual que la
forma de animacion de un peg anima sus capas hijas, la animacién de una capa de dibujo con hijos
también animara sus capas hijas. Ambas capas seguiran apareciendo en la animacion.

Cémo emparentar pegs a las capas en la vista de linea de tiempo

1. En lavista de linea de tiempo, seleccione todas las capas.
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2. En la barra de herramientas de capa de linea de tiempo, haga clic en el botén (% Add Peg (Agregar
peg) para agregar un peg padre a todas las capas seleccionadas.

+H )

Creacion de una jerarquia de capas

Harmony permite crear el rig en una jerarquia elaborada, lo que permite a su vez establecer qué partes del rig
deben influir en otros miembros y cdmo pueden moverse de forma independiente. Por ejemplo, al crear un
rigging del brazo de un personaje simple, puede hacer que la capa del antebrazo sea hija de la capa del brazo,
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y que la capa de la mano sea hija de la capa del antebrazo. De esta manera, si el personaje mueve el antebrazo,
la mano también lo hard, y si mueve el brazo, el antebrazo y la mano también lo haran.

Jerarquia de brazo }—b

Jerarquia de pierna

Al crear un rig de personaje basico, debe tener al menos una jerarquia para cada brazo y cada pierna. Puede
crear una jerarquia que vaya desde el torso, el cuello y la cabeza, y crear un rig de los brazos al torso y otro de
las piernas a las caderas. Esto crearia una jerarquia como esta:

Creacion de una jerarquia en la vista de linea de tiempo

1. En el dreaizquierda de la vista de linea de tiempo, seleccione la capa que desee que sea la capa hija.

2. Arrastre el hijoy coléquelo sobre la capa que desee que sea la capa padre. Asegurese de no colocar
la capa hija entre dos capas.

3. Repita el proceso hasta que haya creado una jerarquia que manipule todas las partes del personaje,
con un peg maestro en la raiz. Al crear un rig, si desea que varias capas tengan un padre comun,
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pero ninguna de las partes existentes del rigging puede servir como dicho padre, cree un nuevo peg
y anide esas capas debajo de dicho peg.

+
+
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NOTA

En la vista de linea de tiempo, puede desconectar una capa de su capa padre manteniendo
presionada la tecla Mayus, arrastrando la capa padre lejos de la capa hija y colocandola en
cualquier lugar de la lista.

Al crear un rigging, tenga en cuenta que el orden de las capas en la vista de linea de tiempo afecta al orden en
que se representan. Las capas de la parte superior de la lista se representaran sobre las capas de la parte
inferior de la lista. Si tiene que cambiar el orden de una capa durante la animacion, puede realizar un
desplazamiento pequerio de la posicién de esta capa sobre el eje Z para anular el orden de la capa y forzarla a
aparecer debajo o sobre otras capas.

Desplazamiento pequeiio de una capa sobre el eje Z

1. En la barra de herramientas de herramientas, seleccione la herramienta . Transform
(Transformar).

2. En lavista de linea de tiempo, de nodos o de camara, seleccione la capa que desea desplazar.

3. Sihaseleccionado la capa en la vista de linea de tiempo o de nodos, haga clic en la pestafia de la
vista de cdmara para establecer el enfoque en esta vista.

4. Realice una de las siguientes acciones:

« Para realizar un desplazamiento pequefio de la capa hacia delante, pulse Alt + flecha
abajo.

o Para realizar un desplazamiento pequerio de la capa hacia atras, pulse Alt + flecha
arriba.
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Peg maestro

Elrig del personaje siempre debe tener un peg maestro que se conecta a todas sus partes. EL peg maestro
permite manipular todo el rig desde una Unica capa, sin necesidad de manipular cada parte individual. Esto es
util para colocar y escalar el personaje en relacidn a la escena, asi como para animar la trayectoria del personaje
cuando tiene que moverse entre las areas de la escena.

Adicion de un peg maestro en la vista de linea de tiempo

1. En lavista de linea de tiempo, seleccione la capa superior.
2. En lavista de linea de tiempo, haga clic en el botdn (% Add Peg (Agregar peg).

Se agrega a la linea de tiempo un nuevo peg al que queda emparentada la capa seleccionada.
3. Asigne el nombre Master mas el nombre del personaje al nuevo peg.

4. En lavista de linea de tiempo, seleccione todas las capas que desee conectar al nuevo peg.
Recuerde que la capa superior ya es un hijo del peg, asi que no lo incluya en la seleccidn.

5. Arrastre la seleccion SOBRE la capa del peg para emparentar todas las piezas del personaje al peg.
Si se agregan capas encima de las capas que ya tienen padres, mueva dicha capa con padres de
nuevo a la parte superior de la pila de capas.
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Capitulo 12: Animacion de un personaje cut-out

Harmony ofrece herramientas muy Utiles para animar modelos de personajes cut-out. Con la herramienta
Transform (Transformar), puede mover las partes del personaje para crear poses clave, mientras que Harmony
crea los intercalados. El tiempo del movimiento se puede ajustar para crear movimientos realistas y los dibujos
de las partes del personaje se pueden intercambiar en cualquier punto de la animacion con objeto de permitir
combinar los cambios del movimiento y del dibujo para crear animaciones cut-out perfectamente ajustadas.

Creacién de una animacién cut-out simple

Crearemos una animacion cut-out simple realizando la primera pose del personaje en el primer fotograma,
la segunda pose en el siguiente fotograma y permitiendo que Harmony las interpole.

1. En lavista de linea de tiempo, contraiga el personaje con la flecha Expand/Collapse

(Expandir/Contraer).

3. Para garantizar que el modelo no desaparezca después de 1 fotograma, abra el cuadro de didlogo
Extend Exposure (Extender exposicion) realizando una de las siguientes acciones:

« Haga clic con el botén derecho en el primer fotograma de la vista de linea de tiempo'y
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seleccione Extend Exposure (Extender exposicion).
o Pulse F5.

4. En el cuadro de didlogo Extend Exposure (Extender exposicion), escriba el nimero de fotogramas
de la escena y confirme. De este modo, el modelo quedara expuesto (sera visible) en toda la escena.

5. Ahora crearemos la primera pose del personaje. En primer lugar, asegurese de que haya un
fotograma clave en el primer fotograma de cada capa del modelo. Con ello garantiza que cuando
cree la segunda pose mas tarde, la primera pose no se verd afectada. Para llevarlo a cabo, realice
una de las siguientes acciones:

« Enla barra de herramientas de linea de tiempo, haga clic en el botén ¢r Add Keyframe
(Agregar fotograma clave).

« Haga clic con el botdén derecho y seleccione Add Keyframe (Agregar fotograma clave).

e Pulse F6.

Se agrega un fotograma clave al fotograma actual.

6. En la barra de herramientas de herramientas, seleccione la herramienta .1 Transform
(Transformar) o pulse Mayus + T.

7. En labarrade herramientas de herramientas, si esta seleccionado el modo $ Animate Off (Animar
desactivado) o gﬁ Animate Onion Skin Range (Animar intervalo de papel cebolla), haga clicen él
para abrir el menu emergente Animate (Animar) y seleccione Animate Current Frame (Animar
fotograma actual).

8. En lavista de cdmara, seleccione las partes que desea animar. El cuadro de control de la
herramienta Transform (Transformar) aparecerd alrededor de la capa seleccionada. Cada parte del
cuadro de control de la herramienta Transform (Transformar) se puede usar para realizar distintos
tipos de transformaciones:
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9. Utilice la herramienta

10.
11.

12.

13.

seleccidn a su nueva posicion.

.| Transform (Transformar) para rotar, sesgar, escalar o trasladar la

Repitalo en otras partes del modelo del personaje hasta que la primera pose haya terminado.

En la barra de herramientas de herramientas, active la funcion é Onion Skin (Papel cebolla).

En la vista de linea de tiempo, seleccione el fotograma donde desee tener la segunda pose.

Cree un fotograma clave para la segunda pose realizando una de las siguientes acciones:

« En la barra de herramientas de linea de tiempo, haga clic en el botén ¢ Add Keyframe

(Agregar fotograma clave).

« Haga clic con el botdn derecho y seleccione Add Keyframe (Agregar fotograma clave).

Pulse FG.
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El segundo fotograma clave aparece, junto con una linea desde el primer fotograma clave al
segundo fotograma clave. Esto indica que cada fotograma intercalado se interpolard mediante
Harmony.

Si no aparece ninguna linea, significa que se ha creado el primer fotograma clave como un
fotograma clave de Stop-motion. Para resolverlo, realice una de las siguientes acciones:

« Haga clic con el botén derecho en el primer fotograma clave y seleccione Set Motion
Keyframe (Definir fotograma clave de movimiento).

o Seleccione el primer fotograma clave y pulse Ctrl + K (Windows/Linux) o 3£ + K (macOS)

Para asegurarse de que los nuevos fotogramas clave se establezcan en Motion (Movimiento) de
forma predeterminada, seleccione Animation (Animacidn) en el mend superior y asegurese de que
la opcién Stop-Motion Keyframe (Fotograma clave de Stop-motion) no esté activada.

NOTA

Cada fotograma clave puede ser un fotograma clave de movimiento o un fotograma
clave de Stop-motion. Los fotogramas entre dos fotogramas clave estan interpolados
por Harmony si el primero de los dos fotogramas clave es un fotograma clave de
movimiento.

14. En la vista de camara, cambie de nuevo la pose del personaje.

Capa
seleccio

15. Repita este proceso para todas las poses que desee agregar a la animacién.
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Ajuste de la velocidad de la animacion

1. En lavista de linea de tiempo, contraiga la jerarquia del rig (o de la parte del rig) a la que desea

aplicar una velocidad.

NOTA

Cuando se aplica una velocidad a una capa con hijos y se contrae la jerarquia de esta
capa, la velocidad se aplica a esa capa y a todos sus hijos.

2. Seleccione uno de los fotogramas clave de la animacién.

NOTA

Solo debe seleccionar un fotograma clave. El cuadro de didlogo Set Ease for Multiple
Parameters (Definir aceleracién para varios parametros) solo puede editar la aceleracion
en un fotograma clave a la vez, pero también le permite saltar rdpidamente entre
fotogramas clave en la linea de tiempo.

3. Realice una de las siguientes acciones:

o En lavista de linea de tiempo, haga clic con el botén derecho y seleccione Set Ease
For Multiple Parameters (Definir aceleracion para varios parametros).

o En la barra de herramientas de linea de tiempo, haga clic en el botén ~~ Set Ease For
Multiple Parameters (Definir aceleracion para varios parametros).
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Se abre el cuadro de didlogo Set Ease For Multiple Parameters (Definir aceleracién para varios
parametros).

=
=

Editor de

4. En el editor de Bézier, haga clic y arrastre el controlador Bézier para ajustar la velocidad de los
fotogramas clave seleccionados.

Controladores

5. También puede ajustar la velocidad introduciendo valores en los campos Time Ratio (Ratio de
tiempo) y Value Ratio (Ratio de valor) debajo del editor de Bézier. Los valores se calculan como un
porcentaje.

o En los campos Left Time Ratio (Ratio de tiempo izquierdo) y Right Time Ratio (Ratio de
tiempo derecho), escriba el valor como porcentaje correspondiente al tiempo que desea que
dure la velocidad. Las curvas Bézier se alejaran horizontalmente de su fotograma clave. El
valor debe estar entre el 0 %y el 100 %.

o En los campos Left Value Ratio (Ratio de valor izquierdo) y Right Value Ratio (Ratio de valor
derecho), escriba el valor como porcentaje correspondiente a la cantidad de sesgo que desea
gue tenga la velocidad. La curva Bézier se movera verticalmente hacia el fotograma clave
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mas cercano si el valor es positivo o lejos del fotograma clave mas cercano si su valor es
negativo. El valor debe estar entre el 0 % y el 100 %.

6. Para aplicar estos parametros de velocidad Unicamente a un tipo de funcién determinado, como

Rotation (Rotacidn) o Scale (Escala), en la seccidn Filters (Filtros), anule la seleccién de los tipos de
funcién a los que no desee que se apliquen.

Motion (Movimiento): aplica los parametros de velocidad a las funciones Position X
(Posicién X), Position Y (Posicién Y), Position Z (Posicién Z) y 3D Path (Ruta 3D)
seleccionadas.

Rotation (Rotacidn): aplica los pardametros de velocidad a las funciones de dangulo
seleccionadas.

Scale (Escala): aplica los parametros de velocidad a las funciones de escala
seleccionadas.

Skew (Sesgar): aplica los parametros de velocidad a las funciones de inclinacion
seleccionadas.

Morphing: aplica los pardmetros de velocidad a las funciones de velocidad de
morphing seleccionadas. Tenga en cuenta que se aplica cuando la funcién Morphing
Velocity (Velocidad de morphing) de la ventana Layer Properties (Propiedades de
capa), no es la velocidad de morphing basica en la vista de propiedades de la
herramienta.

Other (Otras): aplica los pardmetros de velocidad a todas las demas funciones
seleccionadas, como todas las funciones creadas para animar parametros de efecto.

7. Haga clic en uno de los siguientes botones:

Apply/Previous (Aplicar/anterior): aplica los parametros de velocidad al fotograma
clave seleccionadoy, a continuacion, salta al fotograma clave anterior de la linea de
tiempo para que después pueda ajustar su velocidad.

Apply (Aplicar): aplica los parametros de velocidad al fotograma clave seleccionado.

Apply/Next (Aplicar/siguiente): aplica los parametros de velocidad al fotograma clave
seleccionado y, a continuacidn, salta el siguiente fotograma clave de la linea de tiempo
para que después pueda ajustar su velocidad.

Close (Cerrar): cierra el cuadro de didlogo. Si no ha aplicado las modificaciones, se
cancelaran

Desplazamiento por las capas

Dado que la animacidn cut-out normalmente implica modelos complejos con amplias jerarquias, aprender los

atajos para desplazarse facilmente entre las capas puede ahorrar mucho tiempo.
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Un truco de gran utilidad para aprender es el comando Centre on Selection (Centrar en seleccién), junto con su
atajo de teclado. Este comando permite desplazarse directamente a la capa seleccionada en la vista de linea de
tiempo. Por lo tanto, puede usar la vista de camara para seleccionar de forma visual la capa con la que desee
trabajar y, a continuacion, usar el atajo de Centre on Selection (Centrar en seleccidn) para encontrar la capa en
la vista de linea de tiempo, en lugar de revisar la estructura de la escena para localizarla.

Centrado en la seleccion actual en la vista de linea de tiempo

1. En lavista de linea de tiempo, contraiga todas las capas.

2. En la barrade herramientas de herramientas, seleccione la herramienta . Transform

(Transformar).
3. En lavista de cdmara, seleccione una capa.
4. Realice una de las siguientes acciones:

« Haga clicen la pestafia de la vista de linea de tiempo para ajustar el centrado en la

misma y, a continuacion, pulse O.

o En labarra de herramientas de la vista de linea de tiempo, haga clic en el botdn
Centre on Selection (Centrar en seleccidn).

La vista de linea de tiempo estd ahora centrada en la capa seleccionada y todos sus padres se han

expandido automaticamente.

Si desea usar el atajo de teclado con frecuencia, le puede parecer tedioso tener que hacer clic en la pestafna de
vista de linea de tiempo cada vez. Para resolverlo, puede habilitar la preferencia Focus On Mouse Enter
(Centrarse en ratén). Ajustara el centrado en una vista en cuanto el cursor del ratén entre en ella y hara
funcionales al instante todos los atajos de teclado de esta vista.

Activacion de la preferencia Focus On Mouse Enter (Centrarse en ratén)

1. En el mend superior, vaya a Edit > Preferences (Editar > Preferencias) (Windows/Linux) o Harmony

> Preferences (Harmony > Preferencias) (macOS).
2. Abra la pestana General.

3. En la seccidn Options (Opciones), active la casilla de verificacion Focus On Mouse Enter (Centrarse

en raton).
4. Hagaclicen OK (Aceptar).

Los atajos de teclado para vistas especificas funcionaran en cuanto el cursor del ratén entre en la

vista prevista.
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Harmony también tiene comandos y atajos de teclado para cambiar rapidamente la seleccién de la capa
seleccionada actualmente a su su padre, su hijo o uno de sus hermanos, permitiendo asi el desplazamiento con

rapidez por la jerarquia del personaje desde una capa a una de sus capas relacionadas.

Seleccion del padre o del hijo de la capa seleccionada

1. En labarra de herramientas de herramientas, seleccione la herramienta i.} Transform

(Transformary).

2. En la vista de propiedades de la herramienta Transform (Transformar), asegurese de que esté

desactivado el modo i Peg Selection (Seleccién de peg).

3. Enlavista de cdmara o de linea de tiempo, seleccione una capa u objeto conectado a una jerarquia.

o)

~yU

O
[ ]

4. Realice una de las siguientes acciones:
« Seleccione Animation > Select Parent (Animacidn > Seleccionar padre) o pulse B para
seleccionar la capa padre.
« Seleccione Animation > Select Child (Animacién > Seleccionar hijo) o pulse Mayus + B para
seleccionar la capa hija.

o Seleccione Animation > Select Children (Animacion > Seleccionar hijos) para seleccionar

todas las capas hijas al mismo tiempo.

-
— )
e A7
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NOTA

Al subir o bajar la jerarquia de nodos, estos atajos de teclado omiten cualquier nodo de efecto
de la jerarquia y solo seleccionan peg o nodos de dibujo. Esto se debe a que estos atajos se
optimizan para la animacién cut-out. En el cuadro de didlogo Keyboard Shortcuts (Atajos de
teclado), en la seccién General, estos atajos de teclado se denominan Select Parent Skipping
Effects (Seleccionar efectos de omision del padre) y Select Child Skipping Effects (Seleccionar
efectos de omision del hijo). Si desea utilizar los atajos de teclado para navegar por la jerarquia
sin omitir los nodos de efectos, puede asignar atajos de teclado personalizados para los
comandos Select Parent (Seleccionar padre) y Select Child (Seleccionar hijo).

Seleccidén de los hermanos de la capa seleccionada

1. En lavista de linea de tiempo, seleccione una capa que tenga al menos un hermanoy realice una de
las siguientes acciones:

o Para seleccionar el hermano previo de la familia, pulse /.

« Para seleccionar el siguiente hermano de la familia, pulse la tecla de signo de
interrogacion (?).

o
o
o
o
o
o
o
o
o
o
o

| |- - [ - <+
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Capitulo 13: Uso de deformadores

Los deformadores permiten animar objetos y partes de un modelo de personaje mediante las deformaciones
generadas por ordenador. Las deformaciones funcionan mediante la creacién de puntos de control en un
dibujo. Al mover dichos puntos, el dibujo se dobla o distorsiona de modo que las partes del dibujo que estdn
vinculadas a un punto de control siguen dicho punto al lugar donde lo posicione.

Los deformadores pueden aumentar considerablemente el rango de movimientos y animaciones que el rig de
un personaje cut-out sea capaz de realizar sin necesidad de dibujar nuevas poses o recurrir a la animacién
fotograma a fotograma. Un personaje cut-out en rig con deformaciones se puede animar de una forma que se
asemeje a la fluidez y flexibilidad de la animacion tradicional. Ademds, los deformadores se pueden utilizar para
modificar, mejorar o facilitar la animacién fotograma a fotograma cuando sea necesario.

Los deformadores funcionan al crear un rigging con ellos en la parte del cuerpo que desee deformar, crear una
estructura de deformacion vy, a continuacién, animarlo. Se puede realizar facilmente con la herramienta §T

Rigging.
Hay dos tipos de deformadores disponibles en Harmony Advanced:
o Hueso

o Hueso parajuego

Deformador de huesos

La deformacién de hueso permite crear una estructura similar al hueso en la que cada parte es sélida, pero las
articulaciones son flexibles. Esto es sobre todo Util para la animacion de los miembros de un personaje, como los
brazos o las piernas, u otras partes que se puedan articular, como torsos o dedos.

Por ejemplo, se puede utilizar una deformacidn de hueso para articular un brazo que estd hecho de un solo
dibujo, de modo que el brazo y el antebrazo se puedan mover de forma independiente, sin necesidad de dibujar
la parte superior del brazoy el antebrazo en capas diferentes. Harmony deformard el dibujo para que parezca
que esta articulado. Las distintas partes de una deformacién de hueso se pueden rotar alrededor de su
articulacién, extenderse y acortarse, proporcionandole las mismas capacidades que las articulaciones de
animacion en distintas capas, sin tener que preocuparse por la separacion de piezas, puntos de pivote o recorte
de contornos.
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(

| Radiodel';o-/

Articulacion

Deformador de hueso para juego

La deformacidn de hueso para juego es parecida a la deformacién de hueso. Le permite crear estructuras
compuestas de puntos, que representan las articulaciones, y segmentos de lineas rectas vinculando dichos
puntos que representan los huesos. La deformacion de hueso para juego es diferente, ya que se optimiza para
motores de juego como Unity. Por lo tanto, generalmente solo se usa para personajes animados destinados a
importarse en juegos de Unity y no para producciones de animacion.

A diferencia de las deformaciones de hueso, las deformaciones de hueso para juego no tienen una propiedad
de sesgo. Los pliegues de la articulacidon también parecen ligeramente mas redondos.

(

| Radiodel';o-/

Articulacion

Creacion de deformadores

La manera mas sencilla de crear deformadores es usar la herramienta {T Rigging, disponible en la barra de
herramientas de deformacion. Con esta herramienta, todo lo que necesita hacer para crear un deformador es
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seleccionar la capa que desee deformar vy, a continuacion, colocar cada punto del deformador en la vista de
camara.

Los deformadores existen en la escena como una jerarquia de capas de deformacion. Cuando crea un nuevo
deformador, el primer punto que define es la raiz del deformador y cada punto nuevo que crea es un hijo del
punto anterior. Por lo tanto, los deformadores se crean en una cadena y se deben crear teniendo en cuenta la
jerarquia del personaje. Por ejemplo, si crea un deformador para un brazo, la raiz debe ser la articulacién del
hombro, el segundo punto debe ser el codo y el tercero, la muneca.

Un deformador afecta a todas las capas que hay debajo de su jerarquia. Al crear un nuevo deformador
utilizando la herramienta Rigging, se crea automaticamente como padre de la capa seleccionada, y afectard a la
capa seleccionada y a todos sus hijos. Por lo tanto, es importante seleccionar la capa correcta antes de intentar
crear un deformador.

Por ejemplo, si se desea crear un deformador para un brazoy el brazo se divide en varias capas, se puede crear
un rig del brazo en una jerarquia donde el brazo superior sea la raiz, el antebrazo sea el hijo del brazo superior y
la mano sea el hijo del antebrazo. A continuacidn, si crea su deformador en la parte superior del brazo, se creard
como padre de la parte superior del brazoy, por lo tanto, afectara a todo el brazo.

También puede agrupar varias capas debajo de un peg y crear su deformador con este peg seleccionado. Al
crear un deformador en un peg, el deformador se crea como un hijo del peg, pero como padre de todos los hijos
de este peg. Esto se debe a que es probable que un peg sea mas Util sobre un deformador que debajo de él. Si
mueve las capas que estan debajo de un deformador, saldran de la zona de deformacién prevista y pueden
aparecer muy deformadas y distorsionadas. Por lo tanto, es mejor crear todas las deformaciones posibles
debajo de los pegs, y los pegs que estén debajo de los deformadores solo deben animarse si el deformador se
queda intacto. Dado que el deformador se creara como padre de todos los hijos del peg, afectara a todas las
capas que haya debajo de este.

Creacién de un deformador de hueso

1. Una vez seleccionado el elemento, seleccione la herramienta {T Rigging en la barra de
herramientas de deformacion.

2. En lavista de propiedades de la herramienta, habilite el modo 4 Bone (Hueso).
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3. Hagaclicen el lugar donde desee crear la articulacién de raiz de la estructura dsea. La articulacion
de raiz deberia ser la que esté vinculada al resto del cuerpo. Por ejemplo, en un brazo, la articulacidn
de raiz seria el hombro.

4. Haga clicen el lugar donde desee crear la segunda articulacion.

Se creard un hueso entre la primera y la segunda articulacion.

Observe que, al crear un nuevo punto, el anterior aparece ahora rodeado por un circulo. Se trata del
radio de la articulacion, lo que permite determinar qué cantidad de dibujo debe formar parte de la
articulacién. Cada punto de un deformador de hueso, a excepcidn del primero y del dltimo, cuenta
con un radio.

6. Haga clicy mantenga pulsado el punto de control del radio de la articulacién anterior y ajuste el
radio de la articulacidn de modo que cubra la articulacidon correctamente.

7. Repita el proceso hasta que haya terminado de crear la cadena de huesos. Asegurese de crear cada
articulacion en el orden correcto desde la raiz hasta la extremidad.
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Visualizacion de deformadores

Harmony permite controlar qué deformadores se muestran en la vista de cdmara independientemente de la
seleccion actual. Al crear una cadena de deformacidn, sus controles de deformacion se muestran en la vista de
camara. Sin embargo, si selecciona un deformador existente o una capa que esté conectada a deformadores
existentes, sus controles de deformacidn no se mostraran automaticamente. Asimismo, al desactivar una
cadena de deformacién no se ocultaran sus controles de deformacion.

Para poder animar o modificar una cadena de deformacién existente, debe mostrarla de forma manual.

Visualizacién de los controles de deformacién

1. Realice una de las siguientes acciones:

o En lavista de cdmara o de linea de tiempo, seleccione una de las capas de dibujo vinculadas a
la cadena de deformacion que desee visualizacién.

o En lavista de linea de tiempo, seleccione cualquier parte de la cadena de deformacion que
desee visualizacion.

2. Enlabarra de herramientas de deformacion:

« Haga clicen el botén Show the Selected Deformation Chain and Hide All Others (Mostrar la
cadena de deformacidn seleccionada y ocultar el resto) © para mostrar la cadena de
deformacién del elemento seleccionado y ocultar cualquier otra cadena de deformacién que
se muestre.

« Hagaclic en el botén Show Selected Deformers (Mostrar deformadores seleccionados) 2%
para mostrar la cadena de deformacion del elemento seleccionado junto a cualquier otra
cadena de deformacién que se muestre.

Los controles de deformacion aparecen en la vista de camara.

NOTA

El botdn Show the Selected Deformation Chain and Hide All Others (Mostrar la cadena de
deformacién seleccionada y ocultar el resto) mostrara todas las cadenas de deformacion que se
encuentran en la jerarquia de la seleccion. Por ejemplo, si esta seleccionado el peg maestro de
un modelo de personaje, se mostraran todas sus cadenas de deformacién. Asimismo, si estan
seleccionadas varias capas vinculadas con distintas cadenas de deformacion, se mostraran
todas sus cadenas de deformacion.

Cdmo ocultar los controles de deformacidén

1. Realice una de las siguientes acciones:
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« Haga clic en el espacio negativo de la vista de cadmara, de linea de tiempo o de nodos
para descartar la seleccidén actual y, a continuacidn, haga clic en el botén ©~ Show the
Selected Deformation Chain and Hide All Others (Mostrar la cadena de deformacion
seleccionada y ocultar el resto) de la barra de herramientas de deformacion.

o Seleccione una capa que no esté vinculada a ningun deformador y, a continuacion,
haga clicen el botén © Show the Selected Deformation Chain and Hide ALl Others
(Mostrar la cadena de deformacidn seleccionada y ocultar el resto) de la barra de
herramientas de deformacion.

o En la barra de herramientas de cdmara, haga clic en el botén  Hide All Controls
(Ocultar todos los controles).

« En el mend superior, seleccione View > Hide All Controls (Ver > Ocultar todos los
controles).

o Pulse Mayls + C.

Animacion con deformadores

Aligual que con los pegs de animacién y las capas de dibujo, puede animar los deformadores creando
fotogramas clave en sus capas correspondientes en la linea de tiempo. La animacion de deformadores funciona
exactamente igual que la realizacién de modificaciones en un deformador, excepto que requiere el uso de la
herramienta ! Transform (Transformar) en lugar de la herramienta Rigging. Al seleccionar la herramienta
Transform (Transformar), los controles de deformacion de la vista de cdmara se muestran en color verde, lo que
significa que se encuentran en modo de animacién, mientras que cuando se selecciona la herramienta Rigging,
se muestran en rojo, lo que significa que se encuentran en modo de rigging.

Animacion de deformaciones de hueso y hueso para juego

1. En lavista de linea de tiempo, contraiga el personaje con la flecha Expand/Collapse

(Expandir/Contraer).
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3. Para garantizar que el modelo no desaparezca después de 1 fotograma, abra el cuadro de didlogo
Extend Exposure (Extender exposicion) realizando una de las siguientes acciones:

« Haga clic con el botdén derecho en el primer fotograma de la vista de linea de tiempo 'y
seleccione Extend Exposure (Extender exposicidn).

e Pulse F5.

4. En el cuadro de didlogo Extend Exposure (Extender exposicion), escriba el nimero de fotogramas
de la escena y confirme. De este modo, el modelo quedara expuesto (sera visible) en toda la escena.

5. Ahora crearemos la primera pose del personaje. En primer lugar, asegurese de que haya un
fotograma clave en el primer fotograma de cada capa del modelo. Con ello garantiza que cuando
cree la segunda pose mas tarde, la primera pose no se vera afectada. Para llevarlo a cabo, realice
una de las siguientes acciones:

« Enlabarra de herramientas de linea de tiempo, haga clic en el botén ¢r Add Keyframe
(Agregar fotograma clave).

« Haga clic con el botén derecho y seleccione Add Keyframe (Agregar fotograma clave).

e Pulse F6.

Se agrega un fotograma clave al fotograma actual.

6. En la barra de herramientas de herramientas, seleccione la herramienta . Transform
(Transformar) o pulse Mayus + T.

7. En labarra de herramientas de herramientas, si esta seleccionado el modo $ Animate Off (Animar
desactivado) o g\% Animate Onion Skin Range (Animar intervalo de papel cebolla), haga clicen él
para abrir el menl emergente Animate (Animar) y seleccione Animate Current Frame (Animar
fotograma actual).

8. Realice una de las siguientes acciones:

o En lavista de cdmara o de linea de tiempo, seleccione una de las capas de dibujo vinculadas a
la cadena de deformacion que desee animar.

o En lavista de linea de tiempo, seleccione cualquier parte de la cadena de deformacion que
desee animar.
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9. En la barra de herramientas de deformacion:

« Haga clicen el botén Show the Selected Deformation Chain and Hide All Others (Mostrar la
cadena de deformacidn seleccionada y ocultar el resto) ©~ para mostrar la cadena de
deformacion del elemento seleccionado y ocultar cualquier otra cadena de deformacion que
se muestre.

« Hagaclicen el botén Show Selected Deformers (Mostrar deformadores seleccionados) 2
para mostrar la cadena de deformacién del elemento seleccionado junto a cualquier otra
cadena de deformacién que se muestre.

Los controles de deformacién aparecen en la vista de camara.
10. En la vista de camara, realice lo siguiente:

« Para rotar el miembro entero, haga clicy arrastre el primer hueso. Esto girard el primer
hueso y todos los huesos subsiguientes.

o Paradoblar el miembro, haga clicy arrastre otro hueso. Esto girara el hueso y todos
los huesos subsiguientes, pero dejara los huesos anteriores en su posicion actual.

o Para cambiar una articulacién de posicidn, haga clic y arrastre su punto de control.
Esto se puede utilizar para rotar, reducir o extender el hueso, y desplazard todos los
huesos subsiguientes.
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o Parareducir o extender un hueso sin rotarlo, mantenga pulsada la tecla Alty, a

continuacion, haga clicy arrastre su punto de control.

o Paradesplazar el miembro entero, haga clicy arrastre su punto de raiz.

4 \

También puede realizar un desplazamiento pequefio de una articulacién
en cualquier direccién seleccionandola y, a continuacion, pulsando las

Q_ CONSEJO

teclas de flecha.

11. En lavista de linea de tiempo, vaya al fotograma en el que desee definir la siguiente pose clave.
12. Agregue un fotograma clave en el fotograma actual realizando una de las siguientes acciones:

« En la barra de herramientas de linea de tiempo, haga clic en el botén * Add
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Keyframe (Agregar fotograma clave).
« Haga clic con el botdn derecho vy seleccione Add Keyframe (Agregar fotograma clave).
o Pulse F6.
13. Transforme el punto del deformador para crear su nueva pose clave.

14. Repita los pasos anteriores hasta que la animacién haya terminado.
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Capitulo 14: Importacidon de sonido y sincronizacion de labios
— =
~ \

Importacion de sonido

Si desea agregar sonido a la animacién, es recomendable que edite y mezcle los archivos de sonido en un
software de edicidn de sonido. Al tener pistas de sonido de larga duracién mezcladas previamente, se
garantiza que el sonido conserve su tiempo, mezcla y calidad si utiliza software de terceros para la
postproduccidn. Otra buena practica es mantener la pista de sonido separada en pistas de musica, efectos de
sonido y personajes para facilitar la sincronizacién de la animacién con voces y sonidos. De lo contrario, es
posible recortar los efectos de sonido y ajustar su volumen directamente en Harmony cuando sea necesario.

Si crea el proyecto en Toon Boom Storyboard Pro, puede exportar todas las escenas del proyecto como escenas
de Harmony independientes. La pista de sonido del storyboard se cortara por escena y cada pieza se insertard
en las escenas exportadas, lo que permite ahorrar tiempo en la division e importacion de la pista de sonido.

Harmony puede importar archivos de sonido .wav, .aiff y . mp3.

NOTA

La importacién de una pista de sonido mas larga que la escena no ampliara la longitud de esta
ultima. La reproduccion de sonido se detendra al final de la duracién de la escena.

Importacién de un archivo de sonido

1. Realice una de las siguientes acciones:
« En el menu superior, seleccione File > Import > Sound (Archivo > Importar > Sonido).

« En lavista de carta de rodaje, haga clic con el botdn derecho en cualquier parte del
area de fotogramas y seleccione Import > Sounds (Importar > Sonidos).

o En el mend Xsheet (Carta de rodaje), seleccione File > Import > Sounds (Archivo >
Importar > Sonidos).

o Enelmend Timeline (Linea de tiempo), seleccione Import > Sounds (Importar >
Sonidos).

Se abre el cuadro de dialogo Select Sound File (Seleccionar archivo de sonido).

2. En el cuadro de didlogo Select Sound File (Seleccionar archivo de sonido), busque y seleccione un
archivo de sonido.
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El archivo de sonido aparece como una capa en la vista de linea de tiempo. Su forma de onda se
muestra en la pista para ayudar a visualizar en qué fotogramas se producen los efectos de sonido de
la pista de sonido.

La pista de sonido también aparece como una columna en la vista de carta de rodaje, pero no
mostrara una forma de onda de manera predeterminada. Si lo desea, puede visualizar la forma de
onda de una columna de sonido haciendo clic con el botdn derecho en ella y seleccionando Sound
Display > Waveform (Visualizacion de sonido > Forma de onda).

Deteccidon automatica de sincronizacion de labios

La adicidn de la sincronizacion de labios a la animacién es fundamental para que parezca que los personajes
estan vivos. Sin embargo, también es una parte especialmente pesada del proceso de animacion.

— e W
~ \

Para solucionar este problema, Harmony proporciona una funcién de deteccién automatica de sincronizacién de
labios. Esta funcién analiza el contenido de una pista de sonido de la escena y asocia cada fonema que detecta
con una de las formas de boca de la siguiente carta de fonemas, que es una carta de fonemas estandar de la
industria de la animacion.
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Boca
NOTA

Las letras asignadas a estas formas de boca son identificadores estandar y NO se corresponden con
el sonido que se pretende producir.

Esta es una aproximacién de los fonemas ingleses que cada forma de boca puede utilizar para representar:
e« A:m,b,p,h
« B:s,d,j ikt
e Cea
« D:AE
« E:0
e Fu,00
o« G:f ph
« X:silencio, sonido indeterminado

Al realizar la deteccion automatica de sincronizacidn de labios, Harmony no crea dibujos de boca. Simplemente
rellena la columna de dibujo de la capa de la boca del personaje con la sincronizacion de labios generada,
insertando la letra asociada con la forma de boca correcta en cada celda de la columna. Por lo tanto, para que la
deteccidn automdtica de sincronizacidn de labios funcione, la capa de la boca del personaje ya debe contener
un dibujo de boca para cada dibujo de la carta de fonemas, y estos dibujos deben tener el nombre de su letra
correspondiente.

Generacion de una deteccion de sonido para sincronizacion de labios mediante la
vista de propiedades de capa

1. Enlavistade linea de tiempo o de carta de rodaje, seleccione la capa de sonido.
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Las opciones para dicha capa apareceran en la vista de propiedades de capa.

2. Enlas propiedades de capa, haga clic en Detect (Detectar).

Harmony analiza los clips de sonido seleccionados y asigna una letra de sincronizacion de labios a

cada celda de sonido.

3. Hagaclicen el botén Map (Asignar) para abrir el cuadro de didlogo Lip-Sync Mapping (Asignacion
de sincronizacion de labios).

4. En el ment Destination Layer (Capa de destino), seleccione la capa que contiene las posiciones de la
boca para la pista de voz del personaje.
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NOTA

Si la capa seleccionada contiene simbolos, puede asignar la sincronizacién de labios
utilizando dibujos situados directamente en la capa, o bien utilizar los fotogramas del
simbolo. En el campo Symbol Layer (Capa de simbolos), seleccione Don't Use Any
Symbol (No usar ningun simbolo) si desea utilizar los dibujos o el simbolo deseado del
menu desplegable.

5. En la seccién Mapping (Asignacidn), escriba el nombre del dibujo o los fotogramas del simbolo en el
campo situado a la derecha del fonema que representa. Si los dibujos ya tienen los nombres de las
letras del fonema, puede saltarse este paso.

6. Haga clicen OK (Aceptar).
7. En labarra de herramientas de reproduccion, habilite la opcién ®) Enable Sound (Habilitar sonido).

8. Pulse el botén » Play (Reproducir) en la barra de herramientas de reproduccion para ver y oir los
resultados en la vista de camara.

Si tiene que realizar ajustes a la sincronizacidn de labios generada automaticamente, consulte
Animacion manual de sincronizacidn de labios en la pagina 152.

Animacion manual de sincronizacidn de labios

Puede crear la sincronizacion de labios para la escena de forma manual seleccionando qué dibujo de boca debe
exponerse en cada fotograma del cuadro del didlogo de su personaje. Para este proceso, utilizara la funcién
Sound Scrubbing (Depuracion de sonido), que reproduce la parte de la pista de sonido en el fotograma actual
cada vez que mueva el cursor de la linea de tiempo, lo que permite identificar los fonemas que debe hacer
coincidir con la boca de su personaje. También se utilizard un dibujo de sustitucién para cambiar el dibujo de la
boca que se expone en cada fotograma.

Animacidn de sincronizacion de labios utilizando la vista de linea de tiempo

1. En la barra de herramientas de reproduccién, active el botdn €S Sound Scrubbing (Depuracién de
sonido).

2. En lavista de linea de tiempo, arrastre el cabezal de reproduccidn rojo a lo largo de la forma de
onda de la capa de sonido.

3. Cuando llegue a un fotograma en el que deba ir una posicién determinada de la boca, por ejemplo,
una boca abierta con labios redondeados para un sonido como "oh", haga clic en ese fotograma en la
capa de formas de boca.

4. En la seccidn Parameters (Parametros), y continuando en la capa de formas de boca, coloque el
cursor en la parte superior del nombre del dibujo (normalmente una letra) hasta que cambie al
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puntero de intercambio ‘{5

5. Arrastre el cursor para ver la lista de los nombres de la forma de la boca y elija la que desee. EL
dibujo actual se cambia automaticamente a la nueva seleccion.
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Animacion de sincronizacién de labios utilizando la vista de libreria

1. En la barra de herramientas de reproduccion, active el botédn €S Sound Scrubbing (Depuracion de
sonido).

2. En lavista de linea de tiempo, arrastre el cabezal de reproduccién rojo a lo largo de la forma de
onda de la capa de sonido.

3. Cuando llegue a un fotograma en el que deba ir una posicién determinada de la boca, por ejemplo,
una boca abierta con labios redondeados para un sonido como "oh", haga clic en ese fotograma en la
capa de formas de boca.

4. En laventana Drawing Substitution (Sustitucion de dibujo) de la vista de libreria, arrastre el control
para elegir una forma de boca. El dibujo actual se intercambia por el de la ventana de vista previa.

Intercambio de dibujos utilizando la vista de sustituciones de dibujo

1. Agregue la vista de sustituciones de dibujo a su zona de trabajo realizando una de las siguientes
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4.

acciones:

« En la esquina superior derecha de las vistas existentes, haga clic en el botén = Add View
(Agregar vista) y seleccione Drawing Substitutions (Sustituciones de dibujo).

o En el mend superior, seleccione Windows > Drawing Substitutions (Ventanas
> Sustituciones de dibujo).

En la barra de herramientas de reproduccién, active el botdn €S Sound Scrubbing (Depuracidn de
sonido).

En la vista de linea de tiempo, arrastre el cabezal de reproduccién rojo a lo largo de la forma de
onda de la capa de sonido.

Cuando llegue a un fotograma en el que deba ir una posicién determinada de la boca, por ejemplo,
una boca abierta con labios redondeados para un sonido como "oh", haga clic en ese fotograma en la
capa de formas de boca.

En la vista de sustituciones de dibujo, haga clic en la pose de la boca que desee exponer en el
fotograma actual.

Substitutions == [%

CONSEJO

También puede pulsar [ para sustituir el dibujo seleccionado por el dibujo anterior y ] para
sustituirlo por el siguiente dibujo.
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Capitulo 15: Adicion de efectos a una escena

Al crear una escena, crear un rig de personaje o una vez que la animacion esté terminada, puede agregar
efectos, como desenfoques, brillos, sombras, filtros de color y de transparencia, asi como mejorar la calidad del
proyecto. Los efectos cambian la forma en la que las capas o grupos de capas se renderizan en la escena.

Acerca de los efectos

Los efectos son tipos de capas especiales que se pueden agregar a la estructura de la escena. Para que una
capa de efecto funcione, debe estar conectada como hija de un dibujo, grupo u otro efecto. Los efectos solo se
aplican al elemento al que estan conectados. Esto proporciona flexibilidad a la hora de decidir a qué elementos
de la escena afecta un efecto.

Algunos efectos necesitan vincularse a otra capa, denominada capa de mate, que se usa para definir el drea a la
que deben afectar. Un buen ejemplo de ello es el efecto de tono, que se usa para agregar una sombra de una
forma determinada a una capa. De forma independiente, el efecto de tono no tiene ningun impacto en el dibujo
al que estd conectado. Una vez combinado con una capa de mate, el efecto de tono usard la forma del mate
para aplicar una sombra al dibujo. Incluso si la forma del mate sale fuera de los contornos del dibujo, la sombra
solo se aplicard dentro de los contornos del dibujo.
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Una capa de mate es una capa de dibujo habitual que esta conectada a un efecto como su mate. El efecto toma
la forma del dibujo en la capa de mate para determinar el area del dibujo a la que afecta. Los colores y detalles
de la capa de mate se ignoran mediante el efecto y solo se tiene en cuenta su forma.

En la vista de linea de tiempo, se debe crear un rig de un efecto como el hijo de una capa de dibujo o grupo al
que debe afectar.

Si el efecto puede usar una capa de mate, tendrd un parametro de mate al ampliar la lista de parametros.
Puede arrastrar y colocar la capa en la que desee usar un mate para el efecto en el pardmetro de mate del
efecto para vincularlos.

Si el efecto puede usar una capa de mate, tendra un puerto de mate a su izquierda al que se puede conectar la
capa de mate.

Una vez que el efecto esta conectado, puede ajustar sus parametros seleccionandolo vy, a continuacion,
ajustando sus parametros en la vista de propiedades de capa. También puede hacer doble clic en la capa para
abrir su cuadro de didlogo de propiedades de capa. Si se desea, incluso puede animar los parametros del efecto
convirtiendo sus valores a funciones.

Adicién de un efecto

En Harmony, puede agregar efectos seleccionando la capa o grupo al que desee agregar un efectoy, a
continuacion, agregando el efecto a través del menu Add Layers (Agregar capas) de la vista de linea de tiempo.
A continuacion, puede conseguir el efecto previsto ajustando los parametros en la vista de propiedades de capa
y conectandolos a una capa de mate, segun proceda.

Adicion de un efecto
1. En lavistade linea de tiempo, seleccione la capa en la que desee agregar un efecto.

2. Realice una de las siguientes acciones:

o En el mend superior, seleccione Insert > Effects (Insertar > Efectos) y seleccione el
efecto que desea agregar.

157



Capitulo 15: Adicidn de efectos a una escena

« En la barra de herramientas de capas situada encima de la lista de capas, haga clicen
el botén +, Add Layers (Agregar capas), seleccione Effects (Efectos) y, a
continuacion, seleccione el efecto que desee agregar.

« Haga clic con el botén derecho en la capa, seleccione Insert > Effects (Insertar >
Efectos) y, a continuacion, seleccione el efecto que desee agregar.

El efecto aparece en la vista de linea de tiempo, debajo de la capa seleccionada.

3. En lavista de cdmara, haga clic en el botdn Render View (Vista de render) para ver el fotograma
y el efecto actuales renderizados de la escena.

NOTA

El fondo aparecera en negro de forma predeterminada. Para corregirlo, puede
agregar una capa de la carta de color en la parte inferior de la lista de capasy
cambiar su color en la vista de propiedades de capa.

4. En lavista de linea de tiempo, haga doble clic en la capa del efecto para abrir la ventana Layer
Properties (Propiedades de capa). También puede seleccionar la capa del efecto y ver sus
propiedades en la vista de propiedades de capa.

Se abre la vista de propiedades de capa y muestra los parametros disponibles para el efecto

seleccionado.

5. En la vista de propiedades de capa, ajuste los pardametros del efecto segun sea necesario.

NOTA

Cada vez que realice un cambio, la vista de cdmara tendrd que actualizar la imagen
renderizada, lo cual puede provocar una ligera demora antes de que pueda observar el
efecto.
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6. La mayoria de los efectos no se reproduciran en tiempo real en Harmony. Para reproducir la escena
con los efectos finales, haga clic en el botén & Render and Play (Renderizar y reproducir) de la
barra de herramientas de reproduccion de la barra de herramientas de la vista de linea de tiempo.

NOTA

Una vez que haya establecido los parametros para el efecto, puede almacenarlo en la vista de
libreria como plantilla para poder reutilizarlo rapidamente sin necesidad de volver a establecer
los parametros; consulte Creacidn y uso de plantillas en la pagina 192.

Adicion de un efecto con un mate

El siguiente tutorial muestra cémo usar el efecto de cuchilla con un mate. En Harmony, varios efectos usan
mates para determinar el drea de la imagen a la que afectan.

El efecto de cuchilla permite cortar una parte de una imagen. Para ello, debe conectarse al dibujo que se
pretende cortar, asi como a una capa de mate. La cuchilla adoptara la forma del dibujo de la capa de mate y
cortard esta forma de la capa de dibujo. Esto es particularmente (til si desea que un personaje desaparezca
entre un elemento de fondo o si desea realizar un agujero en el centro de un personaje.

Aligual que todos los efectos que utilizan un mate, el efecto de cuchilla tiene un parametro Inverted (Invertido),
que esta deshabilitado de forma predeterminada. Cuando esté habilitada, la cuchilla tendra el efecto contrario:
en lugar de cortar la forma del mate del dibujo, cortara todo lo que se encuentre fuera de la forma del mate del
dibujo, dejando solo las partes del dibujo que estén cubiertas por el mate.

Uso del efecto de cuchilla

1. Seleccione una capa de dibujo.
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2. Realice una de las siguientes acciones:

« En la barra de herramientas sobre la lista de capas en la vista de linea de tiempo, haga clic
en el botén +, Add Layer (Agregar capa) y seleccione Effects > Cutter (Efectos > Cuchilla).

« Haga clic con el botén derecho en la capa y seleccione Insert > Effects > Cutter (Insertar
> Efectos > Cuchilla).

El efecto de cuchilla se crea como capa hija de la capa seleccionada.

1. En la barra de herramientas sobre la lista de capas en la vista de linea de tiempo, haga clicen %%
Add Drawing Layer (Agregar capa de dibujo).

2. En el cuadro de didlogo Add Drawing Layer (Agregar capa de dibujo), asigne a la nueva capa de
dibujo un nombre relevante para una capa de mate, como "Dibujo de mate" y, a continuacion, haga
clicen Add and Close (Agregar y cerrar).

3. En la nueva capa de dibujo de mate, dibuje un mate para el efecto. EL mate puede ser una forma
simple, pero se debe rellenar con un color, ya que solo se tendran en cuenta las partes del mate que
sean opacas.

NOTA

Los mates también pueden tener areas semitransparentes. Las areas del dibujo
cubiertas por dreas semitransparentes del mate se ven parcialmente afectadas por el
efecto.
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4. En lavista de linea de tiempo, haga clic en el botdn + Expand (Expandir) situado a la derecha de
la capa Cutter (Cuchilla).

5. Arrastrey coloque la capa de mate junto al campo Matte (Mate) de la capa Cutter (Cuchilla), debajo
de la columna Parameters (Pardmetros).

La capa de dibujo de mate se convierte en el mate de la capa Cutter (Cuchilla). En este punto, las
areas de lailustracién que se cruzan con la ilustracion de la capa de dibujo de mate estan ocultas.

6. Sidesea invertir el efecto de cuchilla, para que la ilustracién que se cruza con la ilustracién de la
capa de mate sea visible y todo lo demas esté oculto, haga doble clic en la capa Cutter (Cuchilla)
(pero no en sunombre) para abrir su cuadro de didlogo de propiedades de capa vy, a continuacion,
marque el parametro Inverted (Invertido).

Otros dos ejemplos de efectos que funcionan con mates son los efectos de tono y resaltado. El efecto de tono
aplica una sombra a su dibujo basada en su mate, mientras que el efecto de resaltado aplica un resaltado a un
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dibujo basado en un mate. Estos efectos no se aplican fuera de los dibujos a los que estan conectados, de modo
que solo tiene que dibujar los resaltados y la sombra del personaje en las capas de mate sin preocuparse por
dibujar fuera del trazado.

La adicidon de estos efectos a un dibujo funciona exactamente igual que la adicién de una cuchilla a un dibujo,
salvo que tienen parametros adicionales para configurar el color, la intensidad y el renderizado del efecto.

Animacion de un efecto

Es posible que necesite animar algunos efectos para obtener los resultados esperados. Por ejemplo, puede
desear que el radio de un efecto de brillo aumente y disminuya lentamente para hacer que vibre a lo largo de
una escena, o puede desear que la transparencia de un efecto de transparencia aumente de 0 % a 100 % para
hacer desaparecer un dibujo.

Casi todos los parametros numéricos de un efecto se pueden unir a una funcién. Una funcién permite definir un
parametro para distintos valores en diferentes puntos de la escena agregandole fotogramas clave y definiendo
cada fotograma clave en un valor especifico. Entre fotogramas clave, el valor del pardmetro avanzard desde el
valor del fotograma clave anterior al valor del siguiente fotograma clave. Las capas de dibujo se animan
asociando sus coordenadas a funciones. Del mismo modo, los efectos se pueden animar asociando sus
parametros a funciones.

Algunos pardmetros de efectos se pueden animar directamente en la vista de linea de tiempo, pero no todos.
Al expandir los pardmetros de un efecto en la vista de linea de tiempo, algunos de sus parametros pueden
estar ocultos para evitar saturar la vista de linea de tiempo. Puede animar esos pardmetros desde la vista de
propiedades de capa o el cuadro de didlogo de propiedades de capa, que muestra todos los parametros de una
capa.
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Animacion de un parametro de efecto en la vista de linea de tiempo

1. En lavista de linea de tiempo, localice el efecto que desea animar y haga clic en el botén 4 Expand
(Expandir) situado a la derecha de sunombre.

Aparece en la vista de linea de tiempo la lista de parametros que muestra los parametros de efectos
disponibles.

nO=am

|+ + T

2. En el drea derecha de la vista de linea de tiempo, en la misma fila que el parametro que desee
animar, seleccione el fotograma en el que desee crear el primer fotograma clave de animacién para
el efecto.

3. Cree un fotograma clave realizando una de las siguientes acciones:

« En la barra de herramientas de linea de tiempo, haga clic en el botén ¢ Add Keyframe
(Agregar fotograma clave).

« Haga clic con el botdn derecho y seleccione Add Keyframe (Agregar fotograma clave).

e Pulse F6.
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4. En el dreade laizquierda de la vista de linea de tiempo, debajo de la columna Parameters
(Parametros), ajuste el valor del parametro para este fotograma clave realizando una de las
siguientes acciones:

« Haga clicy mantenga pulsado el valor del parametro. A continuacidn, arrastrelo hacia la
izquierda para reducir su valor o hacia la derecha para aumentarlo.

o Hagaclicen el valor del parametro. Aparecera un campo de texto. Escriba el nuevo valor del
parametro y pulse Entrar.

5. En el drea derecha de la vista de linea de tiempo, haga clic en el fotograma en el que desee crear el
segundo fotograma clave de animacion para el efecto.

ro=al
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6. Cree el segundo fotograma clave para la animacion del efecto realizando una de las siguientes
acciones:

« En la barra de herramientas de linea de tiempo, haga clic en el botén ¢ Add Keyframe
(Agregar fotograma clave).

« Haga clic con el botdn derecho y seleccione Add Keyframe (Agregar fotograma clave).

e Pulse F6.

7. En la columna Parameters (Parametros), ajuste el valor del pardmetro en el fotograma clave actual.
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8. Repita los pasos para crear tantos fotogramas clave de animacién para el efecto como sea necesario.

9. Para ajustar el tiempo entre los fotogramas clave de la animacidn, seleccione el primer fotograma
clave.

10. En la barra de herramientas de linea de tiempo, haga clic en el botdn 4~ Set Ease for Multiple
Parameters (Definir aceleracién para varios parametros).

Aparece el cuadro de didlogo Set Ease For Multiple Parameters (Definir aceleracion para varios
parametros). ELl gréfico de funciones de este cuadro de didlogo se centrard en el primer o fotograma
clave de la animacion, que debe tener un controlador de la = curva Bézier al lado apuntando hacia
la derecha.

Controlador

11. Haga clic en el controlador de la = curva Bézier y arrastrelo hacia la derecha, en cualquier angulo,
para ajustar la aceleracién gradual de la animacion.

12. Haga clic en Apply/Next (Aplicar/siguiente).
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El cuadro de didlogo Set Ease For Multiple Parameters (Definir aceleracién para varios parametros)
se centrara en el segundo fotograma clave. Si este es el Ultimo fotograma clave de la animacidn, solo
tendrd un controlador de curva Bézier apuntando hacia la izquierda. Si hay mas fotogramas clave de
animacion después de este, tendra dos controladores de la curva Bézier, uno apuntando en cada
direccion.

13. Haga clic en el controlador izquierdo de la - curva Bézier y arrastrelo hacia la izquierda, en
cualquier angulo, para ajustar la desaceleracidon gradual de la animacion entre el fotograma clave
anterior y el fotograma clave actual.

14. Sihay un controlador de curva Bézier = apuntando hacia la derecha, haga clicen él y arrastrelo
hacia la derecha, en cualquier angulo, para ajustar la aceleracién gradual de la animacion entre el
fotograma clave actual y el siguiente fotograma clave.
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15. Repita los pasos anteriores hasta que el tiempo de la animacidn se ajuste a lo largo de toda la

escena.

Animacidn de un efecto en el cuadro de dialogo de propiedades de capa

1. Abra las propiedades de capa del efecto realizando una de las siguientes acciones:

o Agregue la vista de propiedades de capa a la zona de trabajo y seleccione el efecto en la
vista de linea de tiempo.

o En lavista de linea de tiempo, haga doble clic en la capa del efecto, pero no en sunombre.

2. En las propiedades de capa del efecto, localice el parametro que desea animar y haga clic en el
botdn s Function (Funcion) situado a su derecha.

El campo de entrada del parametro se atenuara. Esto se debe a que no puede editar un parametro
directamente una vez conectado a una funcion. El campo indicara el nombre de la funcién que se
cred para él en este formato:

Nombre de capa: Nombre de funcién: Valor en fotograma actual
3. Haga clic de nuevo en el botdn Function (Funcién) del parametro.

Se abre el cuadro de dialogo Bezier Editor (Editor de Bézier).
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Cursor de fotograma

Este cuadro de didlogo permitird animar la funcién. El grafico de funciones de la parte inferior sirve
para representar los valores de la funcidn a lo largo de cada fotograma de la escena.

4. En el gréfico de funciones, haga clicy arrastre el cursor rojo l para moverlo al fotograma donde
desea crear el primer fotograma clave de animacion.

5. Haga clicen el botén & Add Keyframe (Agregar fotograma clave) para crear el primer fotograma

clave de animacién para el efecto.

Se crea un fotograma clave o y debe ser visible en el grafico de funciones. Si no se ve, es porque el
grafico de funciones no esta colocado para incluir el fotograma clave en su fotograma. Para mover el
gréfico de funciones con el fin de ver el fotograma clave de la funcién, haga clic en el botén 4
Reset View (Restablecer vista) o @ Reset View Vertically (Restablecer vista vertical).
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6. Ajuste el valor del parametro al fotograma actual realizando una de las siguientes acciones:

o En el campo Value (Valor) sobre el grafico de funciones, escriba el valor deseado para el
parametro.

« En el grafico de funciones, haga clicy arrastre el o fotograma clave y muévalo hacia arriba
para aumentar su valor o hacia abajo para disminuirlo.

:Q’. CONSEJO

Si desea establecer el fotograma clave en un valor que esta fuera del fotograma
del gréfico de funciones, puede pulsar la tecla 1 para alejarse. También puede
pulsar la tecla 2 para volver a acercarse.
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7. Hagaclicy arrastre el cursor rojo para moverlo al fotograma donde desea crear el segundo
fotograma clave de animacion.

8. Haga clicen el botén ¢+ Add Keyframe (Agregar fotograma clave) para crear el segundo fotograma
clave de animacion para el efecto.

9. Ajuste el valor del parametro al fotograma actual realizando una de las siguientes acciones:

o En el campo Value (Valor) sobre el gréfico de funciones, escriba el valor deseado para el
parametro.

« En el grafico de funciones, haga clicy arrastre el o fotograma clave y muévalo hacia arriba
para aumentar su valor o hacia abajo para disminuirlo.
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10. Sidesea ajustar el tiempo de la animacion entre el primer y el segundo fotograma clave, haga lo
siguiente:

o Haga clicy arrastre el controlador de la = curva Bézier del primer fotograma clave hacia la
derecha, en cualquier direccién, para que afecte a la aceleraciéon gradual de la animacidn.

« Hagaclicy arrastre el controlador de la <= curva Bézier del segundo fotograma clave hacia la
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izquierda, en cualquier direccidn, para que afecte a la desaceleracion gradual de la animacion.

11. Repita estos pasos hasta que haya creado y sincronizado los fotogramas clave de animacién
necesarios para animar el efecto.

Creacion de un efecto basado en un personaje animado

En el siguiente tutorial se demuestra cdmo combinar efectos con otras funciones de Harmony para crear
facilmente una sombra paralela para un personaje animado. Siguiendo estos pasos, puede crear una sombra
paralela que seguira automaticamente la animacion del personaje, incluso si después cambia la animacidn.

Creacion de una sombra paralela para un personaje animado

1. En lavista de linea de tiempo, seleccione todas las capas que forman el rig de personaje. Si el
personaje esta bajo un peg maestro, también funcionara si selecciona el peg maestro.

2. Asegurese de que el rig de personaje se encuentre en un grupo. De no ser asi, haga clic con el botén
derecho en la seleccién y, a continuacion, seleccione Group Selection (Agrupar seleccion).

172



Guia de introduccién de Harmony 21 Advanced
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3. Unavez seleccionado el personaje en la vista de linea de tiempo, cree un clon del personaje
realizando una de las siguientes acciones:

« Haga clic con el botén derecho en la seleccidn vy, a continuacion, seleccione Clone
Selected Layers: Drawings and Timing (Clonar capas seleccionadas: Dibujos y
tiempo).

« En el mend superior, seleccione Edit > Clone: Drawings and Timing
(Editar > Clonar: Dibujos y tiempo).

NOTA

Al contrario que un duplicado, una capa clonada siempre tiene el mismo tiempo vy la
misma exposicién que su capa de origen, incluso si su capa de origen se cambia mas
tarde. Por lo tanto, puede cambiar la animacién del personaje y la animacién del
personaje clonado se actualizard automaticamente con estos cambios.

4. Agregue un efecto de sombra al grupo realizando una de las siguientes acciones.

« Enlabarra de herramientas de capas de la vista de linea de tiempo, haga clicen +,
Add Layers (Agregar capas) y seleccione Effects > Shadow (Efectos > Sombra).

« Haga clic con el botén derecho en la seleccidn vy, a continuacion, seleccione Insert >
Effects > Shadow (Insertar > Efectos > Sombra).

5. En la vista de linea de tiempo, seleccione la capa raiz del clon del personaje.

6. Cree un peg padre para el clon realizando una de las siguientes acciones:
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o En labarra de herramientas de capas de la vista de linea de tiempo, haga clic en el
botén (% Add Peg (Agregar peg).

o Pulse Ctrl + P (Windows/Linux) o 3 + P (macQS).

En la vista de linea de tiempo, seleccione el peg padre del clon.

En la barra de herramientas de herramientas, seleccione la herramienta . Transform
(Transformar).

En la vista de cdmara, escale y sesgue el clon de modo que parezca una sombra difuminada.
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Capitulo 16: Uso de guias de dibujo

Las guias de dibujo son ayudas para dibujar que puede agregar a su escena para ayudarle a dibujar fondos 'y
objetos con lineas rectas, angulos rectos y efectos de proyeccion grafica, como la proyeccion isométrica, la
perspectiva recta y la perspectiva curvilinea. En el arte tradicional, esto se realiza con herramientas, como
reglas, reglas T, escuadras y puntos de desaparicidn. Las guias permiten simular el uso de dichas herramientas
junto con las herramientas de dibujo en Harmony.

Harmony admite distintos tipos de guias de dibujo, cada una disefiada para distintos tipos de tareas de dibujo.
La mayoria de las guias de dibujo de Harmony funcionan agregando una linea de horizonte y puntos de
desaparicion a su espacio de dibujo. Cuando utiliza una guia de dibujo, aparecen lineas de guia de puntos
mediante el cursor del ratdn. Estas lineas de guia son paralelas o perpendiculares a la linea de horizonte, o van
desde uno de los puntos de desaparicidn de la guia hasta el cursor del ratén. Cuando empieza a dibujar un
trazo, su herramienta de dibujo se fija inmediatamente a uno de los ejes de la guia, como si dibujara con una
regla. También puede utilizar las guias de dibujo como simples referencias visuales sin fijar la herramienta de
dibujo a los ejes.

Harmony admite los siguientes tipos de guias de dibujo:

« Laregla le permite colocar y rotar un eje y, a continuacién, dibujar una linea a lo largo de dicho eje, como
una regla normal.

« La cuadricula cuadrada le ayuda a dibujar lineas paralelas o perpendiculares a la linea de horizonte.

1
=y

« Laguia de perspectiva isométrica le ayuda a dibujar lineas paralelas a uno de los tres ejes: el gje x, el eje
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y.y el eje z. EL angulo de cada eje se puede personalizar segun sea necesario.

Este tipo de seudoperspectiva, también conocida como proyeccion paralela, a menudo se utiliza en
juegos 2D, infografias y esquemas para representar objetos y entornos 3D sin utilizar ninguna
perspectiva, escorzo o renderizado 3D real. En la animacion 2D, a menudo se utiliza para dibujar fondos

de paneo largos desde un angulo alto o bajo.

« Laguia de perspectiva con 1 punto le ayuda a dibujar lineas procedentes de un Unico punto de
desaparicion en el centro del horizonte. También le ayuda a dibujar lineas paralelas o perpendiculares a

la linea de horizonte.

Esto es Util para dibujar estructuras de forma de cuboide que se encuentran de cara a la camara.

« Laguia de perspectiva con 2 puntos le ayuda a dibujar lineas procedentes de uno de los dos puntos de
desaparicion, que se colocan en la linea de horizonte fuera del campo de la camara. También le ayuda a
dibujar lineas perpendiculares a la linea de horizonte.

Esto es util para dibujar estructuras de forma de cuboide desde un angulo horizontal especifico.
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« Laguia de perspectiva con 3 puntos le ayuda a dibujar lineas procedentes de uno de los tres puntos de
desaparicidon. Como con la guia de perspectiva con 2 puntos, se colocan dos puntos de desaparicion en la
linea de horizonte que se utilizan para dibujar lineas horizontales en el eje x o en el eje z. El otro punto
de desaparicion se coloca debajo de la linea de horizonte para ayudarle a dibujar lineas en el eje y.

Esto es util para dibujar estructuras de forma de cuboide desde un punto de vista elevado.

« Laguia de perspectiva con 3 puntos (plano nadir) le ayuda a dibujar lineas procedentes de uno de los
tres puntos de desaparicidn. Como con la guia de perspectiva con 2 puntos, se colocan dos puntos de
desaparicion en la linea de horizonte que se utilizan para dibujar lineas horizontales en el eje x o en el
eje z. El otro punto de desaparicién se coloca encima de la linea de horizonte para ayudarle a dibujar
lineasen el gjey.

Esto es Util para dibujar estructuras de forma de cuboide desde un punto de vista bajo.
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« Laguia de perspectiva con 3 puntos (paneo horizontal) le ayuda a dibujar fondos panoramicos
horizontales, con lineas horizontales curvilineas. Un punto de desaparicién se coloca en el centro de la
linea de horizonte para ayudarle a dibujar lineas en el eje z y dos puntos de desaparicion se colocan en la
linea de horizonte fuera del campo de la cdmara para definir la curva de las lineas horizontales. Las
lineas verticales se colocan perpendicularmente a la linea de horizonte.

Esto es util para dibujar fondos que se deben recorrer horizontalmente. El paneo horizontal de la camara
sobre el fondo dibujado con una guia de perspectiva con 3 puntos (paneo horizontal) simulard una

rotacion de la cdmara en el eje y.

]
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« Laguia de perspectiva con 3 puntos (paneo vertical) le ayuda a dibujar fondos panoramicos verticales,
con lineas verticales curvilineas. Un punto de desaparicién se coloca en el centro de la linea de horizonte
para ayudarle a dibujar lineas en el eje z y dos puntos de desaparicién se colocan debajo de la linea de
horizonte, fuera del campo de la camara, para definir la curva de las lineas verticales. Las lineas

horizontales se colocan en paralelo a la linea de horizonte.

Esto es util para dibujar fondos que se deben recorrer verticalmente. El paneo vertical de la camara
sobre el fondo dibujado con una guia de perspectiva con 3 puntos (paneo vertical) simulara una rotacién

vertical de la cdmara en el gje X.
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« Laguia de perspectiva continua con 4 puntos es muy parecida a la guia de perspectiva con 3 puntos
(paneo horizontal), salvo que esta disefiada para ayudarle a dibujar fondos panoramicos completos de
360°.

Esta guia utiliza 5 puntos de desaparicion. Cuando dibuja una linea horizontal, se curva formando un arco
sobre uno de los puntos de desaparicion y llegando hasta los dos puntos de desaparicion circundantes.
Esto crea un efecto de perspectiva donde cada punto de desaparicion representa uno de los puntos
cardinales, salvo los puntos mas a la izquierda y mas a la derecha que representan el mismo punto
cardinal, lo que crea un fondo en bucle. Los fondos creados con la guia de perspectiva continua con 4
puntos se pueden repetir en bucle horizontalmente para simular una rotaciéon completa de la camara en

elejey.
o o
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« Laguiade perspectiva continua con 4 puntos (paneo vertical) es muy parecida a la guia de perspectiva
con 2 puntos, salvo que sus lineas verticales son curvilineas, para que se pueda utilizar para crear fondos
de paneo verticales. Dos puntos de desaparicion se encuentran en la linea de horizonte, fuera del campo

180



Guia de introduccién de Harmony 21 Advanced

de la camara, para ayudarle a dibujar lineas en el eje x y el eje z, y dos puntos de desaparicion se colocan
encima y debajo del campo de la camara para definir la curva de las lineas verticales.

Esto es util para dibujar fondos que se deben recorrer verticalmente, en los que objetos de forma de
cuboide se ven desde un angulo.

L

« Laguia de perspectiva con 5 puntos (ojo de pez) le ayuda a dibujar fondos curvilineos en el eje x y en el
eje y. Tiene un punto de desaparicion central en la linea de horizonte desde el que se dibujan lineas en
el eje z; dos puntos de desaparicion en los extremos de su linea de horizonte para definir la curva de
lineas horizontales; y dos puntos de desaparicidon encima y debajo de la linea de horizonte para definir la
curva de las lineas verticales.

Esta guia se puede utilizar para dibujar fondos con un efecto de objetivo gran angular con un estilo ojo de
pez. También se puede utilizar para dibujar fondos que se deben recorrer en varias direcciones.
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Para usar una guia de dibujo, en primer lugar debe agregarla a la lista de guias de la escena. Para familiarizarse
con las guias, puede comenzar agregando la guia de dibujo de perspectiva con 1 punto a la lista de guias.

Adicion de una guia de dibujo de perspectiva con 1 punto a la escena

1. En la barra de herramientas de herramientas, seleccione Herramienta & Brush (Pincel), £ Pencil
(Lapiz), (= Stroke (Linea vectorial transparente) o / Line (Linea).

NOTA

Las guias de dibujo solo estan visibles en la vista de camara o de dibujo cuando estd
seleccionada una de las herramientas.

2. Agregue la vista de guias a su espacio de trabajo realizando una de las siguientes acciones:

« En la esquina derecha de cualquier vista de su espacio de trabajo, haga clic en el botén ==
Add View (Agregar vista) y seleccione Guides (Guias).

o En el mend superior, seleccione Windows > Guides (Ventanas > Guias).

182



Guia de introduccién de Harmony 21 Advanced

3. En lavista de guias, haga clicen el botén 4+, New Guide (Nueva guia) y seleccione % 1-Point
Perspective (Perspectiva con 1 punto).

La nueva guia aparece en la lista de guias.

Number of Lines
-

Cuando se agrega una guia nueva, su linea de horizonte se configura en una posicién y un angulo predefinidos y
sus puntos de desaparicién se configuran en una posicion predefinida. En muchos casos, debe realizar ajustes
en la guia para poder dibujar fondos y objetos desde el punto de vista correcto.

Ajuste de una guia de perspectiva con 1 punto en una

1. En la barra de herramientas de herramientas, seleccione Herramienta & Brush (Pincel), £ Pencil
(Lapiz), (~ Stroke (Linea vectorial transparente) o / Line (Linea).

NOTA

Las guias de dibujo solo estan visibles en la vista de camara o de dibujo cuando estd
seleccionada una de las herramientas.
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2. En lavista de guias, asegurese de que la opcidn Enable Guides (Habilitar guias) esté activada.

3. En la lista de guias, seleccione la guia de {=}-perspectiva con 1 punto en una en la que desee

realizar ajustes.

La guia seleccionada aparece en la vista de camara o de dibujo.

4. Realice una de las siguientes acciones:
« Para cambiar la guia de posicidn sin rotarla, haga clic y arrastre su punto de desaparicién &.

o Para rotar la guia, haga clicy arrastre su linea de horizonte.

CONSEJOS

o Cuando el ratdn se coloca encima de la linea de horizonte, el cursor del ratén
cambiard a () para indicar que estd a punto de rotar la gufa.

« Alrotar una guia, suangulo se muestra en la esquina superior izquierda de la
vista de camara o de dibujo.

5. Unavez que haya terminado de realizar ajustes en la guia, puede hacer clic en el botdn [=a
Lock Guides (Bloguear guias) en la vista de guias para evitar modificar su guia accidentalmente

mientras dibuja.
Una vez que la guia esté seleccionada y correctamente colocada, puede comenzar a dibujar con ella.

Dibujo con guias de dibujo

1. En lavista de linea de tiempo o de carta de rodaje, seleccione un dibujo o una celda vacia, y cree un
nuevo dibujo realizando una de las siguientes acciones:

« Haga clic con el botén derecho en la celda y seleccione Drawing > Create Empty Drawing
(Dibujo > Crear dibujo vacio).

o Pulse Alt + Mayus + R.
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2. En la barra de herramientas de herramientas, seleccione Herramienta & Brush (Pincel), £ Pencil
(Lapiz), (= Stroke (Linea vectorial transparente) o / Line (Linea).

NOTA

Las guias de dibujo solo estdn visibles en la vista de cdmara o de dibujo cuando estd
seleccionada una de las herramientas.

3. En lavista de guias, seleccione la guia que desee usar.

4. Para evitar editar su guia accidentalmente mientras dibuja, haga clic en el botdn [=a Lock Guides
(Bloguear guias) en la vista de guias para activarla.

5. Sidesea bloquear sus trazos con los ejes de la guia, asegurese de que la opcién ~¢" Align with Guide
(Alinear con guia) de la vista de guias esté activa. En caso contrario, desactivela para poder dibujar
libremente y use solo las guias como referencias.

6. Mueva el cursor del ratdn por el espacio de dibujo. Observe que las lineas de guias pasan por el
cursor del ratdn, una por cada uno de los ejes de la guia de dibujo.

7. Comience a dibujar en trazo en el mismo angulo que uno de los ejes.

Si la opcidn ~" Align with Guide (Alinear con guia) estd habilitada, el trazo se alinea con el eje mas
cercano a su angulo, como si dibujara con una regla.
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CONSEJOS

« También puede seleccionar manualmente el eje al que desee fijar el trazo pulsando las

teclas Flecha izquierda y Flecha derecha para pasar por cada eje. El eje seleccionado

aparecera mas resaltado que los demas. Si pasa por todos los ejes, ningun eje estara

resaltado, lo que significa que el eje al que se fija la herramienta de dibujo se vuelve a
determinar en funcion del angulo de su trazo.

Esté dibujando o no, puede fijar la posicién y el angulo de las lineas de guia manteniendo
pulsada la tecla Alt. Las lineas de guia dejaran de seguir el cursor del ratén, lo que le
permitird mantenerlas en un angulo y posicién especificos. Esto se puede utilizar para
dibujar sobre la misma linea varias veces para ajustar su longitud y grosor.

Una vez que haya terminado de trabajar con las guias, puede deshabilitarlas. Cuando las guias de dibujo estan

deshabilitadas, no se muestran en el espacio de dibujo y no afectan al comportamiento de las herramientas de

dibujo.

Habilitacién y deshabilitacion de guias de dibujo

1. Para habilitar o deshabilitar las guias de dibujo, realice una de las siguientes acciones:

« En lavista de guias, haga clic en el botén Enable Guide (Habilitar guia)

o Pulse Mayus + G.

NOTAS

Las guias se habilitan automaticamente al agregar una nueva guia o al seleccionar una guia
en la lista de guias.

La guia que se selecciond cuando deshabilitd las guias se volvera a seleccionar cuando
vuelva a habilitar las guias.

Las guias de dibujo solo funcionan con las herramientas Herramientas &~ Brush (Pincel),
£ Pencil (Lapiz), (= Stroke (Linea vectorial transparente)y / Line (Linea). Sise
selecciona cualquier otra herramienta, las guias de dibujo se comportaran como si
estuvieran deshabilitadas.
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Capitulo 17: Creacion de un multiplano

En la accién en vivo, cuando la cdmara se mueve alrededor de una escena, parecerd que los objetos cercanos a
la cdmara se desplazan a una distancia mayor que los objetos alejados de la misma. En la animacién 2D, se

puede conseguir un efecto similar creando un multiplano.

En Harmony, puede configurar facilmente un multiplano creando un fondo sobre varias capas, extendiéndolas
en el eje z para agregar profundidad y moviendo la camara por el entorno resultante para crear una ilusion de

perspectiva impresionante.

En el siguiente ejemplo, el fondo se compone de 6 capas diferentes, y cada una representa un objeto que se
encuentra a una distancia diferente de la camara. A la izquierda, puede ver cémo se sitla cada objeto en
relacién con la cdmara, como si estuviera mirandolos desde un lado. A la derecha, puede ver cémo se sitlan las
capas en relacidn entre si como si estuviera mirando la escena desde una esquina. A continuacion, puede ver la

escena desde el punto de vista de la cdmara.
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Mediante la herramienta Maintain Size (Mantener tamafio), puede convertir facilmente un fondo multicapa
normal en un multiplano. Esta herramienta permite mover una capa mas cerca o mas lejos de la camara
mientras se ajusta automdaticamente el tamafio de la capa proporcionalmente a su distancia de la camara,
conservando su tamafo aparente desde el punto de vista de la cdmara. Por lo tanto, no tiene que preocuparse
por el tamafioy la posicidén de las capas al disefiar el fondo.

En una nueva escena de Harmony, dibuje los distintos elementos de un fondo en capas separadas. Siga los

pasos que se muestran a continuacion para convertir el fondo en un multiplano.

Configuracion de un multiplano con la herramienta Maintain Size (Mantener tamano)

1. Asegurese de que la opcién No Z Dragging (Sin arrastre de eje z) del menu superior Animation
(Animacion) esté deshabilitada.

2. Realice una de las siguientes acciones:

« En la barra de herramientas de animacién avanzada, seleccione la herramienta 53
Maintain Size (Mantener tamaio).

o En el mend superior, seleccione Animation > Tools > Maintain Size (Animacién >
Herramientas > Mantener tamaiio).
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e Pulse Alt + 6.

3. En lavista lateral o superior, seleccione una de las capas de la seccién de imdgenes en miniatura.
También puede seleccionar una capa en la vista de linea de tiempo.

La capa seleccionada se resalta en las vistas superior, lateral y de camara.

4. Arrastre la capa a lo largo del eje Z dentro del cono de cdmara.

El elemento se movera en el eje Z de la escena, pero mantendra el mismo tamafio aparente en la
vista de camara.

Puede ver el multiplano desde distintos puntos de vista mediante la vista de perspectiva.

Visualizacién del multiplano en la vista de perspectiva

1. Habilite la vista de perspectiva realizando una de las siguientes acciones:

« Hagaclicen el botén Add view (Agregar vista) situado junto a las pestanas de las
vistas de camara y de dibujo y seleccione Perspective (Perspectiva).

o En el mend superior, seleccione Windows > Perspective (Ventanas > Perspectiva).

2. Pararotar la vista de perspectiva en las 3 dimensiones, mantenga pulsado Ctrl + MayUs
(Windows/Linux) o &8 + mayusculas (macQOS) y, a continuacidn, haga clicy arrastre.
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Capitulo 18: Creacion y uso de plantillas

Puede crear una plantilla a partir de una capa o de celdas. Puede almacenar como una plantilla cualquier
elemento disponible en la vista de linea de tiempo.

Creacion de una plantilla

Creacion de una plantilla

1. En lavista de linea de tiempo, seleccione varias celdas o capas.

Puede crear una plantilla a partir de una jerarquia de capas entera contrayendo la jerarquia y
seleccionando su capa raiz. Esto puede ser Util para crear plantillas basadas en rigs de personajes o
fondos de escena.

2. En lavista de libreria, seleccione una carpeta para almacenar la plantilla. De forma predeterminada,
tendrd una libreria denominada Libreria de Harmony Advanced almacenada en el ordenador, en la
subcarpeta Libreria de Toon Boom Harmony Advanced de la carpeta Documentos.

3. Silacarpeta de libreria esta bloqueada, haga clic con el botén derecho y seleccione Right to
Modify (Derecho para modificar).

4. Arrastre la seleccién a la carpeta de la libreria elegida.

Library  ==[%

ballerina.tpl

[ATWI

[ AW

Timeline | Node Library

5. En el cuadro de didlogo Rename (Cambiar nombre), asigne un nombre a la nueva plantilla.

6. Haga clicen OK (Aceptar).
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“/~. CONSEJO

’ N

Para cambiar el nombre de una plantilla una vez creada, haga clic en ella con el botén derechoy
seleccione Rename (Cambiar nombre).

Importacidn de una plantilla

Importacién de una plantilla

1. En lavista de libreria, seleccione la plantilla que desee importar.

2. Arrastre la plantilla seleccionada a la vista de cdmara o a la izquierda de la vista de linea de tiempo.

Si coloca la plantilla en la vista de cdmara, sus capas se agregaran en la parte superior de la lista de
capas. Si coloca una plantilla en la lista de capas de la vista de linea de tiempo, se insertara entre
las capas en las que la colocd.

Si la plantilla tiene la misma estructura de capas que una parte de la escena, puede colocarla
directamente en los fotogramas del lado derecho de la vista de linea de tiempo. En lugar de insertar
nuevas capas en la escena, esta accion reemplazard los dibujos y los fotogramas clave de la escena
por los de la plantilla. Esto es Util para importar plantillas de pose o animacién para los personajes
gue ya se encuentran en la escena.
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Tool Properties | Library | 4+[%

[ATWI

Timeline == (%

+ %

X
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Capitulo 19: Exportacidon de una pelicula

A través del cuadro de didlogo Export Movie (Exportar pelicula), puede exportar la animacién como un archivo
de video. De forma predeterminada, Harmony exportara toda la escena en su resolucién completa. Si lo
prefiere, puede elegir exportar solo un rango de fotogramas especifico en la escena o exportarlo en una
resolucion mas pequefia, lo cual puede ser Util si necesita ahorrar tiempo o espacio en disco. En funcién del
formato en el que exporte la pelicula, también puede personalizar los ajustes de compresion de video y de
audio para mas calidad o para obtener espacio en disco.

Exportacién de un archivo de pelicula

1. En el mend superior, seleccione File > Export > Movie (Archivo > Exportar > Pelicula).

Se abre el cuadro de dialogo Export to QuickTime Movie (Exportar a pelicula de QuickTime).

2. En la seccién Output (Salida), abra el ment desplegable Video Format (Formato de video) y

seleccione el formato deseado para su archivo de pelicula:

e QuickTime Movie (*.mov): formato de Apple QuickTime. Este es el formato de
exportacion predeterminado que se recomienda por su portabilidad y porque le
permite elegir entre varios cddecs de video.
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NOTAS

o« En Windows, se debe instalar QuickTime de Apple para que Harmony

pueda exportar peliculas de QuickTime. Puede configurar que las
peliculas de QuickTime utilicen cualquier cédec compatible con
QuickTime, incluidos H.264, MPEG-4 y Animation, para su exportacion.

En macOS, Harmony utiliza Apple AVFoundation para exportar
peliculas de QuickTime, lo que le permite utilizar cédecs como H.264,
Apple ProRes 422 y Apple ProRes 4444, entre otros.

Si desea exportar una pelicula de QuickTime con transparencia,
asegurese de elegir un cédec que admita la codificacién con un canal
alfa.

En GNU/Linux, Harmony utiliza la libreria OpenQuickTime para
exportar las peliculas de QuickTime. Esto solo permite exportar videos
en formatos comunes, como M-JPEG, JPEG para fotos, PNG o RGB sin
comprimir.

o H.264/MPEG-4 (*.mov): formato de pelicula sencillo que utiliza el cédec H.264
compatible con la mayoria de navegadores web.

NOTAS

El uso de este formato no requiere software adicional. Sin embargo, si
es la primera vez que exporta una pelicula en formato H.264/MPEG-4,
se le solicitara que descargue la libreria OpenH264 de Cisco.
Simplemente haga clic en Yes (Si) cuando se le solicite y Harmony
descargara la libreria automdaticamente vy, a continuacién, exportara la
pelicula.

No hay opciones de codificacidn para este formato.

Este formato admite resoluciones de hasta 4096x2304. Cada
dimension debe ser un multiplo de 16 pixeles.

El audio exportado en este formato esta codificado en PCM estéreo de
16 bitsy 22,05 kHz.

o Windows Media Video (*.wmv): formato nativo para Windows Media Player.
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NOTAS

e Los archivos Windows Media Video (.wmv) solo se pueden exportar en
Windows.

« Losreproductores de video y editores en sistemas que no sean de
Windows normalmente no pueden abrir archivos Windows Media
Video (.wmv).

o Flash (.swf)

« Secuencia de imagen en formato Jpeg (*.jpg), Targa (*.tga) o Portable Network
Graphics (*.png).

3. Hagaclic en el botén Browse (Examinar).

4. En el cuadro de didlogo Save (Guardar) que aparece, examine la ubicacién en la que desee exportar
el archivo de pelicula.

5. En el campo File name (Nombre de archivo), escriba el nombre del archivo que desee darle al
archivo de pelicula.

6. Haga clic en Save (Guardar).
7. En la seccion Export Range (Rango de exportacidn), realice una de las siguientes acciones:
o Seleccione All (Todo) si desea renderizar la escena entera.

o Seleccione Frames (Fotogramas) si desea renderizar una parte de la escena. A continuacion,
en el campo de la derecha, introduzca el primer fotograma de la secuencia que desea
exportar, y en el otro campo, el Ultimo fotograma de la secuencia que desea renderizar.

8. Abra la lista desplegable Resolution (Resolucién) y realice una de las siguientes acciones:

« Seleccione Same as Scene Resolution (Igual que resolucién de escena) si desea exportar una
pelicula con la misma resolucion que la escena.

Height:
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o Seleccione 3/4 of Scene Resolution (3/4 de resolucidn de escena), 1/2 of Scene Resolution
(1/2 de resolucién de escena), 1/3 of Scene Resolution (1/3 de resoluciéon de escena) o 1/4 of
Scene Resolution (1/4 de resolucién de escena) si desea exportar una pelicula que sea
inferior a la resolucidn de la escena.

o Seleccione Custom (Personalizado) si desea establecer la resolucién de exportacién
manualmente. A continuacion, en los campos Width (Ancho) y Height (Altura), introduzca en
pixeles la resolucidon deseada para su pelicula.

9. En el ment desplegable Colour Space (Espacio de color), seleccione el espacio de color al que desea
exportar la pelicula.

10. Haga clicen OK (Aceptar).

11. En el cuadro de didlogo Export to QuickTime Movie (Exportar a pelicula de QuickTime), haga clic en
OK (Aceptar).

Aparece una barra de progreso.

12. Desplacese a la ubicacion en el ordenador en la que ha exportado el archivo de pelicula y haga
doble clic en él para verlo en el reproductor de video.
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Glosario

3D
estereoscépico

aberracién
cromatica

aceleracién

aceleraciéon de
entrada

aceleraciéon de
salida

aceleraciéon
gradual

alimentador de

papel
automatico

animacion

animacion cut-
out

Imagenes o peliculas que generan dos imdgenes diferentes, cada uno desde el
punto de vista de uno de los ojos humanos. Cuando se visualizan o proyectan a
través de dispositivos especiales, como una pantalla 3D o gafas de realidad
virtual, se crea la ilusion que los elementos de la imagen se encuentran enfrente
del espectador.

En dptica, una aberracién cromatica (CA), acromatismo o distorsién cromatica, es
un tipo de distorsion en el que una lente no puede enfocar todos los colores en el
mismo punto de convergencia.

En animacidn, la velocidad es la aceleracion y la desaceleracion de un
movimiento. Puede ser un movimiento creado mediante una curva de funcién o
una serie de dibujos animados. Otros términos comunes para aceleracién gradual
y desaceleracion gradual son aceleracion y desaceleracion.

Aceleracion drastica al principio de la accion.

Aceleracion dréstica al final de la accidn.

Aceleracidn gradual en la accidon. Conocida también como aceleracidn.

Método automatizado de introducir dibujos en un escaner en el que hay varios
dibujos apilados en un alimentador de hojas. Cuando se activa el escaner, los
dibujos se digitalizan de forma consecutiva, sin ninguna otra intervencién del
usuario.

Simulacién de movimiento que se crea dibujando o editando fotogramas
individuales.

El proceso conocido como animacién cut-out es la accidn de animar personajes
compuestos por varias piezas moviéndolos de fotograma en fotograma. La
animacion cut-out se puede generar por ordenador o realizarse del modo
tradicional utilizando papel.
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animacion
directa

animacion pose
apose

animacién
secundaria

animacion sin
papel

animacion
tradicional

animatica

anime

arco

Técnica en la cual se dibuja por orden una secuencia completa desde la primera
posicion hasta la ultima. Esta metodologia requiere muy poca planificacion. El
lugar en el que el personaje termina y cdmo llega hasta alli pueden ser una
sorpresa tanto para el publico como para el animador. Este enfoque es
espontaneo y creativo, pero puede generar resultados imprecisos.

El proceso de animacion pose a pose es la accién que consiste en crear todas las
poses de accidn principales, denominadas poses clave, y después colocar las
poses secundarias entre las claves. Las poses secundarias se denominan
descomposicidn. Por Ultimo, el animador rellena los huecos con los dibujos
intercalados para lograr una animacion fluida.

Movimiento secundario provocado por la accidn principal. Por ejemplo, un
personaje que corre y lleva puesta una capa. La accién principal es el cuerpo que
corre. Esto provocara que la capa siga el movimiento, aunque no se movera al
mismo tiempo, sino que reaccionara varios fotogramas después y seguird la curva
de movimiento principal.

El proceso de animacion sin papel es la accidon de animar digitalmente. El
principal proceso de animacidn sin papel es dibujar la animacion, fotograma a
fotograma, directamente en el software.

Tipo de proceso de animacion mediante el cual todas las secuencias de animacion
se dibujan a mano en papel antes de digitalizarlos o tintarlos en celdas.

Una pelicula hecha con secuenciaciéon de paneles en un storyboard, en la que se
establece el tiempo aproximado de cada panel para la accidon que representay se
sincroniza cada panel con la pista de sonido. Las animaticas se utilizan para
convertir el storyboard en un borrador de la pelicula final con el fin de
determinar el tiempo asignado a cada escena y a cada accién y sincronizar la
accidn con la pista de sonido.

Animacién japonesa.

La accidn no suele producirse de forma directa, sino que mas bien se suele
desplegar en lo que los narradores denominan un arco. El propdsito de un arco
de historia es mover un personaje o situacion de un estado o escenario al
siguiente.
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arrastrar

artista de layout

atajos de
teclado

baja resolucién

bocetos

campo

canal alfa

capa

capa de fondo

capa superior

Operacion que consiste en hacer clic en un elemento, mantenerlo pulsadoy, a
continuacion, moverlo mediante el movimiento del cursor del ratdn. Esto se
puede realizar con el botdn izquierdo del ratdn o con la punta del lapiz.

Artista que dibuja el fondo y crea la camara y la guia de campo, haciendo
coincidir la escena y el movimiento de la cdmara. Dibujard en el modelo las poses
de accién principales.

Tecla de teclado o combinacion de teclas de teclado que se asigna para realizar
un comando especifico en la aplicacién al pulsarlos.

Formato idéneo para videos destinados a la web, donde el tamafio y la descarga
rapida del archivo de video tienen prioridad respecto a la calidad. Una imagen de
baja resolucién es aquella que no contiene detalles precisos.

Es un nombre comun en una pelicula de animacién para un dibujo que se utiliza
como referencia, pero no forma parte de la imagen final. Un layout es un boceto.
Es el esbozo del esqueleto de una animacion o disefio. Los bocetos consisten
principalmente en lineas y formas esbozadas, pero también pueden contener
detalles de disefio.

Unidad de medida que se utiliza en la animacion tradicional para registrar y
realizar un seguimiento de la cdmara, asi como de su proximidad a la escena.

Canal de imagen que contiene informacién de transparencia. De partida, una
imagen tiene tres canales: rojo, verde y azul (RGB). El canal alfa es el cuarto
canal (A). El mate, o informacidn de transparencia, se almacena en este cuarto
canal. Una imagen sin canal alfa siempre es opaca.

En animacidn, una capa es una columna, nivel o personaje individual. Las capas
de una escena estan superpuestas para formar la imagen final.

En animacidn, una capa de fondo es una parte especifica de la decoracién
colocada detras de la animacién principal.

Parte del entorno de una escena, como una silla o un arbusto, que se coloca
delante de la animacion principal.
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carta de color

cartade
exposicién

cartade
fonemas

carta de rodaje

celda

ciclo

ciclo de andar

cinematica
directa

Una carta de color es una tarjeta que contiene un color sélido con el mismo
tamano que la camara. La carta de color rellena el fondo con un color sélido
cuando no se ha incluido ninguna imagen de fondo.

Hoja con varias columnas verticales y fotogramas horizontales que se utiliza para
indicar el tiempo de una escena. Cada columna representa una capa de escena.
Los numeros de dibujos de cada columna se indican y se repiten a lo largo de la
cantidad de fotogramas determinada en la que deben aparecer. La carta de
exposicion la utilizan los animadores, directores y otros miembros del equipo
para trazar la secuencia y el tiempo de lasimagenes, el dialogo, los efectos de
sonido, las pistas de sonido y los movimientos de cdmara. Conocida también
como carta de rodaje.

Carta basada en los ocho fonemas de la animacién (A, B,C,D, E,F, Gy X, que se
utiliza para representar el silencio) utilizados para la sincronizacién de labios.

La utilizan los animadores, directores y otros miembros del equipo para trazar la
secuencia y el tiempo de las imagenes, el dialogo, los efectos de sonido, las pistas
de sonido y los movimientos de camara. Conocida también como carta de
exposicion.

En la animacidn tradicional, una celda (también denominada celuloide) es una
hoja transparente en la que la animacion se tinta y se pinta antes de enviarla a la
camara. El trazado de la imagen se dibuja en la parte delantera de la celda y, a
continuacion, se colorea por la parte trasera.

Serie de fotogramas de animacion que se pueden repetir para simular un
movimiento continuo. Por ejemplo, un personaje a menudo camina mediante una
animacion en la que da dos pasos, uno con cada piey, a continuacién, repitiendo
la animacion.

Serie de dibujos "en el lugar" que describen cdmo camina un personaje. La ilusion
de movimiento se crea utilizando paneos de fondo. Para evitar realizar
innumerables dibujos, los animadores suelen realizar un ciclo de andar para un
personaje.

La cinematica directa es una funcién utilizada para animar principalmente
personajes 3D y marionetas cut-out con jerarquia. Se utiliza para animar una
marioneta a partir de una de sus partes padres, como un hombro, y hacer que el
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cinematica
inversa (IK)

circulo
cromatico

clean up

CMYK

cddigo de

tiempo

composiciéon

corte

corte de salto

resto del brazo se mueva con ella como un todo.

Funcidn utilizada principalmente para animar personajes 3D y marionetas cut-
out con jerarquia. La cinemdtica inversa animard una marioneta desde una de las
extremidades, como una mano, y permitira que el resto del cuerpo la siga con
naturalidad.

Visualizacion del espectro de colores en forma de circulo.

Una vez que los bocetos se han evaluado y aprobado, se quita todo el ruido de la
imagen (lineas sobrantes, notas, etc.) para crear dibujos finales que se pueden
tintar, pintar y filmar. El proceso de clean up hace referencia al trazado de una
linea limpia sobre un boceto para conseguir la version final o a la eliminacion de
la suciedad y las lineas adicionales que han quedado tras el proceso de
digitalizacién.

Acrénimo en inglés de cian, magenta, amarillo y negro. Estos colores forman el
modelo estandar utilizado en un proceso denominado impresion offset.

Informacidn de tiempo impresa en un clip de pelicula para indicar la escena, hora,
minuto y segundo que se muestran actualmente en pantalla.

La composicidn es la accidn de incorporar todos los elementos de una escena
para crear el resultado final antes del renderizado. Por ejemplo, el artista de la
composicion importara todas las secuencias, el fondo, las superposiciones y las
subcapas de la animacién en la escena y los colocard correctamente. A
continuacion, el artista definira el encuadre de cdmara y lo animara en caso
necesario. Por Ultimo, el animador creara todos los efectos generados por
ordenador para el proyecto.

Cuando una escena pasa a la escena siguiente de un fotograma a otro sin ningun
efecto visual.

Corte brusco entre dos escenas. Normalmente, un corte de salto no es
visualmente agradable. Normalmente lo provoca el final de una escenay el
comienzo de otra, con una imagen parecida. La falta de diferencia provoca que el
0jo vea un pequeno salto entre las dos escenas.
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curva Bézier

depuracion de
sonido

desaceleracién

desaceleracién
gradual

descomposicién

desglose de
pista de audio

desplazamiento
pequefio

deteccién
automatica de
sincronizacion
de labios

Método para definir lineas curvas inventado por el matematico francés Pierre
Bézier. Una curva Bézier es una curva matematica o paramétrica. Los puntos de
control definen las curvas Bézier. En Harmony, las curvas Bézier tienen un punto
de inicio, un punto de final y dos puntos de control interiores que influyen la
curva entre los puntos de inicio y final.

Proceso que permite escuchar el sonido en tiempo real, mientras mueve el
cabezal de reproduccidn hacia delante o hacia atras. Es muy Util para realizar el
ajuste preciso de una sincronizacién de labios.

Desaceleracidn gradual en la accion. Conocida también como desaceleracion
gradual.

Desaceleracién gradual en la accién. Conocida también como desaceleracion.

En animacion cut-out, la descomposicion es la accion de descomponer un
personaje en trozos para crear una marioneta con articulaciones. Para
descomponer un personaje, el artista corta partes, como las manos y los brazos,
del modelo del personaje y las pega en capas independientes. A continuacion,
las articulaciones se fijan y se definen los pivotes. En la animacion tradicional,
una descomposicidn es una pose de animacion que normalmente se encuentra
entre dos poses clave. Las poses clave son las poses principales de una
animacion y las descomposiciones son poses secundarias que ayudan a describir
el movimiento y la curva de rotacién (normalmente denominada arco).

Desglose de una pista de pelicula animada en sonidos individuales para generar
la posicién fotograma a fotograma precisa de cada sonido.

Pequefio empujon (izquierda, derecha, arriba, abajo, hacia delante o hacia atras)
realizado con las teclas de flecha del teclado en un elemento seleccionado. EL
desplazamiento pequerio se utiliza para mover una seleccién de manera muy
ligeray precisa.

Asignacion automatica de dibujos en un elemento a la carta de fonemas
generada para un sonido. Puede ahorrar tiempo al sincronizar los labios una pista
de voz
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deteccidon
manual de
sincronizacidon
de labios

didlogo
diseno del

personaje

dpi

eje

escena

estilo de paleta

exposicién

film-1.33

film-1.66

Intercambio manual de dibujos de posicién de la boca para que coincidan con una
pista de voz. Para este proceso, se utilizan tanto la depuracién de sonido
(escuchar una onda de sonido descompuesta fotograma a fotograma) como las
sustituciones de dibujos.

Texto hablado por un personaje en una pelicula o animacidn.

Cada personaje de una pelicula animada se dibuja desde varios dngulos en
formato de estilo pdster denominado hoja de modelo, que sirve como referencia
para los animadores.

Siglas en inglés para puntos por pulgada, que representa la medida estandar de
resolucion para impresoras computerizadas. En ocasiones se aplica a pantallas,
en cuyo caso es mas exacto denominarlo pixeles por pulgada. En cualquier caso,
el punto es el elemento diferenciado mas pequefio que forma la imagen.

Linea imaginaria alrededor de la cual rota un objeto. Para graficos 2D, hay dos
gjes: X (horizontal) e Y (vertical). Para graficos 3D, hay tres ejes: X (horizontal), Y
(vertical) y Z (profundidad). En animaciones que rotan constantemente, el
elemento de eje especifica alrededor de qué eje rota el objeto. Un nimero
negativo provoca que una animacion rote en sentido contrario a las agujas del
reloj, mientras que un numero positivo hace que una animacién rote a la derecha.

Plano en una pelicula o programa. Una secuencia esta compuesta por varias
escenas. Una escena cambia a otra mediante un corte simple o por transicion.

Un estilo de paleta es una segunda version de una paleta existente con un ligero
cambio en el tinte y el valor. Un estilo de paleta se puede utilizar para crear la
version nocturna de una paleta. También se le puede denominar paleta de
clonado.

En animacion, una exposicidn es el nimero de celdas en las que un dibujo
aparece en la escena. Para que un dibujo parezca mas grande, la exposicién se
debe ampliar durante un ndmero de celdas mayor.

Resolucion idonea para el formato de pelicula panoramico que se ajusta a la
proporcion estandar de 4:3 pixeles.

Resolucion idénea para el formato de pelicula panoramico que se ajusta a la
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flipping

fondo

fonema

fotograma

fotograma clave

fotograma clave
de movimiento

fotograma clave
de Stop-motion

fotogramas por
segundo

funcién

proporcion de 16:9 pixeles.

En la animacidn tradicional, flipping es la accidén de pasar por los dibujos de una
secuencia de animacién muy rapidamente con el fin de ver la animacién en
movimiento. Flipping también puede ser la accidn de crear una transformacién en
espejo de un objeto.

Ilustraciones que llenan el campo de la cdmara y que se encuentran detrds de los
personajes y props. Normalmente, estas ilustraciones representan la decoracién
o escena en la que ocurre la accién.

Unidad de sonido de un idioma.

Un fotograma de animacién es una imagen fotografica Unica en una pelicula. En
la animacion tradicional, el estandar norteamericano contiene generalmente 24
fotogramas por segundo, mientras que el estandar europeo es de 25.

Posiciones importantes en la accién que definen los puntos inicial y final de
cualquier accidn. Un fotograma clave es una posicion generada por ordenador en
un momento especifico (fotograma) y en una trayectoria determinada.

Fotograma clave con interpolacién generada por ordenador.

Fotograma clave sin interpolacién generada por ordenador.

Representan la velocidad a la que se reproducen los fotogramas por segundo. Se
calculan por lo general en fotogramas por segundo. Por ejemplo, una escena se
podria reproducir a 12, 24, 25, 30 o 60 fotogramas por segundo o a cualquier otro
numero. Es la medida de la frecuencia (tasa) a la que un dispositivo de imagen
produce imagenes consecutivas Unicas, denominadas fotogramas. El término se
aplica por igual a los gréaficos por ordenador, videocadmaras, camaras de pelicula y
sistemas de captura de movimiento. La tasa de fotogramas se suele expresar
principalmente en fotogramas por segundo (fps) y en monitores de barrido
progresivo en hercios (Hz).

Movimiento, trayectoria o ruta generados por ordenador al que se pueden
conectar parametros de elementos, otras trayectorias y efectos. La funcién se
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ink and paint

puede controlar agregando fotogramas clave y puntos de control en la curva de
funcion.

El fundido de entrada o fundido de salida es un efecto de transicién utilizado para
abrir o cerrar una secuencia. Un fundido de entrada se produce cuando la primera
escena aparece progresivamente, desde una transparencia total a su opacidad
total. Un fundido de salida se produce cuando la escena desaparece
progresivamente, desde la opacidad total a la transparencia total.

Cuando una escena pasa a la escena siguiente mediante un fundido en el que
desaparece unay aparece la siguiente.

Rango de colores que puede representar un dispositivo determinado.

Texto original que contiene la informacion de toda la pelicula o el programa. En
animacion, el guion contiene todas las descripciones de la ubicacidn, el didlogo, el
tiempo, etc. Un proyecto comienza con un guion.

Acrénimo en inglés de televisién de alta definicidn, que es el estandar de
resolucion actual para producciones televisivas. La resolucién de producciones de
HDTV es 1280x720 (HD ready) o 1920x1080 (full HD), y sus fotogramas por
segundo normalmente oscilan entre 23.976 y 30.

Guia que contiene todas las unidades de campo que los artistas de animacién y
layout utilizan para definir el tamafio del campo de la cdmara, asi como sus
movimientos.

Fotograma en la animacidn en el cual el personaje mantiene su posicién sin
moverse. Se puede crear un hold entre dos fotogramas clave cualesquiera.

Siglas en inglés para matiz, saturacion y valor. Método para definir los colores en
cuanto a matiz (tinte), saturacion (sombra) y valor (tono o luminancia).

Imagen muy pequeia utilizada como una referencia o indicador.

El proceso ink and paint es la accién de pintar las zonas vacias y colorear las
lineas en los dibujos de animacién finales siguiendo un modelo de color.

208



Guia de introduccién de Harmony 21 Advanced

intercalado

interpolacién

layout

layouty pose

libreria

linea de accidn

linea de tiempo

lineas
vectoriales
transparentes

mapa de bits

mesa de disco

Dibujos que existen entre las poses clave. Se dibujan para crear transiciones
fluidas entre poses.

Movimiento generado por ordenador creado entre dos fotogramas clave. Se
puede crear interpolacion, o no, entre los fotogramas clave.

Paso de comunicacion entre el storyboard y la animacién. Es la accidn de poner el
storyboard en el modelo. Es decir, el personaje se dibuja siguiendo el diseno del
paguete de modelo, de modo que el animador puede comenzar a trabajar. EL
artista de layout dibuja el fondo y crea la cdmara y la guia de campo, haciendo
coincidir la escena y el movimiento de la camara. Por ultimo, el animador dibuja
en el modelo las poses de accidn principales.

Accidn que consiste en poner el storyboard en el modelo (a la escala adecuada)
para que el animador comience a trabajar.

Zona de almacenamiento que contiene plantillas y recursos que se pueden
reutilizar en un proyecto o escena.

Linea central en una pose de accién. Cuando se pintan poses de accién sin tocar
la linea de accidn se garantiza que la pose sea dindmica y que su silueta se ajuste
a la direccién de la accidn.

Representacion horizontal de los elementos, el tiempo y los fotogramas clave de

una escena.

Cuando no hacen referencia a trazos reales, las lineas vectoriales transparentes
son contornos invisibles que se utilizan para definir zonas de color o para cerrar
zonas de color abiertas.

Imagen definida por una malla de pixeles, asi como por el color individual de cada
uno de sus pixeles. Los graficos de mapas de bits se caracterizan por ser
preferibles a los graficos vectoriales para ilustraciones muy detalladas o
fotorrealistas. Sin embargo, los graficos de mapas de bits no se pueden escalar,
rotar o sesgar sin que la imagen pierda calidad.

Equivalente al disco/mesa de animacidn, es un dispositivo que permite rotar el
espacio de trabajo para mayor comodidad mientras se dibuja.
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mesade luz

modelo de color

modelo/modelo

de color

morphing

multiplano

NTSC

PAL

paleta maestra

paleta/paleta
maestra

Dispositivo que permite ver otras capas en transparencia mientras trabaja en una
capa determinada.

Disefio de color oficial que se debe utilizar para pintar la animacién. Un modelo
es el disefio de personaje, prop o ubicacion definitivo que cada artista debe seguir
para la produccion.

Disefio de personaje, prop o ubicacién definitivo que cada artista debe seguir
para una produccion. Un modelo de color es el disefio de color oficial que se debe
utilizar para pintar la animacién.

Funcién que permite crear dibujos generados por ordenador entre un dibujo de
origen y otro de destino. La animacidn creada con la funcién de morphing se
puede reutilizar en distintos proyectos.

Efecto de pasar por diversos niveles de dibujos para crear una sensacién de
profundidad en un plano. Un multiplano es una escena en la que las capas estan
colocadas a distintas distancias de la camara, de modo que, cuando la camara se
mueve, se produce una ilusién de profundidad. Con un multiplano, toda la
perspectiva y la escala se calculan automaticamente.

Antiguo sistema de difusion televisiva analdgico estandar utilizado en
Norteamérica.

Resolucion que funciona mejor con el formato europeo para pantallas de
televisién y de ordenador, ya que los pixeles rectangulares se muestran con una
orientacion distinta.

Grupo de colores atribuidos a un personaje o prop. La paleta se utiliza durante
toda la produccion para mantener la coherencia en el aspecto y para garantizar
que se utilicen los mismos colores durante la produccion. Conocida también como
paleta.

Una paleta o paleta maestra es un grupo de colores atribuidos a un personaje o
prop. La paleta se utiliza durante todo el proyecto para mantener la coherencia
en el aspecto y para evitar cambios de color durante la animacion. También se le
denomina paleta maestra.
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panear

panel

papel cebolla

paso con doble
bote

peg

pivote

pixel

planificacion de
layout

plano

plano de
situacion

Mover la cdmara atravesando la escena en cualquier direccion.

En un storyboard, un panel es un fotograma en un plano. Un plano puede estar
compuesto por uno o varios paneles.

Funcidn que permite ver los dibujos anterior y siguiente de una secuencia.

En los fotogramas clave y las posiciones de paso de un paso con doble bote, el
cuerpo es menor que una linea de referencia dibujada en posicion vertical.
Durante los intercalados, el cuerpo esta situado sobre esta linea, ofreciendo asi
un aspecto de rebote.

En la animacion tradicional, es una herramienta utilizada para garantizar el
registro preciso de la accién a medida que se mueven las capas de celdas. En la
animacion digital, en la que se realiza un rigging de marionetas mas avanzado, se
pueden usar capas de pegs. Las capas de pegs son capas de trayectoria que no
contienen dibujos. Son rutas de movimiento que puede usar para agregar
articulaciones de ruta. Para las Ultimas, también puede utilizar una herramienta
de cinematica inversa.

Punto alrededor del cual un peg o dibujo rota.

Elemento mas pequefio de una imagen mostrado en un monitor o pantalla de
televisidn. El pixel, abreviatura en inglés de elemento de imagen, es un punto
Unico en una imagen grafica. Es una pequefia muestra de una imagen, un punto,
un cuadrado o una seccién muy pequefia compuesta de filtrado suavizado. Si
acerca el zoom lo suficiente en una imagen digital, vera los pixeles, que parecen
pequefios cuadrados de distintos colores e intensidad.

Dibujo de las funciones principales de la escena que se utiliza como referencia al
planificar la animacion y ejecutar sus etapas iniciales.

Escena en una pelicula o programa. Una secuencia estd compuesta por varios
planos. Un plano cambia a otro mediante un corte simple o por transicion.

Escena en la cual el espectador puede ver toda el drea en la que se estd
produciendo una secuencia. Por ejemplo, si un nifio estd jugando en el patio
delantero de su casa, el plano de situacidn seria una escena en la que el
espectador puede ver la casa, el patio, parte de la calle y los edificios situados
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pose clave

posicién de
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proceso de
layout
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renderizado

resolucidn

RGB

alrededor del punto de accién central. Esto ayuda al espectador a entender la
ubicacion de la historia y la orientacién de la escena.

Recurso almacenado en la libreria que se puede reutilizar en cualquier proyecto.
Una plantilla puede ser un dibujo, una serie de fotogramas clave, un archivo de
sonido, un panel, un personaje cut-out, un efecto, una trayectoria, una animacion
o cualquier otra cosa que se utilice en la animacion.

Posiciones importantes en la accién que definen los puntos inicial y final de
cualquier transicién suave. Las claves, o poses clave, son los dibujos principales
de una secuencia de animacion que describen el movimiento. Por ejemplo, si se
agita un brazo, las claves corresponderan al brazo de una extremidad del
movimiento de onda vy a la otra extremidad. Al realizar un flipping de dichos
dibujos, el animador puede ver el esqueleto del movimiento sin tener todos los
dibujos.

Al dibujar una secuencia en la que un personaje camina, la posicion de paso es el
punto en el que una pierna pasa a la otra.

Paso de comunicacion entre el storyboard y la animacién.

Proporcidn entre las dimensiones de ancho y altura de una escena, fotograma o
formato de pelicula. Actualmente, la proporcién mas popular es 16:9. Las
pantallas antiguas utilizaban una proporcién de 4:3.

Paso final de la animacién por ordenador. Durante el renderizado, el ordenador
toma cada pixel que aparece en la pantalla y procesa todos los componentes.
Ademds, agrega desenfoque de movimiento antes de que produzca una imagen
final. Es el proceso de calcular las imagenes finales después del proceso de
composicion.

Tamafio de una escena, calculado por lo general en pixeles. Por ejemplo, la
resolucion NTSC es de 720 x 480. La resolucidon debe coincidir con la salida final:
HDTV, film-1.33, film-1.66, NTSC, PAL, baja.

Siglas en inglés para rojo, verde y azul. Método que permite definir el color
especificando las cantidades de estos tres componentes del color.
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rigging

rotoscopia

secuencia

simbolo

sincronizacidn
de labios

slugging

storyboard

tableta/lapiz

Totales
acumulados de
columna

transicion

Proceso de conectar las distintas partes de una marioneta cut-out.

Técnica de animacién en la que los animadores trazan un movimiento de pelicula
de accién en vivo, fotograma a fotograma, para usarlo en peliculas animadas. Es
el acto de esbozar sobre material de accién en vivo para crear una secuencia
animada.

Serie de escenas o planos que forman una parte distinta de la historia o pelicula,
normalmente conectados por la unién de la ubicacién o el tiempo.

Un icono combina animacion, ilustracién o capas en un Unico objeto que puede
controlar en una capa. También puede crear iconos de cada parte del cuerpo en
marionetas cut-out. En un icono puede colocar lo que desee. Puede utilizar
simbolos para animar una marioneta o crear animaciones reutilizables, como un
parpadeo.

Proceso que consiste en sincronizar la boca de un personaje con sonidos en la
pista de sonido del didlogo. La boca se ajusta fotograma a fotograma para hacer
coincidir el sonido del dialogo y aparentar que el personaje esta hablando. La
sincronizacion de labios se puede utilizar para cualquier secuencia de sonidoy no
solo para el habla. Por ejemplo, puede hacer que un pajaro pie o que un lobo
aulle a la luna.

Indicacion de los tiempos de inicio y detencidn de un didlogo y las acciones
relevantes.

Plan visual de todas las escenas y planos de una animacion. El storyboard indica
lo que sucedera, cuando lo hard y como se distribuyen los objetos en una escena.

Dispositivo utilizado junto con un ratén, o en lugar del mismo, para mover el
puntero (en ocasiones denominado cursor) por la pantalla del ordenador.

Campo de texto que contiene informacién de didlogo, efectos, sonido o slugging
en un storyboard.

Efecto colocado entre dos escenas cuando se pasa de una a otra. Los efectos de
transicién comunes son el fundido encadenado y el barrido.
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trayectoria

trazar y pintar

usar carta de
rodaje

vector

velocidad

vibracién de
camara

Zona

Zoha segura

Ruta o trayectoria generada por ordenador que pueden seguir los elementos. La
trayectoria se puede controlar mediante puntos de control, fotogramas clave y
velocidad.

Una vez que los bocetos de las animaciones se han limpiado y se ha realizado
una prueba de linea o de lapiz final, cada dibujo se traza y se pinta para la
animacion final. En el mundo digital actual, esto se puede realizar de maneras
distintas a los métodos de celuloide o acetato tradicionales.

Asignar un dibujo determinado a un rango de fotogramas.

Una imagen basada en vectores esta compuesta por puntos y curvas Bézier. El
ordenador lee los puntos y traza los segmentos, vinculandolos para reproducir la
forma de imagen. Una imagen vectorial no contiene tamano fijo ni resolucidn. El
grafico se puede ampliar y distorsionar seguin se desee y el sistema volvera a
calcular los segmentos y reconstruird las formas. Las imagenes vectoriales se
trasladan y se muestran en pixeles una vez que el calculo se ha realizado.

En animacidn, la velocidad es la aceleracidn o la desaceleracidn de un
movimiento. Se puede alcanzar mediante una curva de funcion o una serie de
dibujos animados. Otros términos comunes para aceleracion gradual y
desaceleracién gradual son aceleracion y desaceleracion.

La vibracién de cdmara se produce en una escena cuando la cdmara se mueve
ligeramente y rapidamente en varias direcciones. Este movimiento da la
impresion de impacto, vibracioén o, por ejemplo, baches en la carretera.

Area que se puede pintar con color.

Zona central del fotograma de una escena que no quedara recortada por el
fotograma de TV. Como un fotograma de TV corta un margen del tamano del
fotograma original, al mantener una zona segura se garantiza que la accién
principal de la escena siga siendo claramente visible una vez que la pelicula se
proyecte en television.
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